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Introduction 
 

Read this Instruction Manual thoroughly before using 
the product. 
 

Thank you for purchasing this product. 

This operation manual describes the product's operation procedures and related options. Read the manual 

thoroughly and use the product in accordance with the described instructions. 

 

Also, keep this manual for future reference. 

 

 

 

 IMPORTANT 
 If the user or usage location changes, ensure that this Instruction Manual is always kept together 

with the product. 

 If this manual or a product warning label is lost or damaged, immediately contact your Shimadzu 

representative to request a replacement. 

 To ensure safe operation, read all Safety Instructions before using the product. 

 To ensure safe operation, contact your Shimadzu representative if product installation, adjustment, 

or re-installation (after the product is moved) is required. 

 

 Notice 
 Information in this manual is subject to change without notice and does not represent a commitment 

on the part of the vendor. 

 Any errors or omissions which may have occurred in this manual despite the utmost care taken in its 

production will be corrected as soon as possible, although not necessarily immediately after 

detection. 

 All rights are reserved, including those to reproduce this manual or parts thereof in any form 

without permission in writing from Shimadzu Corporation. 

 Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States 

and/or other countries. Other company names and product names mentioned in this manual are 

trademarks or registered trademarks of their respective companies. The TM and ® symbols are 

omitted in this manual. 

 This product uses WinWrap® Basic, Copyright 1993-2015 Polar Engineering and Consulting 

(http://www.winwrap.com/ ). 

© 2012-2015 Shimadzu Corporation. All rights reserved. 
Original version is approved in English. 

 

http://www.winwrap.com/�
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About the Instruction Manual 

 Indications Used in This Manual 

Cautions and Notes are indicated using the following conventions: 
 

Notation Meaning 

 

Indicates a potentially hazardous situation which, if not avoided, may 
result in minor to moderate injury or equipment damage. 

  Emphasizes additional information that is provided to ensure the 
proper use of this product. 

 

The following symbols are used in this manual: 
 

Notation Meaning 

Prohibitions 

Indicates an action that must not be performed. 

Instructions  

Indicates an action that must be performed. 

 Indicates the location of related reference information. 

 

 Mouse and Window Operations 

Description Meaning 

Click Means pointing to an object and pressing the left mouse button once. 

Right click Means pointing to an object and pressing the right mouse button once. 

Double click Means pointing to an object and pressing the left mouse button twice. 

Drag 
Means pointing to an object and then moving the mouse pointer while 
holding the left mouse button down. 

Drag and drop 
Means dragging an object to the target location and then releasing the left 
mouse button. 

Text in square brackets [  ] 
The names of buttons in a window, and window names, are enclosed in 
square brackets. 
Example: Click [OK]. 

Text in quotation marks "  " 
Entered numerical values, text, and keyboard key names are indicated 
enclosed in quotation marks. 
Example: Press the "N" key while holding down the "Ctrl" key. 
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Use of Instruction Manuals 
LabSolutions IR (file management version), LabSolutions DB IR (database version), and LabSolutions CS IR 

(client server version) are available for LabSolutions IR software. 

The procedures for data management, startup, and network connection differ between each version. 

For details, see "1.2 Software Edition" in this manual. 

 

The LabSolutions IR software comprises the LabSolutions Manager program and the LabSolutions IR 

program. The instruction manuals, including this manual, are organized as follows. 

Refer to the corresponding instruction manual for details on the operation of LabSolutions IR. 

[LabSolutions IR] 
 

Instruction Manual Description 

Installation and Maintenance Guide 
This manual explains software installation, troubleshooting, and 
environment settings. 

System Users Guide 
This manual explains how to use the management function and 
validation software. 

Basic Operation Guide 
(this manual) 

This manual explains specifically how to perform basic operations 
using the software. 

Quick Guide 
This quick guide briefly introduces software startup through to initial 
operation. 

 

[LabSolutions DB IR/LabSolutions CS IR] 

Instruction Manual Description 

LabSolutions Manager DB 
Installation & Maintenance Guide 
or 

LabSolutions Manager CS 
Installation & Maintenance Guide 

This manual explains software installation, troubleshooting, and 
environment settings. 

LabSolutions DB/CS IR 
Installation & Maintenance Guide 

IR Volume (this manual) 

This manual explains FTIR model-specific installation, 
troubleshooting, and environment settings. 

LabSolutions Manager DB 
System Users Guide IR Volume  
or 
LabSolutions Manager CS 
System Users Guide  

This manual explains how to use the management function, data 
management function, and validation software with respect to 
LabSolutions system. 

LabSolutions DB/CS IR 
System Users Guide IR Volume 

This manual explains how to use the FTIR model-specific 
management function and validation software. 

LabSolutions IR  
Basic Operation Guide(this manual) 

This manual explains specifically how to perform basic operations 
using the software. 

LabSolutions IR Quick Guide 
This quick guide briefly introduces software startup through to initial 
operation. 

For details on each command in the LabSolutions IR software and execution method, refer to help file 
provided with the LabSolutions IR software. 

This manual uses the file management version of LabSolutions IR to explain operation. 

The basic operation manual is aimed at new users of the LabSolutions IR software and describes the basic 
operating procedures of the software. This manual provides a run-through of routine operations performed 
using the LabSolutions IR software. 

Explanations in this manual are structured as follows. 
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Notation Meaning 

Safety Instructions 
Describes the precautions related to the usage of this product. 
Always read and thoroughly understand this section. 

Chapter 1 Basic Software Operation Provides an outline of the LabSolutions IR software. 

Chapter 2 Starting the System 
Describes the startup procedures from turning on the system 
to software startup. 

Chapter 3 Launcher Describes how to use the launcher. 

Chapter 4 Spectrum Describes how to use the spectrum measurement function. 

Chapter 5 Quantitation 
Describes how to use the quantitation measurement function 
that employs the multi-point calibration curve method. 

Chapter 6 Photometric Describes how to use the photometric measurement function. 

Chapter 7 Postrun/View 
Describes how to use the postrun function and view function of 
each measurement program. 

Chapter 8 Manipulation Describes how to use the manipulation function. 

Chapter 9 Search 
Describes how to use the search function and how to create 
and edit libraries. 

Chapter 10 Chemometric Quantitation Describes how to use the CLS quantitative functions. 

Chapter 11 Printing Describes how to use the printing function. 

Chapter 12 Easy Macro Program 
Describes how to create, edit, and execute easy macro
program. 

Chapter 13 Shutting Down the System Describes how to shut down the system. 

Chapter 14 [Easy Scan] Program 

Describes how to use the [Easy Scan] program. 
The series of steps for configuring parameter settings, 
performing background measurement, sample measurement, 
and peak pick, and printing reports can be performed 
automatically. 

Chapter 15 Contaminant Analysis 
Program 

Describes how to use the contaminant analysis program.
After contaminant measurement is complete, spectrum search, 
qualitative analysis, and report printing can be performed 
automatically. 

Chapter 16 PharmaReport Program 
Food Additives Identification 
Program 

Describes how to use the PharmaReport program and Food 
Additives Identification program. 
This program has the following three functions. 
1. Compare a sample spectrum and standard spectrum and 

print a report of the comparison results. 
2. Perform peak pick on a sample spectrum for the specified 

wavenumbers and print a report of the detection results. 
3. Combine the functions above functions and perform 

automatic identification. 

Chapter 17 Purity Judge Program 

Describes how to use the purity judge program. 
The program calculates the conformity score between the 
sample spectrum and the reference spectrum to make 
pass/fail judgment.  
Judgment parameters can be registered in advance so the 
judgment can be performed automatically by simply selecting 
the spectrum. The result of jusgment can be printed. 

Chapter 18 Appendix 
Describes how to use many of the convenient functions in 
LabSolutions IR, such as library conversion. 

While chapters 3 to 17 describe examples of operation that are considered to be the most frequently used, these 
examples may not always be consistent with your specific operational requirements. In this case, an 
understanding of basic methodology and operating procedures can be attained by performing operations based 
on the actual examples in this manual. 

Shimadzu recommends attempting the examples in this manual until you become accustomed to operating the 
software. 

For explanations on items not covered in the above chapters, refer to the help file provided with the 
LabSolutions IR software. 
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Warranty 
Shimadzu provides the following warranty for this product. 

1. Period: Please contact your Shimadzu representative for information about the period of 
this warranty. 

2. Description: If a product/part failure occurs for reasons attributable to Shimadzu during the 
warranty period, Shimadzu will repair or replace the product/part free of charge. 
However, in the case of products which are usually available on the market only 
for a short time, such as personal computers and their peripherals/parts, Shimadzu 
may not be able to provide identical replacement products. 

3. Limitation of 
Liability: 

1. In no event will Shimadzu be liable for any lost revenue, profit or data, or for 
special, indirect, consequential, incidental or punitive damages, however caused 
regardless of the theory of liability, arising out of or related to the use of or 
inability to use the product, even if Shimadzu has been advised of the possibility 
of such damage. 

2. In no event will Shimadzu's liability to you, whether in contract, tort (including 
negligence), or otherwise, exceed the amount you paid for the product. 

4. Exceptions: Failures caused by the following are excluded from the warranty, even if they 
occur during the warranty period. 

1. Improper product handling 

2. Repairs or modifications performed by parties other than Shimadzu or 
Shimadzu designated companies 

3. Product use in combination with hardware or software other than that 
designated by Shimadzu 

4. Computer viruses leading to device failures and damage to data and software, 
including the product's basic software 

5. Power failures, including power outages and sudden voltage drops, leading to 
device failures and damage to data and software, including the product's basic 
software 

6. Turning OFF the product without following the proper shutdown procedure 
leading to device failures and damage to data and software, including the 
product's basic software 

7. Reasons unrelated to the product itself 

8. Product use in harsh environments, such as those subject to high temperatures or 
humidity levels, corrosive gases, or strong vibrations 

9. Fires, earthquakes, or any other act of nature, contamination by radioactive or 
hazardous substances, or any other force majeure event, including wars, riots, 
and crimes 

10. Product movement or transportation after installation 

11. Consumable items  
Recording media such as CD-ROMs are considered consumable items. 

 * If there is a document such as a warranty provided with the product, or there is a separate 
contract agreed upon that includes warranty conditions, the provisions of those documents 
shall apply. 
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After-Sales Service and Availability of 
Replacement Parts 

After-Sales 
Service 

If any problems occur with this product, perform an inspection and take 
appropriate corrective action as described in this manual's troubleshooting 
section. 

If the problem persists, or the symptoms are not covered in the 
troubleshooting section, contact your Shimadzu representative. 

 

Replacement 
Parts Availability 

Replacement parts for this product will be available for a period of seven (7) 
years after the product is discontinued. Thereafter, such parts may cease to be 
available. 

Note, however, that the availability of parts not manufactured by Shimadzu 
shall be determined by the relevant manufacturers. 
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Software License Agreement 
PLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THE SOFTWARE. 
SHIMADZU Corporation (“SMZ”) is willing to license the SMZ software provided herein, together with 
accompanying documentation (collectively “SOFTWARE”) to you only upon the condition that you accept 
all of the terms and condition contained in this License Agreement. By using the SOFTWARE, you agree to 
be bound by the terms of this Agreement. If you do not agree to all these terms of this Agreement, 
promptly return the unused SOFTWARE to the party (either SMZ or its reseller) from whom you acquired it 
to receive a refund of the amount you paid. 

 

1. LICENSE. SMZ grants you a non-exclusive and nontransferable license to use the 
SOFTWARE subject to the following terms and conditions. 

2. LIMITATION OF 
USE. 

Except as specifically authorized by SMZ, you may NOT: 
a. Use the SOFTWARE, or permit the SOFTWARE to be used, on more than one 

computer at any one time. 
b. Copy the SOFTWARE except one (1) archival copy of the SOFTWARE. 
c. Modify, reverse engineer, decompile, disassemble, or create derivative works 

based upon the SOFTWARE. 
d. Transfer, rent, lease or grant any rights in the SOFTWARE in any form to 

anyone else. 

3. TITLE AND 
OWNERSHIP.

This license is not for sale and it may not be assigned or sublicensed to anyone 
else. Title and all associated intellectual property rights to the SOFTWARE shall 
remain in SMZ and/or its licensor. 

4. UPGRADES. You are entitled to receive all official software upgrades for the SOFTWARE that 
SMZ will release as deemed necessary by SMZ. An upgrade means certain 
supplemental program modules and/or information for bug fixing and/or updates to 
the defects and/or failures of the SOFTWARE that are acknowledged or confirmed 
by SMZ. An upgrade excludes hardware, network, consulting services, third party 
products, operation and general computer system maintenance. All supplemental 
program module for upgrades and enhancements furnished to you shall be 
deemed to be part of the SOFTWARE and subject to the terms and conditions set 
forth in this Agreement. 

5. LIMITED 
WARRANTY. 

SMZ warrants that for a period of one (1) year from the date of purchase, as 
evidenced by a copy of the receipt, the media on which SOFTWARE is furnished 
will be free of defects in materials and workmanship under normal use. 
Except for the foregoing, SOFTWARE is provided AS IS. Your exclusive remedy 
and the entire liability of SMZ and its suppliers under this limited warranty will be, 
at SMZ’s option, repair, replacement, or refund of the Software if reported (or, 
upon request, returned) to the party supplying the SOFTWARE to you. In no event 
does SMZ warrant that the Software is error free or that you will be able to operate 
the SOFTWARE without problems or interruptions. 
EXCEPT AS SPECIFIED IN THIS WARRANTY, ALL EXPRESS OR IMPLIED 
CONDITIONS, REPRESENTATIONS, AND WARRANTIES INCLUDING, 
WITHOUT LIMITATION, ANY IMPLIED WARRANTY OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT, ARISING 
FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE, ARE 
HEREBY EXCLUDED TO THE EXTENT ALLOWED BY APPLICABLE LAW. 

6. LIMITATION OF 
LIABILITY. 

IN NO EVENT WILL SMZ BE LIABLE FOR ANY LOST REVENUE, PROFIT OR 
DATA, OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTAL OR 
PUNITIVE DAMAGES, HOWEVER CAUSED REGARDLESS OF THE THEORY 
OF LIABILITY, ARISING OUT OF OR RELATED TO THE USE OF OR INABILITY 
TO USE SOFTWARE, EVEN IF SMZ HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. IN NO EVENT WILL SMZ’S LIABILITY TO 
YOU, WHETHER IN CONTRACT, TORT (INCLUDING NEGLIGENCE), OR 
OTHERWISE, EXCEED THE AMOUNT YOU PAID FOR SOFTWARE. 

7. TERMINATION. This License is effective until terminated. You may terminate this License at any 
time by destroying all copies of SOFTWARE including any documentation. This 
License will terminate immediately without notice from SMZ if you fail to comply 
with any provision of this License. Upon termination, you must destroy all copies of 
SOFTWARE. 
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8. GENERAL a. This Agreement is the entire agreement. If any provision of this agreement is 
held invalid, the remainder of this agreement shall continue in full force and 
effect. 

b. This Agreement shall be construed and governed in accordance with the laws 
of Japan, excluding its conflict of law rules. 

c. The exclusive jurisdiction for any disputes arising out of or in connection with 
this Agreement shall be Kyoto District Court of Japan. 

d. The invalidity or unenforceability of any provision of this Agreement shall not 
affect the validity or enforceability of any other provision. 
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Notice 
 

 Latest information 

Latest information for LabSolutions IR software is described in "ReadmeE.htm" in both of Installation Disk. 

Please refer to both of them before using IRsolution software. 

 

 Operating system  

LabSolutions IR software only runs on Windows 7 Professional 32-bit and 64-bit.  

  

 Screensaver 

If the screensaver activates during continuous measurements, Time course measurement, mapping 

measurement, or other types of measurements, the software may stopped operating. Turn off the screensaver 

function in your corresponding version of Windows. 

 

 Resident programs running on the LabSolutions IR PC (such as anti-virus software) 

LabSolutions IR starts up, runs and exits very slowly when resident programs such anti-virus software are 

running on the LabSolutions IR PC. Please exit any such programs before using the LabSolutions IR software. 

  

 Windows 7 Aero function  

The following problems may occur when the Windows 7 Aero function is enabled. While these problems do 

not affect the operation of LabSolutions IR, the Aero function should be disabled to avoid display issues. 

 The trail of mouse movement may become white on graphs.  

 Parts of 3D/4D data on graphs may not be displayed correctly and axis labels may not be displayed. 

 If the mouse is moved too quickly when performing operations such as magnification, the drawn position 

may be shifted. 

The following problem may occur when the Windows 7 Aero function is disabled, however, it does not affect 

the operation of LabSolutions IR. 

 The blue, yellow, and red icons on the status display in the measurement program may flicker. 

 

 3D data  

Be aware that processing of 3D data may take time depending on the display card used in the LabSolutions 

PC. 

  

 Characters to be input 

Unicode characters cannot be used on LabSolutions IR. Please never use Unicode characters. 

 

 Numerical values 

Please input numbers by the normal-width figure on this program. 

 

 



Introduction 

x  LabSolutions IR Basic Operation Manual 

 Floppy disks  

LabSolutions IR requires four to five times the disk space of files on the same storage device when loading 

and saving. Therefore, if a file is loaded from a floppy disk, the file might be lost due to a shortage of space. 

Do not use floppy disks. Files on floppy disk must be copied to the hard disk before loading into LabSolutions 

IR.  

  

 Macro program and file saving  

When the [Save the dataset after modification immediately] checkbox is selected in the security policy, 

overwriting to an existing file is prohibited on normal operation of LabSolutions IR. 

A macro program can overwrite to an existing file because they are used for automation.  

  

 Macro program and scan parameters  

When a macro program is run that includes changes to scan parameters, the scan parameters are changed and 

cannot be returned to their previous values. Even if a user without rights to edit scan parameters runs a macro 

program that includes changes to scan parameters, the scan parameters are changed. Memorizing or saving 

scan parameters before running macro programs is recommended. 

 

 Importing data from text format  

LabSolutions IR can import data converted to ASCII (Simple Text) format in IRsolution and data created X Y 

format by spreadsheet software. Note that while this data can be imported into LabSolutions IR, it cannot be 

searched or manipulated. 

 

 ATR measurement 

Before ATR measurement, we recommend checking how pressure is applied on the prism by performing 

monitor measurement. If you perform ATR measurement as a user who is not allowed to perform monitor 

measurement, be extremely careful not to damage the prism and sample. 
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Chapter 1 Basic Software Operation 
 

This chapter provides an outline of the LabSolutions IR software and explains basic operation. 

Refer to the help file provided with the LabSolutions IR software for examples not included in this 
manual. 

Refer to the help file provided with LabSolutions IR for detailed explanations, tutorials, and other 
information regarding LabSolutions IR functions. 

 

 Explanations included in this chapter 
This chapter provides an outline of the LabSolutions IR specifications and software. 
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1.1 Outline 
The LabSolutions IR software is one component of the LabSolutions software series and is used 
with the Shimadzu's Fourier Transform Infrared Spectrophotometer series to control the instrument 
and perform data analysis. 

 

1.1.1 Specifications 
Item Specifications 

Operating system Microsoft Windows 7 Professional 32 bit version/64 bit version 

Required hard disk space 300 MB min. 

Required memory 4 GB min. 

Controllable devices FTIR 
 FTIR-8300/8400/8400S/8700/8900 

 IRTracer-100 

 IRPrestige-21 

 IRAffinity-1 series 

Infrared microscope 
 AIM-8800 

Programs Postrun program 
Spectrum program 
Quantitation program 
Photometric program 
Time course program (option) 
Mapping program (option) 

Manipulation functions Four Arithmetic Operations, Normalize, Zero Baseline Correction, 3 Point 
Baseline Correction, Multipoint Baseline Correction, Smoothing, Derivative, 
Cut ,Connect, Reduce, Interpolate, Frequency Convert, X Adjust, 
Time-Temperature Conversion, Peak Pick, Film Thickness, Data Calculation, 
Purity, Deconvolution, FFT, Kubelka Munk, ATR Correction, Kramers Kronig, 
Atmosphere Correction, 3D Reprocess, 3D Extract 

Manipulation functions 
(option) 

Peak split, 3D recalculation, spectrum extraction from 3D data 

Search functions Spectrum search, peak search, text search, combination search 

Usable libraries User libraries, Sadtler libraries, STJ libraries, etc. 

Quantitative functions Multi-point calibration curve method 
CLS quantitative method 
PLS quantitative method (option) 
Photometrics 
Recalculation function for quantitative and photometric results 

Printing functions Report template creation 
Printing using report templates 
Easy printing using the ViewPrint function 

GLP/GMP support Tree-structured audit trail function 
Recording of operation logs and data logs (history) 
Saving by overwriting the same filename is prohibited 

Security functions Coordination with LabSolutions security functions 
User-group based privilege settings 

Macro functions Easy macro function 
 Collective execution of multiple operations by simply arranging operations in 

the order of the procedure 

 Execution possible from the desktop 

Macro platform (option) 
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1.2 Software Edition 
Shimadzu offers the following three software versions in the LabSolutions IR series. 

This manual uses the file management version of LabSolutions IR to explain operation. 
 

Name LabSolutions IR LabSolutions DB IR LabSolutions CS IR 
Edition File management edition Database edition Client server edition 
Data management 
method 

Measured data files are 
saved and managed in 
folders on the PC. The 
existence of data files can 
be checked using 
Windows Explorer. 

Measured data files are saved and managed in the 
LabSolutions database. 
The existence of data files cannot be checked using 
Windows Explorer. 

Data references The software references 
files on drives or in folders 
on the PC. 

The software references files in the database. 

Transferring 
LabSolutions IR data 
between PCs 

Transfer of files Loading via import 
(Data can be either copied to a local destination using 
the data file export function or downloaded from the 
database manager.) 

LabSolutions database Unavailable Available 
(The database resides on a 
local PC) 

Available 
(The database resides on a 
server) 

CLASS-Agent 
database 

Available (Option) Unavailable 
(The contents of the CLASS-Agent database can be 
transferred to the LabSolutions database.) 

User administration Available 
Rights group 
administration 

Available 

Project administration Unavailable Available 
Standalone/network Either can be used. Only the standalone 

configuration can be used.
Only databases on the 
network can be used. 
(LabSolutions IR data can 
be viewed using the 
database manager on a PC 
set up for viewing 
purposes. Note that 
LabSolutions IR must be 
installed on the PC used for 
viewing.) 

Data backup Performed on a file-by-file 
basis using Windows 
Explorer. 

Performed for each database. 

Startup method LabSolutions IR icon 
LabSolutions icon 

LabSolutions icon 

Easy macro program Available Cannot use the file loading function. 
Validation program Available Only validation through measurement can be used. 

Validation of previously measured spectra can be used 
after copying the necessary files from the database to a 
local folder. 

Identification test 
program 

Available Only identification tests through measurement can be 
used. 
Identification tests of previously measured spectra can 
be used after copying the necessary files from the 
database to a local folder. 

Contaminant analysis 
program 

Available Can be used after copying files from the database to a 
local folder. 

[Easy Scan] program Available Available 
Report viewer Available Can be used after copying the necessary files from the 

database to a local folder. 
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1.3 Startup Method 
There are two methods available for starting LabSolutions IR: startup via the LabSolutions IR icon 
(file management version only) and startup via the LabSolutions icon. 

For details on each startup method, see "2.2 Starting LabSolutions IR". 

1.3.1 LabSolutions IR Window Layout 
The layout of the window for each measurement program in LabSolutions IR is shown below. 

  
For details on the window layout of postrun/view, see "Chapter 7 Postrun/View". 

 

 
Spectrum Measurement Window 

 

As an example, the layout of the spectrum measurement window is described in the table below. 

No. Name Function 

1 Main toolbar The main toolbar common to all LabSolutions IR windows. 
Printing, searching, and manipulation can be performed from this 
toolbar. 

2 Menu bar These menus are common to all LabSolutions IR windows. 

3 Tree view Common to all LabSolutions IR windows. 
Displays scan parameters, peak pick tables, and data history saved 
together with the currently opened data in a hierarchical view. 
Click [+] on each node to expand the hierarchy contained within. 

4 Log Displays and records logs and warnings resulting from LabSolutions 
IR operation. 

5 Measurement toolbar A toolbar specific to each measurement program. 
It contains buttons for performing measurement and controlling the 
instrument. 

6 Status monitor Displays the state of the FTIR's interferometer. 

7 Scan parameters Set scan parameters in this area. 

8 Data area Displays measured data. 

2

1

5

6

7

3 

4 

8



1.3 Startup Method 
 

LabSolutions IR Basic Operation Manual  5 

1.3.2 Tree View 
The tree view structure is shown below. 

Display or hide the tree view by clicking [Tree View] on the [View] menu. 

 
Example of Spectrum Data 

 

Measure a sample or open data to display data in the tree view and data area. 

At first, data is displayed at the top of the hierarchical structure. When data is processed, new data 
is added at the lower levels. 

If other data is added, it is displayed at the top of the hierarchical structure. Close the data to remove 
the data from the tree view and data area. 

For details on the data format of displayed data, see "1.3.4 Data Formats of the LabSolutions IR 
Software". 

The following operations can be performed on data in the tree view. 

Operation Description 

Click [+] or ] to 
the left of data 

Display or hide the contents of the data in the tree view. 
 Click [+] to display data lower in the hierarchy. 

 Click [] to hide data lower in the hierarchy. 

Double-click Double-click on data to perform processing on it. 
The type of processing differs depending on the program or displayed window. 
Double-click when the postrun program is running or the view window is shown to display 
the corresponding data. 
Double-click when the Quantitation program, Photometric program, or chemometrics 
window is shown to add the corresponding spectrum to the sample table. 

[Original data] (absorbance or transmittance) 

[Data file.ispd] 

[Properties] 

(Annotation) 

(Peak pick table) 

(Spectrum search results) 

(Quantitative results) 

[Sample interferogram] 

[Background interferogram] 

[Manipulation 
result 1] 

[Manipulation 
result 1] 

(Scan parameters) 

(History) 

[Properties] 

(Annotation) 

(Peak pick table) 

[Manipulation 
result 1 of 1] 

(History) 

[Properties] 

(Annotation) 

(Peak pick table) 

(History) 

(History)

[Properties] 

(Annotation) 

(Peak pick table) 
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Operation Description 

Right-click Right-click on data to execute any of the following operations on the command menu, 
which are displayed according to the context of the task. 
 Clear the data tab display 

 Select to display or hide parameters 

 Specify a file for manipulation 

 Add data to a library 

Drag Drag data to the data area to perform processing on it. 
The type of processing differs depending on the program or displayed window. 
Double-click when the postrun program is running or the view window is shown to display 
the corresponding data. 
Drag when the Quantitation program, Photometric program, or chemometrics window is 
shown to add the corresponding spectrum to the sample table. 

 

1.3.3 Right-Click Menu 
Right-click on the tree view or graph area to display menu commands specific to the current task. 
This allows commands to be easily executed without having to select via a menu or the toolbar. 

 

1.3.4 Data Formats of the LabSolutions IR Software 
Because LabSolutions IR data files are compatible with GLP/GMP, original data obtained during 
measurement and all calculation results obtained using various manipulation functions are saved in 
a single file. 

Accordingly, a single data file generally stores multiple data. 

For this reason, files that contain all of the data are referred to as "containers" and each set of data 
within a container is referred to as a "data set". In addition, each data set is appended with auxiliary 
information. 

 

 Data sets included in the container for spectrum data 

Item Description 

Sample transmittance or 
absorbance data 

This is the data of the sample that is normally used. 
This data set is used in the analysis of the sample. 

Sample interferogram Raw measurement data of the sample obtained from the instrument. 

Background interferogram Raw measurement data of the background obtained from the instrument. 

All manipulation results Result data obtained from applying various manipulation functions to the 
data set. This data is regarded as independent data and added to the 
container. 

Quantitative results The results of quantitative calculation. 

Spectrum search results Spectrum search results (hit list) and spectral subtraction calculation 
results. 

 

 Data sets included in the container for mapping measurement data and Time course 
measurement data 

Item Description 

3D/4D data A 3D display of mapping measurement data and Time course 
measurement data. 

Constructed spectrum Spectrum data of each position vs. time. 
Each position contains its own data chart (data set of spectrum data). 

TAC/SAC TAC/SAC data calculated from mapping measurement data or Time 
course measurement data. 
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 Data sets included in the container for quantitation measurement data and photometric 
measurement data 

Item Description 

Standard sample table 
Unknown sample table 
Sample table 

Table data with information including the sample name and concentration.

Constructed spectrum Standard sample, unknown sample, and sample spectrum data. 
Each position contains its own data chart (data set of spectrum data). 

 

 Auxiliary data appended to each data set 

Item Description 

History History of data set generation and modification 

Scan parameters Parameters used during measurement 

Annotation A list of comments entered in the spectrum window using the annotation 
function 

Peak pick table Peak pick table generated using the peak pick function 

Point pick table Point pick table generated using the Point pick function 
 

When these data sets are created through measurement or a saved container is loaded into the 
software, they are displayed on screen in the tree view so that dependencies between data sets are 
apparent. 

In the case of spectrum data, although transmittance or absorbance data of a sample is created 
during measurement, this data is displayed at the top of the hierarchy in the tree view. Other data 
sets and auxiliary data appended directly to the top data set are displayed at lower levels in the 
hierarchy. 

Auxiliary data is also appended to each data set other than the top data set. When manipulation is 
executed, the resulting spectrum is inserted as a new data set directly under the original data set for 
which processing was executed. 

One of the data sets among these is regarded to represent the entire container file and is used for 
display and data analysis by the software. This data set is referred to as the "active data set" and 
usually specifies the original transmittance or absorbance data of sample. If any manipulation is 
performed on the active data set, the result of such processing then becomes the new active data 
set. The software also allows the active data set to be selected manually. 
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1.3.5 File Formats of the LabSolutions IR Software 
The following file formats can be used with the LabSolutions IR software. 

It is possible to set the file formats (filters) for use in [File Preferences] - [File Filters] on the [Tool] 
menu. 

 

 Data files 

Name Extension Description 

Spectrum file ispd This file contains spectrum data. 
In addition to sample spectra, this file contains spectra of manipulation 
in progress, background and sample interferograms, scan parameters 
and peak pick tables, Point pick tables, and search results. 

Area mapping file i4dd This file contains area mapping measurement data. 
In addition to data for 3D display, this file contains visible images, a 
sample spectrum for each position, background and sample 
interferograms, and scan parameters. 
Execute [3D Manipulation] to replace the metadata in the sample 
spectrum with that of the calculation results. Any subsequent 
manipulation can only be executed with respect to the latest 
calculation results. 
Manipulation with respect to each sample spectrum is performed after 
the corresponding spectra have been exported. 

Line mapping file i3dd This file contains line mapping measurement data. 
In addition to data for 3D display, this file contains visible images, a 
sample spectrum for each position, background and sample 
interferograms, and scan parameters. 
Execute [3D Manipulation] to replace the metadata in the sample 
spectrum with that of the calculation results. Any subsequent 
manipulation can only be executed with respect to the latest 
calculation results. 
Manipulation with respect to each sample spectrum is performed after 
the corresponding spectra have been exported. 

Time course file itcd This file contains Time course measurement data. 
In addition to data for 3D display, this file contains a sample spectrum 
for each point in time, background and sample interferograms, and 
scan parameters. 
Execute [3D Manipulation] to replace the metadata in the sample 
spectrum with that of the calculation results. Any subsequent 
manipulation can only be executed with respect to the latest 
calculation results. 
Manipulation with respect to each sample spectrum is performed after 
the corresponding spectra have been exported. 

Rapid scan file rspc This file contains rapid scan measurement data. 
In addition to data for 3D display, this file contains a sample spectrum 
for each point in time, background and sample interferograms, and 
scan parameters. 
Execute [3D Manipulation] to replace the metadata in the sample 
spectrum with that of the calculation results. Any subsequent 
manipulation can only be executed with respect to the latest 
calculation results. 
Manipulation with respect to each sample spectrum is performed after 
the corresponding spectra have been exported. 
While this file can be loaded, it cannot be output. 

2D file i2dd This file contains a change of position graph cut from line mapping 
measurement data using [Extract] or a change over time graph cut 
from Time course measurement data using [Extract]. 

Calibration curve file istd This file contains the calibration curve data used in quantitation 
measurement. 
It comprises a standard sample table, calibration curve parameters, 
and standard sample spectra. 
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Name Extension Description 

Quantitation file irqt This file contains the quantitative result data from quantitation 
measurement. 
It comprises a standard sample table, calibration curve parameters, 
standard sample spectra, unknown sample table, and unknown 
sample spectra. 

CLS calibration curve 
file 
PLS calibration curve 
file 

irqc These files contain the calibration curve data used in CLS and PLS 
quantitation measurement. 
It comprises a standard sample table, calibration curve parameters, 
and standard sample spectra. 

Photometric file ipht This file contains the photometric result data from photometric 
measurement. 
It comprises a sample table, photometric parameters, and sample 
spectra. 

JCAMP-DX file dx/cs/jpx 
/jcm 

This is a JCAMP-DX format file. 
This file can be loaded and saved (exported). 
This file format is used when sharing data with software products 
developed by other companies. 
Only one set of data (one spectrum) can be saved per file. 
JCAMP-DX format settings can be configured in [File Preferences] - 
[File Filters] - [JCAMP-DX Files] on the [Tool] menu. 

ASCII file asc This is an ASCII format file. 
This file can be loaded and saved (exported). 
It consists of a predetermined header file and a list of vertical axis 
value data (such as transmittance or absorbance). 
Only one set of data (one spectrum) can be saved per file. 

ASCII Simple Text 
(text) file 

txt This text format file format contains horizontal axis values (such as 
wavenumbers) and the corresponding vertical axis values (such as 
transmittance or absorbance) delimited with commas. 
This file can be loaded and saved (exported). 
It is used when handling data in spreadsheet software. 
Only one set of data (one spectrum) can be saved per file. 

ASCII UVProbe 
Spectrum (text) file 

txt A spectrum file which is saved as Data pritn format on UVProbe can 
be imported to LabSolutions IR. 
A spectrum file is exported to a text format which can be loaded on 
UVProbe. 
Only one set of data (one spectrum) can be saved per file. 

HYPER-IR file irs This file format was used in the HYPER-IR software. 
This file can be loaded and saved (exported). 
Only one set of data (one spectrum) can be saved per file. 

IRsolution file smf This file contains the data measured using the IRsolution software. 
While this type of file can be loaded, smf format files cannot be output.
This file can contain spectra, 3D, 4D, calibration curve, or 2D files. 
In addition to sample spectra, this file contains spectra of manipulation 
in progress, background and sample interferograms, scan parameters 
and peak pick tables, Point pick tables, search results, and calibration 
curves. 

3D file 3d This is a 3D data file obtained using mapping measurement with the 
HYPER-IR software. 
While this file can be loaded, it cannot be output. 

4D file 4d This is a 4D data file obtained using mapping measurement with the 
HYPER-IR software. 
While this file can be loaded, it cannot be output. 
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 Parameter files 

Name Extension Description 

Scan parameters iscp This file stores scan parameters. 
It is not compatible with the IRsolution software. 

Time course scan 
parameter file 

itcp This file stores Time course scan parameters. 
It contains Time course measurement settings, scan parameters, and 
equation settings. 

Photometric condition 
file 

iphp This condition file is used for photometric measurement. 
It contains photometric parameters, scan parameters, and equation 
settings. 

Point pick template file iptm This template file is used for Point pick. 

Equation file iequ This file stores equations used in mapping measurement, Time course 
measurement, quantitation measurement, and photometric 
measurement. 

Report template file irtm This is a report template file. 
It is not compatible with the IRsolution software. 

Search parameter file isrp This file contains the search parameters used in spectrum search. 
It is not compatible with the IRsolution software. 

 

 User libraries 

Name Extension Description 

User library file Idx 
idx2 
sig 
nam 
l + 
two-digit 
number 

This library file comprises five types of identically named files that 
have different file extensions. 
Regard the five types as a single group. 

 

 Easy macro program and VB macro program files 

Name Extension Description 

Easy macro sequence 
file 

iscq This is an easy macro program. 

Macro container file ilcm/lcm This is a Visual BASIC macro program in container format. 

BASIC file bas This is the file format of Visual BASIC macro programs. 
 

 Other 

Name Extension Description 

Log log This file contains the history of operations performed using the 
software. 
The contents of this file can be checked in [Operation Log] - [View] on 
the [Tool] menu. 
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1.4 Window Operation 
This section explains window operation in LabSolutions IR. 

 

1.4.1 Specifying Data (Making Data Active) 
The user must specify the data for processing when multiple data is displayed on screen. 

Use the following methods to specify the data for processing. 

 Click [Activate Next] on the [Graph] menu. 

 Click [Activate Next] on the right-click menu. 

 Click the data line on the graph. 

 Click the legend displayed in the graph area. 

 

1.4.2 Active Pointer 
In addition to measured spectra, the LabSolutions IR data file also contains sample interferograms, 
background interferograms, and spectra resulting from manipulation. 

The user must decide on the data to display first when opening a data file because showing all the 
data at once will only cause confusion. The indicator used for the data to be displayed first is called 
the active pointer. 

 

Only one active pointer can be set for each data file. 

When a data file is opened, the data set with the active pointer is displayed. 

The active pointer is automatically set to the following in data files. 

 Measured spectrum 

 Resulting spectrum of the last manipulation 

 Last displayed spectrum 

 The spectrum with the active pointer checkmark in tree view 

Manipulation, searching, and quantitative calculation use the active data that is set with the active 
pointer in calculation. To use data that is not set with the active pointer in calculation, display the 
data and then process it manually using each relevant screen. 

 

 
Active Pointer 
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Chapter 2 Starting the System 
 

This chapter explains the procedure for starting the system, from turning on power to software 
startup, and assumes that the LabSolutions IR software is already installed on the PC for use. 

For details on Windows operation, refer to the relevant Windows manual. 

 

2.1 Turning the Power ON 
2.1.1 For IRTracer-100 

1. Turn ON the activation switch on the IRTracer-100. 

 

2. Turn ON power to the PC. 

A system check is performed and then Windows starts up. 
 
 

2.1.2 For IRPrestige-21 

1. Turn ON the main switch on the IRPrestige-21. 

 

2. Turn ON power to the PC. 

A system check is performed and then Windows starts up. 
 

main switch 

Activation Switch 
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2.1.3 For the IRAffinity-1 Series 

1. Turn ON the activation switch on the IRAffinity-1 series instrument. 

 

2. Turn ON power to the PC. 

A system check is performed and then Windows starts up. 

  
Internal initialization of the instrument is performed when the IRAffinity-1 series is turned on. 

The instrument performs initialization when the power is turned on if an auto sample changer, 
such as the ASC-8000T, is connected to the sample compartment. Be careful not to allow your 
fingers to become caught in the instrument during initialization. 

The auto sample changer must be initialized by the LabSolutions IR software even if it was 
already initialized when the IRAffinity-1 series instrument was turned on. 

 
 

2.1.4 For the FTIR-8000 Series 

1. Turn ON the activation switch on the FTIR-8000 series instrument. 

 
 

2. Turn ON power to the PC. 

A system check is performed and then Windows starts up. 
 

activation switch

activation switch (ON is indicated by the | mark) Power indicator 
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2.2 Starting LabSolutions IR 
Use either of the following methods to start LabSolutions IR. 

 

2.2.1 Startup Using the LabSolutions IR Icon (File Management Version 
Only) 
Use the following startup method when using LabSolutions IR programs, such as the Spectrum 
program. 

1. Double-click  (LabSolutions IR) on the desktop. 

  
The software can also be started by clicking the [Start] button, navigating to [LabSolutions] - [IR] 
under [Programs], and clicking [LabSolutions IR]. 

2. Enter a user ID and password into the [Login] window and click [OK]. 

The launcher starts. 
 

 
[Login] Window 
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3. Click the program to start on the [Shortcut] tab. 

The program starts. 

 
Launcher 

 

 

2.2.2 Startup Using the LabSolutions Icon 

Double-click  (LabSolutions) to start the software and to reference the security policy, 

system settings, user management details, and manual.  

The database and client server versions are started using this method. 

Each program in LabSolutions IR can be started from the [LabSolutions Main] window. 

1. Double-click  (LabSolutions) on the desktop.  

  
The software can also be started by clicking the [Start] button, navigating to [LabSolutions] 
under [Programs], and clicking [LabSolutions]. 

2. Enter a user ID and password into the [Login] window and click [OK]. 

 
[Login] Window 
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The [LabSolutions Main] window is displayed. 
 

 
[LabSolutions Main] Window 

3. Click [Instruments]. 

4. Double-click [FTIR]. 

The launcher starts. 
Click the desired program on the [Shortcut] tab to start it. 

 

 
Launcher 
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2.2.3 Connecting to the Instrument 

1. Check that there is nothing obstructing the infrared beam in the sample compartment. 

Remove the sample and any accessories from the sample compartment. 
 

  
If something obstructs the infrared beam in the sample compartment, such as the sample or an 
accessory, the "Power diagnostic" and other tests performed during self diagnostics will fail 
(result in NG). 

2. Click [Instrument] on the measurement toolbar in LabSolutions IR measurement program, and 
select [Initialize]. 

The software connects to the instrument and measurement becomes possible. 
 

  
 Click [Instrument Preferences] - [FTIR Preferences] on the [Tool] menu in LabSolutions IR 

and select the [Initialize FTIR on startup] checkbox to automatically connect to the 
instrument upon LabSolutions IR startup. 

 The following message is displayed when background data from previous sessions is found 
on the hard disk. Click [Yes] to discard the previous background data or click [No] to use it in 
the subsequent session. 

 
Discarding of Background Data from Previous Sessions 

 

 Select the FTIR to be used in the [Instrument Preferences] window, which is displayed by 
clicking [Instrument Preferences] - [Instrument Type] on the [Tool] menu. 

 Other programs, such as anti-virus software, running on the PC used for LabSolutions IR 
may cause the LabSolutions IR software to start up, run, and exit slowly. 
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2.3 Correcting Initialization Errors 
2.3.1 LabSolutions IR Cannot Communicate with the IRPrestige-21 

Cause Solution 

The IRPrestige-21 is not 
turned ON. 

(1) Turn ON the main switch on the IRPrestige-21. 
(2) Execute [Initialize] again in LabSolutions IR. 

The interface cable is 
disconnected. 

(1) Check that the interface cable is connected properly. 
(2) Execute [Initialize] again in LabSolutions IR. 

[IRPrestige series] is not 
selected in the [Instrument 
Type] window. 

(1) Exit LabSolutions IR and then restart it. 
(2) Click [Instrument Preferences] - [Instrument Type] on the [Tool] 

menu. 
(3) Select the [IRPrestige series] checkbox as the FTIR instrument to use 

and click [OK]. 
(4) Execute [Initialize] again in LabSolutions IR. 

 

2.3.2 LabSolutions IR Cannot Communicate with the IRAffinity-1 Series 
or IRTracer-100 

Cause Solution 

The IRAffinity-1 series 
instrument or IRTracer-100 is 
not turned ON. 

(1) Turn ON the activation switch on the IRAffinity-1 series instrument or 
the activation switch on the IRTracer-100. 

(2) Execute [Initialize] again in LabSolutions IR. 

The interface cable is 
disconnected. 

(1) Check that the interface cable is connected properly. 
(2) Execute [Initialize] again in LabSolutions IR. 

[IRAffinity-1 series] or 
[IRTracer-100 series] is not 
selected in the [Instrument 
Type] window. 

(1) Exit LabSolutions IR and then restart it. 
(2) Click [Instrument Preferences] - [Instrument Type] on the [Tool] 

menu. 
(3) Select the [IRAffinity-1 series] or [IRTracer-100 series] checkbox as 

the FTIR instrument to use and click [OK]. 
(4) Execute [Initialize] again in LabSolutions IR. 

 

2.3.3 LabSolutions IR Cannot Communicate with the FTIR-8000 Series 

Cause Solution 

The FTIR-8000 series 
instrument is not turned ON. 

(1) Turn ON the activation switch on the FTIR-8000 series instrument. 
(2) Shut down the PC and then start it up again. 
(3) Execute [Initialize] again in LabSolutions IR. 

The interface cable is 
disconnected. 

(1) Check that the interface cable is connected properly. 
(2) Turn ON power to the FTIR. 
(3) Shut down the PC and then start it up again. 
(4) Execute [Initialize] again in LabSolutions IR. 

Using a PC with a 64-bit OS 
installed. 

(1) The FTIR-8000 series cannot be used on a PC with a 64-bit OS 
installed. Connect a PC that has a 32-bit OS installed. 

[FTIR 8000 series] is not 
selected in the [Instrument 
Type] window. 

(1) Exit LabSolutions IR and then restart it. 
(2) Click [Instrument Preferences] - [Instrument Type] on the [Tool] 

menu. 
(3) Select the [FTIR 8000 series] checkbox as the FTIR instrument to 

use and click [OK]. 
(4) Execute [Initialize] again in LabSolutions IR. 
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2.3.4 LabSolutions IR Starts Up, Runs, and Exits Very Slowly 

Cause Solution 

Programs, such as anti-virus 
software, other than the 
LabSolutions IR software is 
running. 

Other programs, such as anti-virus software, running on the PC used for 
LabSolutions IR may cause the LabSolutions IR software to start up, run, and 
exit slowly or not at all. 
Do not start other software when using LabSolutions IR. 
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Chapter 3 Launcher 
 

This chapter explains how to operate the launcher. 

Refer to the help file provided with the LabSolutions IR software for examples not included in this 
manual. 

Refer to the help file provided with LabSolutions IR for detailed explanations, tutorials, and other 
information regarding LabSolutions IR functions. 

 

 Explanations included in this chapter 
This chapter explains the startup method for applications and macro programs using the launcher in 
addition to the procedure for registering applications and macro programs to the launcher. 

 

 Operations that can be performed using this function 
 Start applications and macro programs from the launcher 

 Register macro programs and applications to the launcher 

 
 

  
Close the [LabSolutions Main] window, launcher, [LabSolutions IR] postrun program, and any 
measurement programs when exiting the LabSolutions IR software. Do not turn off the power or press 
the reset switch on the PC while Windows is running. 

 



Chapter 3 Launcher 

22  LabSolutions IR Basic Operation Manual 

3.1 Startup 

Double-click  (LabSolutions IR) on the desktop or click [FTIR] in the [LabSolutions Main] 
window to start the launcher. 

 

 
Launcher 

 

The launcher is divided into the following three parts. 

Name Function 

[Shortcut] tab Start LabSolutions IR measurement programs, the postrun program, and 
applications from this tab. 

[Macro] tab Start macro programs. 

[Settings] Register applications and macro programs to the launcher. 
 

The launcher can be exited independently of any measurement and postrun windows that were 
started using the launcher. 

The launcher can also be started when measurement and postrun windows are already open. 
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3.2 [Shortcut] Tab 
LabSolutions IR measurement programs and the postrun program can be started from this tab. 

In addition, frequently used external applications, such as AIMView, and folders that contain macro 
program files can be started by registering them to this tab. 

 

 
[Shortcut] Tab 

 

 

3.2.1 Measurement Program and Postrun 
LabSolutions IR measurement programs and the postrun program can be started from this tab. 

However, note that when one measurement program is already open, another measurement 
program cannot be started with the exception of the postrun program. 

The icons for the optional Time course and Mapping programs cannot be clicked if these programs 
are not installed. 

 

 

3.2.2 Applications 
Frequently used external applications that are not included with LabSolutions IR, such as AIMView, 
can be started by registering them to this tab. 

For details on the registration method, see "3.4.2 Application and Macro Settings". 
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3.3 [Macro] Tab 
Frequently used macro programs can be started by registering them to this tab. 

Registration is performed via [Settings]. 
 

  
[Macro] Tab 
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3.4 Configuration 
Register the applications and macro programs to be started from the launcher. 

Programs to be started together with the launcher when starting LabSolutions IR can also be 
selected. 

Click [Settings] in the launcher to display the [Configuration] window. 
 

 
[Configuration] Window 

 

 

3.4.1 Startup Settings 
Set the programs to be started together with the launcher. 

Item Description 

[Launcher and Window] Start the selected measurement program or postrun program. 

[Launcher and Macro 
program] 

Start the selected macro program. 

[Launcher only] Only start the launcher. 
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3.4.2 Application and Macro Settings 
Register frequently used applications and macro programs to the launcher. 

 

 Registering applications 
A maximum of 14 applications can be registered to the launcher. The order of applications can also 
be configured. 

1. Click the [Application] tab. 

2. Select an empty row and click [Edit]. 

The [Edit Application] window is displayed. 

3. Click [Browse File] and select the application for registration. 

The application icon is set automatically. To change the icon, click [Select] and select another icon. 
 

 
[Edit Application] Window 

 

  
A folder can be registered by clicking [Browse Folder] instead of [Browse File]. This allows 
registration and collective management of programs and files of the same type that are stored 
in the same folder. 

4. Enter an application title in [Title]. 

5. Click [OK]. 

The user is returned to the [Configuration] window. 
 

  
The order of registered applications can be changed using the [Up] and [Down] buttons. 
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 Registering macro programs 
A maximum of 50 macro programs can be registered to the launcher. The order of macro programs 
can also be configured. 

1. Click the [Macro] tab. 

2. Click [Add]. 

The [Edit Macro] window is displayed. 

3. Click [...] and select the easy macro program for registration. 

 
[Edit Macro] Window 

4. Enter a title and comment for the macro in the [Title] and [Comment] fields. 

5. Click [OK]. 

The user is returned to the [Configuration] window. 
 

  
The order of registered macro programs can be changed using the [Up] and [Down] buttons. 
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Chapter 4 Spectrum 
 

This chapter explains how to operate the Spectrum program. 

Refer to the help file provided with the LabSolutions IR software for examples not included in this 
manual. 

Refer to the help file provided with LabSolutions IR for detailed explanations, tutorials, and other 
information regarding LabSolutions IR functions. 

 

 Explanations included in this chapter 
This chapter explains typical scan parameters, methods for measuring spectra using polystyrene 
film, and how to zoom of spectra during measurement. 

 

 Operations that can be performed using this function 
Perform the following using the LabSolutions IR measurement function. 

 Background (BKG) scan, sample scan, and monitor scan 

 Set scan parameters 

 Zoom spectra during measurement 

 

  
Atmosphere correction function 

Although LabSolutions IR is provided with an atmosphere correction function that eliminates the 
effects of carbon dioxide and water vapor from the measured spectrum, this function may not be 
effective in the following cases. 

 When there is so much water vapor in the atmosphere that the spectrum is saturated 

 Or conversely, when there is almost no water vapor due to purging 

 When amide absorption occurs 

In these cases, turn off atmosphere correction during measurement (on the [Tool] menu) and 
proceed with measurement as usual without using the atmosphere correction function for 
manipulation. 

 



Chapter 4 Spectrum 

30  LabSolutions IR Basic Operation Manual 

4.1 Startup 
Click [Spectrum] in the LabSolutions IR launcher to start the Spectrum program. 

 

4.1.1 Spectrum Window Layout 
 

 
Spectrum Window 

 

The spectrum window is divided into the following four parts. 

No. Name Function 

1 Spectrum measurement 
toolbar 

This toolbar contains buttons used to perform spectrum 
measurement. 

2 Status monitor Displays the state of the FTIR's interferometer. 

3 Scan parameters Set scan parameters in this area. 

4 Spectrum graph Displays a spectrum during and after measurement. 
 

2

3

4 

1
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4.2 Setting Scan Parameters 
Measure a transmittance spectrum using the polystyrene film supplied with the instrument. 

The measurement conditions are shown below. 

Parameter Setting 

Sample Polystyrene film (standard accessory) 

Measurement mode Transmittance (%T) 

Apodization function Happ-Genzel 

No. of scans 20 

Resolution 4 cm-1 

Wavenumber range 400-4000 cm-1 
 

The scan parameter area is used to configure the measurement conditions. 

The scan parameter area consists of four tabs that include [Data], [Instrument], [More], and 
[Advanced], and clicking on each tab will display its contents (the [Advanced] tab is not displayed 
when using the FTIR-8400S). 

 

 

4.2.1 [Data] Tab 

 
[Data] Tab 

 

 [Measurement Mode] 
Set whether to display the measured spectrum using [%Transmittance] or [Absorbance]. 

While either setting can be used in qualitative analysis, absorbance is appropriate for quantitation. 

For special purposes, the [Power] used prior to calculation (division) with the background spectrum 
and the [Interferogram] used prior to Fourier transformation can also be selected. 

Select [%Transmittance] here. 
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 [Apodization] 
Set the apodization function used to calculate the power spectrum through Fourier transformation of 
the interferogram. 

The apodization function affects the resolution and the S/N ratio of spectra and a higher resolution 
increases noise on the baseline. 

The resolution becomes higher and noise increases in the order of [None]/[Box-Car], 
[Bessel]/[Happ-Genzel]/[Cos], [Triangle], and [SqrTriangle]. Select [Happ-Genzel] for normal 
measurement. 

For high resolution measurements, such as gas analysis, [None] or [Box-Car] can be selected as 
they provide better resolution. In micro analysis where an improved S/N ratio is required, 
[SqrTriangle] can be selected. 

Select [Happ-Genzel] here. 

 

 [No. of Scans] 
Set the number of scans to perform during measurement. 

While a setting of about 10 is appropriate for normal measurement, set a larger value when spectra 
with a better S/N ratio are required. The maximum number of scans that can be set differs 
depending on the FTIR. 

The IRAffinity-1 series, IRPrestige-21, and FTIR-8000 series support up to 4000 scans and the 
IRTracer-100 supports up to 512 scans. 

Generally, increasing the number of scans by a factor of m improves the S/N ratio by a factor of  
m (i.e. changing the number of scans from 1 to 4 improves the S/N ratio by twofold). 

Set [20] scans here. 

 

 [Resolution] 
Set the resolution used in measurement. 

When analyzing gas of low concentration, select 0.25 cm−1 or 0.5 cm−1 for the IRTracer-100, 0.5 
cm−1 for the IRPrestige-21 and IRAffinity series, or 0.85 cm−1 for the FTIR-8400S to accurately 
measure minute absorption peaks. 

Because the spectra of solids and liquids do not have minute peaks as do those observed with 
gases, sufficient spectra can be obtained with settings of 4 cm−1 or 8 cm−1 when measuring solids 
and liquids. As a setting of 2 cm-1 will yield higher resolution spectra, selecting a resolution higher 
than this is not necessary even if spectra of a higher resolution are required. Using unnecessarily 
high resolutions will cause long measurement times and reduce the S/N ratio. 

Select [4.0] cm-1 here. 

 

 [Range] 
Enter numerical values for the wavenumber range according to the measurement method and 
detector used. 

Set values from [400] to [4000] here (minimum: 400 cm−1, maximum: 4000 cm−1). 
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4.2.2 [Instrument] Tab 

 
[Instrument] Tab 

 

 [Beam] 
The beam direction can be selected when the optional beam switching kit is installed. 

Select [Internal] when performing measurement within the sample compartment of the main unit. 

Select [External] when directing the beam to an external device, such as an infrared microscope. 

Select [Validate] to insert polystyrene film for validation into the optical path. 

This is provided for the validation program and the end-user does not need to select this under 
normal circumstances. 

Select [Internal] here. 

 

 [Detector] 
Select the detector to use. 

The standard DLATGS detector is set as the detector for [standard]. 

Select option 1 to 3 when performing measurement using an infrared microscope or optional 
detector (such as an MCT detector). 

Select [standard] here. 

 

 [Mirror Speed] 
Select the speed of the moving mirror. 

Normally select [2.8] mm/sec when using the standard DLATGS detector and [5.0] mm/sec when 
using an MCT detector, such as an infrared microscope. 

When measuring thin films using the transmittance method, measuring samples using the KBr-pellet 
method, or measuring liquid samples using liquid cells with high-transmittance windows, such as 
KBr or NaCl, an "A/D out of range error" may occur if measurement is performed with a mirror speed 
of 2.0 mm/sec and a [Open] aperture. This occurs because the output from the DLATGS detector 
becomes too high and exceeds the capacity of the detector's A/D converter. In this case, select 
[auto] or a smaller value for [Aperture] on the [More] tab. 

On the other hand, when using an accessory that reduces light intensity, such as an ATR or diffuse 
reflectance measurement device, while measuring samples with [Aperture] set to [Open] on the 
[More] tab, the sensitivity of the detector increases within the capacity of the A/D converter allowing 
measurement of higher quality spectra. 

Select [2.8] (mm/sec) here. 
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4.2.3 [More] Tab 

 
[More] Tab 

 

 [Normal] 
Set the gain and measurement mode used for spectrum measurement and background (BKG) 
measurement. 

The default setting for both [Gain] and [Aperture] is [auto]. If [Gain] and [Aperture] are not set to 
[auto], change them to [auto]. 

Because the size of the beam image in the sample compartment becomes larger than the KBr pellet 
(13, 5, 4, or 2 mm), liquid cell, sealed cell, and fixed thickness cell (all 10  22 mm) when [Aperture] 
is set to [auto] (completely open), only part of the beam can be used when employing these 
accessories. 

In this case, derivative noise may appear on the baseline of the obtained spectrum. 

This noise can be reduced by performing background (BKG) measurement and sample 
measurement with a smaller aperture (3.0, 2.1, or 1.5). 

 

 [Monitor] 
Set the gain and measurement mode used during monitor measurement. 

The default setting for [Gain] is [1]. If [Gain] is not set to [1], change it to [1]. 

Interferogram, power spectrum, transmittance, or absorbance can be selected for the measurement 
mode in the same way as for sample measurement. These are used in the adjustment of the mirror 
of accessory devices. 

If the background (BKG) has been measured in advance, the measured value can be displayed as 
transmittance or absorbance. 

Transmittance and absorbance are convenient for checking the adhesion between the sample and 
prism in ATR measurement. 

The measurement mode selected here is only the display method for monitor measurement and 
does not need to be the same as the measurement mode for sample measurement. 

Select [Power] here. 
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4.2.4 [Advanced] Tab 

 
[Advanced] Tab 

 
This tab contains scan parameters specific to the IRPrestige-21, IRTracer-100, and IRAffinity-1 
series. 

This tab is used to set more advanced parameters, such as hardware settings. 

A "data evaluation" mode is also available in addition to the normal measurement methods for the 
IRPrestige-21, IRTracer-100, and IRAffinity-1 series. This measurement mode enables higher 
accuracy data to be obtained by only using interferograms of better quality than the preset threshold 
in calculation. 

The measurement range and light source appropriate to the measurement range can be set in 
advance. 

The most appropriate detector and light source for the set measurement range are selected 
automatically. 

Leave all parameters in their default settings. 
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4.3 Monitoring the Instrument Status (Status Monitor) 
The status monitor displays the state of IRPrestige-21, IRTracer-100, IRAffinity-1 series and 
FTIR-8000 series instruments and information on any installed accessories. 

 
Status Monitor 

 

The status monitor displays the following information. 

Item Description 

[Beamsplitter] 
(IRPrestige-21/ 
IRTracer-100/IRAffinity-1 
series) 

Indicates the type of beam splitter installed. 
 Green: The beam splitter is installed correctly. 

 Red: The beam splitter is not correctly inserted all the way in. 
Check the state of installation according to the instrument's instruction 
manual. 

[Laser] Indicates whether the laser is on or off. 
 Green: The laser is on and operating normally. 

 Red: The laser is off. 
In this case, contact your Shimadzu representative. 

[Lamp] Indicates whether the Light source is on or off. 
 Green: The Light source is on and operating normally. 

 Red: The Light source is off. 
In this case, contact your Shimadzu representative. 

[Humidity] 
(IRTracer-100/IRAffinity-1 
series) 

Indicates the humidity level in the interferometer. 
 Green: Low level of humidity in the interferometer. 

 Red: High level of humidity in the interferometer. 
The dehumidifier may have broken down. 
Immediately disconnect the power cord and do not use the FTIR. 
Remove the top cover and replace the silica gel with a new batch. 
Contact your Shimadzu representative. 

[SW] Indicates whether the beam switching kit is installed, and if so, its corresponding 
settings. 
 None: The beam switching kit is not installed. 

 Green: The beam switching kit is installed and operating normally. 
The beam settings are displayed as follows. 
Internal: The IR beam is directed into the sample compartment and 

the standard detector can be used. 
External: The IR beam is directed outside and external accessories, 

such as a microscope, can be used. 
Validate: Polystyrene film is inserted into the optical path of the beam.

This mode is used for automatic validation. 
 Red: The beam switching kit is installed but not working. 

In this case, contact your Shimadzu representative. 

[ASC] Indicates whether the auto sample changer is installed 
 None: The auto sample changer is not installed. 

 Yellow: The auto sample changer is not initialized. 

 Green: The auto sample changer was correctly initialized and is ready for use.

[Accessory] Indicates whether an accessory with an automatic recognition function is installed, 
and if so, displays its serial number. 
 None: No accessory is installed. 

 Green: The accessory is installed and ready for use. 
The accessory's serial number is displayed. 
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4.4 Measurement 
 

4.4.1 Spectrum Measurement Toolbar 

 
Spectrum Measurement Toolbar 

 

 [Sample name], [Sample ID], [Option], and [Comment] 
Information regarding a spectrum, including sample name and measurement method, can be 
entered on the spectrum measurement toolbar. 

Any entered information is saved together with the corresponding spectrum. 
 

 [Filename] 
LabSolutions IR saves all measured spectra to the hard disk as soon as measurements are 
complete. This field is used to enter the destination (hard disk and folder) and filename for saving. 

Click the [...] to select a destination for saving. The file extension is "*.ispd". 

The file is saved to "\LabSolutions\IR\Data" if a hard drive and folder are not selected and only a 
filename is specified. 

Leave the filename as "default.ispd". 
 

 [Auto increment] 
Select the [Auto increment] checkbox to automatically increment the number added to the end of the 
filename when the results of each measurement are saved. For example, if "default.ispd" is entered 
for the filename, the filename for the first measured spectrum is set to "default1.ispd" and the 
filename for the second measured spectrum is set to "default2.ispd". 

The software recognizes if "default1" to "default3" are already in use and automatically skips to 
"default4.ispd" in this case. (If "default1" is entered, the filename is set to "default11", "default12", 
etc.) 

LabSolutions IR prohibits saving by overwriting files. Accordingly, filenames must be entered for 
every measurement if [Auto increment] is not checked. (If measurement is started without changing 
the filename, a dialog box prompting for the filename to be changed appears.) 

Select the [Auto increment] checkbox here. 
 

 [View background] 
Select the [View background] checkbox to display the measured background spectrum for 
confirmation purposes after background (BKG) scan is complete. The background spectrum is not 
displayed when this checkbox is deselected (although not displayed, the spectrum is still used in 
calculations during sample measurement). Select this checkbox if necessary. 

Select the [View background] checkbox here. 
 

 [Monitor Autoscale] 
Select the [Monitor Autoscale] checkbox to automatically scale the vertical axis so that the spectrum 
measured in real time during monitor measurement is displayed at its maximum size. 

If this checkbox is deselected, the vertical axis range of the first spectrum measured in real time is 
used for display. 

The display range can be changed during monitor measurement if necessary. 

It is convenient to deselect this checkbox when adjusting accessories. 

Use the default checkbox setting here. 
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 [Switch to View after scanning.] 
Select the [Switch to View after scanning.] checkbox to display an obtained spectrum on View 
window, after BKG or Sample scan is completed. 

 

  [Rest time] 
Displays the rest time to complete the scan.  

It is an rough estimated rest time which is calculated from set scan parameters when FTIR works 
normally. Therfore, scanning may not be finished as estimated according to condition of instrument 
or samples. 

 

4.4.2 Background (BKG) Measurement 
Shimadzu's Fourier Transform Infrared Spectrophotometer employs a single beam optical system. 

In the single beam optical system, background (BKG) scan is executed first. 

1. Click [BKG Scan]. 

The message "Please prepare sample compartment for background scan." is displayed. 

2. Confirm that no sample is set in the sample holder in the sample compartment and click [OK]. 

Background (BKG) measurement starts. 
The progress of measurement is displayed on the status bar at the lower left corner of the screen and the 
background spectrum is displayed while being updated in real-time in the measurement window. 
During measurement, all scan parameters and buttons on the spectrum measurement toolbar are 
disabled except for the [Stop] button. These items are re-enabled after measurement is complete. 
 
A background spectrum is displayed in the corresponding view window after background (BKG) 
measurement is complete. 

 

 
Power Spectrum Displayed after Background (BKG) Scan Is Complete 
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4.4.3 Sample Measurement 

1. After background (BKG) measurement is complete, set the sample for measurement. 

Insert a polystyrene film into the sample holder in the sample compartment. 

2. Click [Measurement] on the main toolbar. 

The measurement window is displayed. 

3. Click [Sample Scan] on the spectrum measurement toolbar. 

Sample measurement starts. 
In the same manner as for background (BKG) measurement, the progress of measurement is displayed 
on the status bar at the lower left corner of the screen and the spectrum currently being measured is 
displayed while being updated in real-time in the measurement window. 
During measurement, all scan parameters and buttons on the spectrum measurement toolbar are 
disabled except for the [Stop] button. These items are re-enabled after measurement is complete. 

 

 
Window Displayed During Sample Measurement 

 
Measurement can be stopped and resumed. 
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Click the [Stop] button on the spectrum measurement toolbar to stop measurement. 
 

 
[Stop Scanning] Dialog Box 

 
Item Description 

[Finish] Stop the measurement and display the data measured up to that time. 

[Abort] Abort the measurement and discard the data measured up to that time. 

[Resume] Resume the measurement. 
 

 

4.4.4 Checking the Measured Spectrum 
The following operations can be performed on spectra during and after measurement. 

 Zooming spectra 

 Autoscale 

 

 Zooming spectra 
Drag the cursor on the graph window to create a rectangular frame and click on the position to zoom. 
The area enclosed by the rectangular frame is zoomed. 

 
Zooming 

 

 Autoscale 
Click [Autoscale] on the right-click menu on the graph window to automatically scale the spectrum. 

Autoscale only changes the vertical axis to an appropriate size and does not change the horizontal 
axis range. 

 
Right-Click Menu 
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4.4.5 Starting Sample Measurement from Monitor Measurement 
Sample measurement can be started during monitor scanning. 

When measuring with the ATR accessory, the peak intensity of displayed spectrum can be judged 
by monitor scanning of the degree of pressure that the prism is pressed into the sample. Sample 
measurement can be started after the pressure is adjusted appropriately through monitor 
measurement. 

1. Set scan parameters by referring to "4.2 Setting Scan Parameters". 

Select [%Transmittance] or [Absorbance] for [Mode] located under [Monitor] on the [More] tab. 

2. Set sample information by referring to "4.4.1 Spectrum Measurement Toolbar". 

3. Measure background by referring to "4.4.2 Background (BKG) Measurement". 

4. Set the sample and click [Monitor]. 

Monitor measurement starts and a spectrum is displayed. 
An absorbance peak in the spectrum appears as the prism is pressed into the sample using the ATR 
accessory. 
When the peak is an appropriate intensity, the pressing stops. 

5. Click [Sample Scan]. 

Spectrum measurement starts directly from monitor measurement. 
 

 
Window Displayed During Monitor Measurement 
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4.4.6 Standby Mode 
The IRTracer and IRAffinity-1series can start sample measurement upon receiving an external 
trigger signal, such as a start signal from a thermal analysis instrument or reaction device. 

The hardware for receiving external trigger signals is an option. 

1. Set scan parameters by referring to "4.2 Setting Scan Parameters". 

Select the [Standby Mode] checkbox on the [Advanced] tab. 

2. Set sample information by referring to "4.4.1 Spectrum Measurement Toolbar". 

3. Measure background by referring to "4.4.2 Background (BKG) Measurement". 

4. Click [Sample Scan]. 

The [Standby] dialog box is displayed. 
Sample measurement starts and a spectrum appears when an external trigger signal is received while 
the dialog box is displayed. 
Click [Stop] to stop standby. 

 

 
[Standby] Dialog Box 

 

 

4.5 View 
The measured spectrum is displayed in the view window after measurement is complete. 

Comparison with other spectra and printing can be performed in the view window. The search 
window can also be used from the view window. 

For details on view window functions, see "Chapter 7 Postrun/View". 
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Chapter 5 Quantitation 
 

This chapter explains how to operate the Quantitation program. 

Refer to the help file provided with the LabSolutions IR software for examples not included in this 
manual. 

Refer to the help file provided with LabSolutions IR for detailed explanations, tutorials, and other 
information regarding LabSolutions IR functions. 

 

 Explanations included in this chapter 
This chapter explains quantitation measurement using the multi-point calibration curve method, 
processing subsequent to unknown sample measurement, and the automatic quantitation 
measurement function that uses an auto sample changer (ASC). 

The sample data used in explanations of operations is located in the installation folder of this 
software. 

For example, if the software is installed to "C:\Program Files", the sample files are copied to 
"C:\Program Files\LabSolutions\IR\Data". This path is abbreviated to "\Data" and "\Data\Tutorial" in 
the case of subfolders in this manual. 

 

  
If using the database version or client server version, use a project with a registered sample file that 
was created according to descriptions in the Installation and Maintenance Manual ("Sample_IR_JP" 
under default settings). 

 

 Operations that can be performed using this function 
Create calibration curves using the multi-point calibration curve method and perform quantitation 
measurement of unknown samples, perform calculations and assessment with respect to the 
measurement results of unknown samples, and perform automatic quantitation measurement using 
an auto sample changer (ASC). 

 

  
Atmosphere correction function 

Although LabSolutions IR is provided with an atmosphere correction function that eliminates the 
effects of carbon dioxide and water vapor from the measured spectrum, this function may not be 
effective in the following cases. 

 When there is so much water vapor in the atmosphere that the spectrum is saturated 

 Or conversely, when there is almost no water vapor due to purging 

 When amide absorption occurs 

In these cases, turn off atmosphere correction during measurement (on the [Tool] menu) and 
proceed with measurement as usual without using the atmosphere correction function for 
manipulation. 
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5.1 Quantitation 
Of the quantitative methods based on light absorption, the calibration curve method (single or 
multi-point) is the most widely used and is not just limited to infrared analysis. 

The calibration curve method uses Lambert-Beer's law* to quantify unknown samples by 
determining a regression equation (calibration curve) that represents the relationship between 
concentration and the peak intensity (peak height or area of the displayed absorbance) of the target 
component in the spectrum of a standard sample of known concentration. 

In this method, the creation of a calibration curve by measuring several points (1 to 5) on a standard 
sample allows quantitative analysis to be performed easily. 

However, in creating the calibration curve, only an absorption peak of a target component that is 
mostly unaffected by other components (effects including peak overlaying and other traits) is 
required. When quantifying multiple components, a calibration curve must be created for each 
component by only using a peak from the corresponding component as described above. 

The multi linear regression method and PLS method were developed in response to the weaknesses 
of the calibration curve method. In these two methods, peaks affected by other components can be 
used and several components can be quantified at the same time. 

However, a large number of standard samples (about 10 to 100 points) are required according to the 
number of target components to be quantified. 

 
* Lambert-Beer's law 

 

When the intensity of incident light is I0 and the intensity of transmitted light is I1, the relationship between I0 
and I1 can be described as follows: 

 

I1 = I0 × 10-εcl 
 

This is called Lambert-Beer's law. 
where, 
ε: absorbance coefficient 
c: sample concentration 
l: cell pathlength 
Transmittance (%T) and absorbance (abs) are defined as follows: 
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While there is an exponential relationship between transmittance and concentration, c, absorbance is 
proportional to sample concentration because ε and l are constant when the sample and cell pathlength are 
known. 
For this reason, absorbance (Abs) mode is normally used to perform measurement in quantitative analysis.
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5.2 Startup 
Click [Quantitation] in the LabSolutions IR launcher to start the Quantitation program. 

 

5.2.1 Quantitation Window Layout 

 
Quantitation Window 

 

The quantitation measurement window is divided into the following five parts. 

No. Name Function 

1 Quantitation measurement 
toolbar 

This toolbar contains buttons used to perform quantitation 
measurement. 

2 Standard sample table Load standard sample spectra, enter concentrations, and create 
calibration curves. 

3 Settings area Set scan parameters and quantitative scan parameters for creating 
calibration curves. This area also displays calibration curve equations 
and correlation coefficients. 

4 Unknown sample table Measure, load, and quantify spectra of unknown samples. 
Calculations and pass/fail assessment with respect to the quantitative 
calculation results can be performed. 

5 Graph area Displays measured spectra. 
 

1

3

5

2 

4 
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5.3 Creating a Calibration Curve 
5.3.1 Creating/Loading a Calibration Curve 

Click [New] on the [File] menu to create a new calibration curve when a previously created 
calibration curve file is displayed. 

Click [Load Calibration Curve] on the quantitation measurement toolbar to load a previously created 
calibration curve. 

 
Quantitation Measurement Toolbar 

 

5.3.2 Creating a Multi-Point Calibration Curve 
Create a multi-point calibration curve (standard sample table) by importing saved standard sample 
spectra. 

Multi-point calibration curves cannot be created concurrently with quantitation measurement. 

Standard sample spectra must be measured and saved in advance using the Spectrum program. 
Perform this measurement in absorbance mode. 

1. Click [Import] above the standard sample table. 

The [Import Spectrum] window is displayed. 

2. Select the standard sample spectrum from the list and click [Import]. 

The imported spectrum is displayed in the standard sample table. 
In this example, import the files "QUANT1.ispd" through "QUANT8.ispd" located in "\Data\Tutorial" 
as the standard sample spectra. 

 

 
[Import Spectrum] Window 
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3. Click [Close] after importing the required standard sample spectra. 

4. Enter the known concentrations for the imported spectra into the [Concentration] fields in the 
standard sample table. 

Enter the following values for each concentration. 
 

Spectrum Concentration 

QUANT1.ispd 200 mg 

QUANT2.ispd 220 mg 

QUANT3.ispd 242 mg 

QUANT4.ispd 266.2 mg 

QUANT5.ispd 292.82 mg 

QUANT6.ispd 322.1 mg 

QUANT7.ispd 354.31 mg 

QUANT8.ispd 400 mg 
 

 
Quantitation Window 

5. Click the [Calibration Curve] tab in the settings area and then click [Settings]. 

The [Edit calibration curve] window is displayed. 
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6. Set the component name, unit type and order for calibration curve. 

 
[Edit calibration curve] Window 

 

Name Function 

[Component] Enter the component name of the sample. 

[Unit] Enter the unit of concentration. Enter "mg" in this example. 

[Execute 
preprocessings] 

Select this checkbox to create a calibration curve and perform quantitation after 
executing certain data preprocessing on all spectra. 
Deselect the checkbox in this example. 

  
The quantitative results may take some time to appear after spectrum 
measurement completes depending on the type of preprocessing 
performed or when a large amount of preprocessing is configured. 

[Quantitation 
method] 

Specify information including peak height and area. 

[Calibration 
parameters] 

Select the method for creating calibration curves. 
[K-factor method] can be used when the calibration curve equation is known. 
Select [Multi point method] in this example. 

[Order] Set the order of the calibration curve to be created. 
As Lambert-Beer's law dictates a linear relationship between absorbance and 
concentration, normally select first order. 
Select [1st] order in this example. 

 

[Origin] Set whether or not the origin is to be used as a quantitation point. 
 [Ignore]: Do not use the origin. 

 [Use as data]: Use the origin as one standard sample. 

 [Pass on origin]: Force the calibration curve to pass through the origin. 

Normally select [Ignore] when creating multi-point calibration curve. Select [Use 
as data] or [Pass on origin] when creating a single-point calibration curve. 
Select [Ignore] in this example. 

7. Click [Settings] under [Quantitation method]. 

The [Equation setting] window is displayed. 
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8. Set the wavenumber of the peak used in quantitation. 

The wavenumber is set as an equation. 
 

 
[Equation setting] Window 

1. Click [Edit]. 

2. Select [Peak height] for [Type of equation]. 

3. Select the [Select peak top] and [Baseline correction] checkboxes. 

4. Enter the peak top in the [Peak position] field under [Peak1] and enter the wavenumber range 
of the baseline in the [Start position] and [End position] fields. 
Click the [>>] to select a peak on a spectrum. 
Enter "730" for [Start position], "755" for [Peak position], and "774" for [End position] in this example. 

5. Click [Register]. 
A message appears to confirm the equation update. Click [OK]. 
The configured wavenumber setting is registered and an asterisk (*) appears in the [Use] field. 

6. Click [OK]. 
The [Equation setting] window closes and the configured wavenumber is displayed as an equation 
under [Quantitation method] in the [Edit calibration curve] window. 

9. Click [OK]. 

The [Edit calibration curve] window closes and the quantitation method is displayed on the [Calibration 
Curve] tab in the settings area. 

1 

6 

5 2 

3 

4 
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10. Click [Calibration] on the quantitation measurement toolbar. 

A calibration curve is displayed on the [Calibration Curve] tab in the settings area. 
The calibration curve equation and correlation coefficient are displayed right the calibration curve 
graph. 

 

 
After a Calibration Curve is Created 

11. Click [Save Calibration Curve] on the quantitation measurement toolbar. 

The [Save As] dialog box is displayed. 
Save the created calibration curve. 
Enter "test.istd" for the filename. 
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5.4 Quantifying Unknown Samples 
The following two methods can be used to quantify unknown samples. 

 Quantitation by loading a previously measured spectrum of the unknown sample 

  
See "5.4.2 Loading the Unknown Sample Spectrum for Quantitation". 

 

 Quantitation concurrent to measurement of the spectrum of the unknown sample 

  
See "5.4.3 Measuring and Quantifying the Unknown Sample". 

 

5.4.1 Specifying a Quantitative Data Filename 
Specify the filename to use for saving the result of the quantitation measurement to be performed in 
advance. 

Either enter the quantitative data filename in the [Filename] field on the quantitation measurement 
toolbar or click [...] and specify the quantitative data filename in the dialog box that appears. 

In this example, click [...] and enter "test.irqt" in the "\Data\Tutorial" folder. 

 

5.4.2 Loading the Unknown Sample Spectrum for Quantitation 
This quantitation method involves loading a previously measured spectrum of the unknown sample. 

In this example, use the "QUNKNOWN.ispd" file located in the "\Data\Tutorial" folder as the 
unknown sample. 

Unknown sample spectra must be measured and saved in advance using the Spectrum program. 
Perform this measurement in absorbance mode. 

1. Click [Import] above the unknown sample table. 

The [Import Spectrum] window is displayed. 

2. Select the unknown sample spectrum from the list and click [Import]. 

The quantitative result is displayed in the unknown sample table. 
In this example, import the "QUNKNOWN.ispd" file located in the "\Data\Tutorial" folder as the 
unknown sample spectrum. 
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3. Click [Close] after importing the required unknown sample spectrum. 

The quantitative results are displayed in the unknown sample table. 

 
Quantitation Window 

 

 

5.4.3 Measuring and Quantifying the Unknown Sample 
The method for quantifying the unknown sample spectrum concurrent to measurement is described 
below. 

1. Click the [Scan parameters] tab in the settings area and then click [Settings]. 

The [Instrument Parameters] window is displayed. 

2. Set the scan parameters on each tab. 

Use the same settings as for normal spectrum measurement. 
 

  
See "4.2 Set Scan Parameters". 
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[Instrument Parameters] Window 

3. Click [OK] after settings are complete. 

The [Instrument Parameters] window closes and the scan parameters are displayed on the [Scan 
parameters] tab in the settings area. 

4. Insert the background sample into the sample compartment and click [BKG Scan] on the 
quantitation measurement toolbar. 

The real-time spectrum is displayed on the [BKG&Monitor spectrum] tab in the graph area. 

5. Input [Spectrum names] to be scanned. 

6. Insert the unknown sample into the sample compartment and click [Sample Scan] on the 
quantitation measurement toolbar. 

The real-time spectrum is displayed on the [BKG&Monitor spectrum] tab in the graph area. 
When measurement is complete, the spectrum is saved and the quantitative results are displayed in the 
unknown sample table. 

 

 

5.4.4 Measuring and Quantifying the Unknown Sample Using an Auto 
Sample Changer 
The unknown sample can be scanned and be quantified automatically by using an auto sample 
changer (ASC). 

The following example demonstrates quantitatively measuring one background sample and 17 
unknown samples using the ASC-8000T auto sampler changer for transmission measurement. 

1. Turn OFF power to the FTIR. 

2. Install the ASC on the FTIR and then turn ON power to the FTIR. 
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3. Click [Instrument] on the quantitation measurement toolbar and select [Initialize]. 

FTIR initialization starts. 

4. After initialization is complete, click [Instrument] and select [Sampler]. 

The [Sampler] window is displayed. 

5. Configure the auto sample changer. 

 
[Sampler] Window 

1. Select either [ASC-A] or [ASC-B]. 
Only [ASC-A] is available for the IRAffinity series. 

2. Select the auto sample changer to use at [Accessory]. 
Select [ASC-8000T] in this example. 
[Maximum] and [Pulse No.] are set automatically. 

3. Select the [both] checkbox under [Control] and click [Init.]. 
ASC-8000T initialization is performed. 

4. Click [OK]. 
Close the [Sampler] window. 

6. Click the [Scan parameters] tab and select the [Use ASC] checkbox. 

If the background sample is contained in the ASC, select the [Run BKG sample] checkbox. 
Install the background sample at position B in the ASC. This position is recognized as No. 0 in 
LabSolutions IR. 
Deselect [Run BKG sample] when only using position B in the ASC to measure an unknown sample. 
Position B in the ASC is recognized as No. 0 in LabSolutions IR. 

7. Click the [Scan parameters] tab in the settings area and then click [Settings]. 

The [Instrument Parameters] window is displayed. 

8. Set the scan parameters on each tab. 

Use the same settings as for normal spectrum measurement. 
 

  
See "4.2 Set Scan Parameters". 

3 
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 [Instrument Parameters] Window 

9. Click [OK] after settings are complete. 

The [Instrument Parameters] window closes and the scan parameters are displayed on the [Scan 
parameters] tab in the settings area. 

10. Enter the number of samples to be measured into the field to the left of the [Insert Line] button 
above the unknown sample table. 

Quantitation measurement of 17 samples will be performed in this example, so enter "17" and click 
[Insert Line]. 
Rows 1 to 17 are added to the list. 

11. Drag numbers 1 to 17 in the [No.] column to select rows 1 to 17 and then click [Edit All]. 

The [batch sample information input] window is displayed. 
In this example, configure the following settings. 

 

Item Setting 

[ASC] Select this checkbox. 
Enter the number of the sample to be measured first in [First no]. 
Enter "1" in this example. 

[Sample name] 
[Sample ID] 
[Option] 

Select this checkbox. 
These comprise the text entered for [Name] suffixed with a number. 

[Spectrum name] Select this checkbox. 
This is the filename of the spectrum saved in the quantitation measurement 
file. 
This name comprises the text entered for [Name] suffixed with a number or 
ASC number. 
This name can also be created by combining the sample name and sample 
ID. 
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[batch sample information input] Window 

12. Click [OK] after the settings are complete. 

13. Install the background sample and unknown sample in the ASC. 

14. Click [Sample Scan] on the quantitation measurement toolbar. 

Spectrum measurement of the unknown sample is performed after background (BKG) measurement is 
complete. 
The real-time spectrum is displayed on the [BKG&Monitor spectrum] tab in the graph area. 
Each time a spectrum measurement completes, the spectrum is saved and the quantitative results are 
displayed in the unknown sample table. 
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5.5 Post-Processing of Quantitative Data 
A variety of calculations can be performed based on the determined concentration values. 

1. Click the [Equation] tab in the settings area and then click [Edit]. 

The [Equation setting] window is displayed. 

2. Set an equation. 

Calculation using a user-specified equation and pass/fail assessment using acceptance equation can be 
performed with respect to concentrations. 

 

 
[Equation setting] Window 
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Chapter 6 Photometric 
 

This chapter explains how to operate the Photometric program. 

Refer to the help file provided with the LabSolutions IR software for examples not included in this 
manual. 

Refer to the help file provided with LabSolutions IR for detailed explanations, tutorials, and other 
information regarding LabSolutions IR functions. 

 

 Explanations included in this chapter 
This chapter explains photometric measurement, processing subsequent to sample measurement, 
and the automatic photometric measurement function that uses an auto sample changer (ASC). 

The sample data used in explanations of operations is located in the installation folder of this 
software. 

For example, if the software is installed to "C:\Program Files", the sample files are copied to 
"C:\Program Files\LabSolutions\IR\Data". This path is abbreviated to "\Data" and "\Data\Tutorial" in 
the case of subfolders in this manual. 

  
If using the database version or client server version, use a project with a registered sample file that 
was created according to descriptions in the Installation and Maintenance Manual ("Sample_IR_JP" 
under default settings). 

 

 Operations that can be performed using this function 
Perform photometric measurement of samples, calculations and assessment with respect to 
photometric measurement results, and automatic photometric measurement using an auto sample 
changer (ASC). 

 

  
Atmosphere correction function 

Although LabSolutions IR is provided with an atmosphere correction function that eliminates the 
effects of carbon dioxide and water vapor from the measured spectrum, this function may not be 
effective in the following cases. 

 When there is so much water vapor in the atmosphere that the spectrum is saturated 

 Or conversely, when there is almost no water vapor due to purging 

 When amide absorption occurs 

In these cases, turn off atmosphere correction during measurement (on the [Tool] menu) and 
proceed with measurement as usual without using the atmosphere correction function for 
manipulation. 
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6.1 Photometric 
Photometric measurement involves scanning intensity (such as absorbance and transmittance) as 
well as peak height and area at specified positions (wavenumbers and wavelengths) on a spectrum. 
A variety of calculations can be performed using the scanned values. 

These values can also be used for pass/fail assessment. 

 

6.2 Startup 
Click [Photometric] in the LabSolutions IR launcher to start the Photometric program. 

 

6.2.1 Photometric Window Layout 

 
Photometric Window 

 

The photometric measurement window is divided into the following four parts. 

No. Name Function 

1 Photometric measurement 
toolbar 

This toolbar contains buttons used to perform photometric 
measurement. 

2 Settings area Set photometric scan parameters such as scan parameters, 
preprocessing, and equations. 

3 Sample table Measure sample spectra and load spectra to perform photometric 
calculation. Calculations and pass/fail assessment with respect to 
photometric calculation results can be performed. 

4 Graph area Displays measured spectra. 
 

1

2

4

3 
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6.3 Setting Photometric Scan Parameters 
6.3.1 Creating/Loading Photometric Scan Parameters 

Click [New] on the [File] menu to perform a new photometric measurement when previously created 
photometric measurement data is displayed. 

Load previously created photometric scan parameters by clicking [Load Parameter] on the 
photometric measurement toolbar and selecting the desired photometric scan parameters. 

 
Photometric Measurement Toolbar 

 

6.3.2 Creating Photometric Scan Parameters 

1. Click [Import] above the sample table. 

The [Import Spectrum] window is displayed. 

2. Select the sample spectrum from the list and click [Import]. 

The imported spectrum is displayed in the sample table. 
In this example, import the "QUANT1.ispd" file located in the "\Data\Tutorial" folder. 

 

 
[Inport Spectrum] Window 

 



Chapter 6 Photometric 

62  LabSolutions IR Basic Operation Manual 

3. Click [Close] after importing the required sample spectrum. 

4. Click the [Equation] tab in the settings area and then click [Edit]. 

The [Equation setting] window is displayed. 

5. Set the wavenumber of the peak to use in photometric measurement. 

The wavenumber is set as an equation. 

 
[Equation setting] Window 

1. Click [Edit]. 

2. Select [Peak height] for [Type of equation]. 

3. Select the [Select peak top] and [Baseline correction] checkboxes. 

4. Enter the peak top in the [Peak position] field under [Peak1] and enter the wavenumber range 
of the baseline in the [Start position] and [End position] fields. 
Click [>>] to select a peak on a spectrum. 
Enter "730" for [Start position], "755" for [Peak position], and "774" for [End position] in this example. 

5. Click [Register]. 
The configured wavenumber setting is registered and an asterisk (*) appears in the [Use] field. 

6. Click [OK]. 
The [Equation setting] window closes and the configured wavenumber range is displayed as an equation 
on the [Equation] tab. 

6. Click [Save Parameter] on the photometric measurement toolbar. 

The [Save As] dialog box is displayed. 
Save the created photometric scan parameters. 
Enter "test.iphp" for the filename. 
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6.4 Sample Measurement 
Photometric measurement can be performed using the following two methods. 

 Photometric calculation by loading a previously measured spectrum of the sample 

  
See "6.4.2 Performing Photometric Calculation by Loading a Sample Spectrum". 

 

 Photometric calculation concurrent to measurement of the sample spectrum 

  
See "6.4.3 Measuring the Sample and Performing Photometric Calculation". 

 

6.4.1 Specifying a Photometric Data Filename 
Specify the filename to use for saving the result of the photometric measurement to be performed in 
advance. 

Enter a filename or click [...] and specify a filename in the dialog box that appears. 

In this example, click [...] and specify "test.ipht" in the "\Data\Tutorial" folder. 

 

6.4.2 Performing Photometric Calculation by Loading a Sample 
Spectrum 
This method involves performing photometric calculation by loading a previously measured 
spectrum of the sample. 

In this example, use the "QUANT1.ispd" file located in the "\Data\Tutorial" folder as the sample. 

Sample spectra must be measured and saved in advance using the Spectrum program. 

1. Click [Import] above the sample table. 

The [Import Spectrum] window is displayed. 

2. Select the sample spectrum from the list and click [Import]. 

The photometric result is displayed in the sample table. 
In this example, import the "QUANT1.ispd" file located in the "\Data\Tutorial" folder as the sample 
spectrum. 

 
[Inport Spectrum] Window 
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3. Click [Close] after importing the required sample spectrum. 

 
Photometric Window 

 

6.4.3 Measuring the Sample and Performing Photometric Calculation 
This method involves performing photometric calculation concurrent to measurement of the sample 
spectrum. 

1. Click the [Scan parameters] tab in the settings area and then click [Settings]. 

The [Instrument Parameters] window is displayed. 

2. Set the scan parameters on each tab. 

Use the same settings as for normal spectrum measurement. 
 

  
See "4.2 Set Scan Parameters". 
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[Instrument Parameters] Window 

3. Click [OK] after settings are complete. 

The [Instrument Parameters] window closes and the scan parameters are displayed on the [Scan 
parameters] tab in the settings area. 

4. Insert the background sample into the sample compartment and click [BKG Scan] on the 
photometric measurement toolbar. 

The real-time spectrum is displayed on the [BKG&Monitor spectrum] tab in the graph area. 

5. Input [Spectrum names] to be scanned. 

6. Insert the sample into the sample compartment and click [Sample Scan] on the photometric 
measurement toolbar. 

The real-time spectrum is displayed on the [BKG&Monitor spectrum] tab in the graph area. 
When measurement is complete, the spectrum is saved and the photometric results are displayed in the 
sample table. 

 

6.4.4 Measuring and Performing Photometric Calculation of the Sample 
Using an Auto Sample Changer 
The sample can be scanned and be calculated photometric calculation automatically by using an 
auto sample changer (ASC). 

The following example demonstrates measuring one background sample and 17 unknown samples 
using the ASC-8000T auto sample changer for transmission measurement. 

1. Turn OFF power to the FTIR. 

2. Install the ASC on the FTIR and then turn ON power to the FTIR. 
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3. Click [Instrument] on the photometric measurement toolbar and select [Initialize]. 

FTIR initialization starts. 

4. After initialization is complete, click [Instrument] and select [Sampler]. 

The [Sampler] window is displayed. 

5. Configure the auto sample changer. 

 
[Sampler] Window 

1. Select either [ASC-A] or [ASC-B]. 
Only [ASC-A] is available for the IRAffinity series. 

2. Select the auto sample changer to use at [Accessory]. 
Select [ASC-8000T] in this example. 
[Maximum] and [Pulse No.] are set automatically. 

3. Select the [both] checkbox under [Control] and click [Init.]. 
ASC-8000T initialization is performed. 

4. Click [OK]. 
Close the [Sampler] window. 

6. Click the [Scan parameters] tab and select the [Use ASC] checkbox. 

If the background sample is contained in the ASC, select the [Run BKG sample] checkbox. 
Install the background sample at position B in the ASC. This position is recognized as No. 0 in 
LabSolutions IR. 
Deselect [Run BKG sample] when only using position B in the ASC to measure a sample. 
Position B in the ASC is recognized as No. 0 in LabSolutions IR. 

7. Click the [Scan parameters] tab in the settings area and then click [Settings]. 

The [Instrument Parameters] window is displayed. 

8. Set the scan parameters on each tab. 

Use the same settings as for normal spectrum measurement. 
 

  
See "4.2 Set Scan Parameters". 

3 

4 

2 

1 
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[Instrument Parameters] Window 

9. Click [OK] after settings are complete. 

The [Instrument Parameters] window closes and the scan parameters are displayed on the [Scan 
parameters] tab. 

10. Enter the number of samples to be measured into the field to the left of the [Insert Line] button 
above the sample table. 

Measurement of 17 samples will be performed in this example, so enter "17" and click [Insert Line]. 
Rows 1 to 17 are added to the list. 

11. Drag numbers 1 to 17 in the [No.] column to select rows 1 to 17 and then click [Edit All]. 

The [batch sample information input] window is displayed. 
In this example, configure the following settings. 

 

Item Setting 

[ASC] Select this checkbox. 
Enter the number of the sample to be measured first in [First no]. 
Enter "1" in this example. 

[Sample name] 
[Sample ID] 
[Option] 

Select this checkbox. 
These comprise the text entered for [Name] suffixed with a number. 

[Spectrum name] Select this checkbox. 
This is the filename of the spectrum saved in the photometric measurement 
file. 
This name comprises the text entered for [Name] suffixed with a number or 
ASC number. 
This name can also be created by combining the sample name and sample 
ID. 
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[batch sample information input] Window 

12. Click [OK] after the settings are complete. 

13. Install the background sample and sample in the ASC. 

14. Click [Sample Scan] on the photometric measurement toolbar. 

Spectrum measurement of the sample is performed after background (BKG) measurement is complete. 
The real-time spectrum is displayed on the [BKG&Monitor spectrum] tab in the graph area. 
Each time a spectrum measurement completes, the spectrum is saved and the photometric results are 
displayed in the sample table. 
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6.5 Post-Processing of Photometric Data 
A variety of calculations can be performed based on the determined concentration values. 

1. Click the [Equation] tab in the settings area and then click [Edit]. 

The [Equation setting] window is displayed. 

2. Set an equation. 

Calculation using a user-specified equation and pass/fail assessment using an acceptance equation can 
be performed with respect to peak area etc. 

 

 
[Equation setting] Window 

 



Chapter 6 Photometric 

70  LabSolutions IR Basic Operation Manual 
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Chapter 7 Postrun/View 
 

This chapter explains how to operate the postrun program and the view window of each 
measurement program. 

Refer to the help file provided with the LabSolutions IR software for examples not included in this 
manual. 

Refer to the help file provided with LabSolutions IR for detailed explanations, tutorials, and other 
information regarding LabSolutions IR functions. 

 

 Explanations included in this chapter 
This chapter explains the functions for displaying data, overlaying data, magnifying data on screen, 
and conversion of data on the vertical axis. 

The sample data used in explanations of operations is located in the installation folder of this 
software. 

For example, if the software is installed to "C:\Program Files", the sample files are copied to 
"C:\Program Files\LabSolutions\IR\Data". This path is abbreviated to "\Data" and "\Data\Tutorial" in 
the case of subfolders in this manual. 

  
If using the database version or client server version, use a project with a registered sample file that 
was created according to descriptions in the Installation and Maintenance Manual ("Sample_IR_JP" 
under default settings). 

 

 Operations that can be performed using this function 
 

Postrun program 

Display, print, process data, search, and perform chemometric quantitation with respect to 2D 
spectra, 3D spectra, 4D spectra, and Time course data. 

 Use this program to create and edit libraries. 

 Run this program in conjunction with other windows for performing measurements, including the 
Spectrum program, Time course program, Quantitation program, and Photometric program. 

 

View window 

 Analyze measured data and spectra in the same measurement window. 

 Note that view windows cannot be used for chemometrics or to create and edit libraries. 
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7.1 Startup 
Click [Postrun] in the LabSolutions IR launcher to start the postrun program. 

The measurement programs that allow postrun are spectrum measurement, Time course 
measurement, and mapping measurement. 

This program can run in conjunction with other windows for performing measurements, including the 
Spectrum program, Time course program, Quantitation program, and Photometric program. 

 

Click [View] on the main toolbar in each measurement program to show the corresponding view 
window. 

 

7.1.1 Postrun Window/View Window Layout 

 
Postrun Window 

 

The postrun window and view windows are divided into the following five parts. 

No. Name Function 

1 Main toolbar The main toolbar common to all LabSolutions IR windows. 
Printing, searching, and manipulation can be performed from this 
toolbar. 

2 Tree view Common to all LabSolutions IR windows. 
Displays scan parameters, peak pick tables, and data history saved 
together with the currently opened data in a hierarchical view. 
Click [+] on each node to expand the hierarchy contained within. 

3 Log Displays and records logs and warnings resulting from LabSolutions 
IR operation. 

4 Graph window Displays spectra. 

5 Manipulation result Displays the peak pick results, point pick results, and pausing records 
during Time course program. 
Also, peak pick and point pick can be executed from this area. 

1

4
2 

3 
5
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7.2 Functions of the Postrun Window/View Windows 
7.2.1 Zooming Data 

Drag the cursor on the main display graph window to create a rectangular frame and click on the 
position to zoom. The area enclosed by the rectangular frame is zoomed. 

The zoomed position is also shown in the overview window. 

 

 
Displaying a Zoomed Spectrum 

 

Overview 

Main display 
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 Changing the zoomed state 
The zoomed state in the overview window can be changed. 

 Move the mouse cursor over a  mark around the gray frame, which indicates the zoomed 
position, to display an up/down, left/right, or diagonal arrow depending on the location of the mark 
on the frame. 

Dragging the mouse while this arrow is displayed changes the size of the frame as well as the 
zoomed display in the area below the graph display. 

 Move the mouse cursor inside the gray frame to display crossed arrows. 

Dragging the mouse while crossed arrows are displayed moves the position of the frame as well 
as the zoomed display in the area below the graph display. 

 

   
Changing the Zoomed State 

 

 Autoscale 
Click [Autoscale] on the right-click menu on the graph window to change the vertical range to one 
appropriate for the displayed horizontal (wavenumber) range. 

 

 
Autoscale 

 

 Full scale 
Click [Full view] on the right-click menu on the graph window to return the magnified data to its 
original size. 
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7.2.2 View 

 Transmittance (%T) and absorbance (Abs) conversion 
Click [Y-Axis Mode] - [Transmittance] or [Absorbance] on the right-click menu on the graph window 
to convert between transmittance (%T) and absorbance (Abs). 

 
Converting Between Transmittance and Absorbance 

 

 Hiding the overview window 
Click [Overview] on the [Window] menu to hide the overview window and enlarge the main display 
graph window. 

Click [Overview] again to redisplay the overview window. 

 
Hiding the Overview Window 
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7.2.3 Viewing Multiple Data 

1. Click [Open] on the [File] menu. 

2. Select the filename of the data to open in the folder that stores the data and click [Open]. 

 
[Open] Dialog Box 

 

 
The file extension of spectra measured using LabSolutions IR is usually ".ispd". 
Multiple data can be opened at the same time by using the "Shift" and "Ctrl" keys. 

 

In this example, make sure the folder displayed for [Look in] is "\Data\Tutorial", select multiple data, 
such as "MIX1.ispd" and "MIX2.ispd", while holding down the "Shift" or "Ctrl" key, and then click 
[Open]. 
The selected data is displayed in an overlaid state. 
The data for display (active data) can be changed by clicking on the tab of each corresponding data. 

 

 
Opening Multiple Data 
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 Displaying and hiding data 
The tree view can be used to hide and redisplay data. 

This example uses the "MIX2" data to demonstrate these operations. 

1. Click on [MIX2] (not [Active Data: MIX2]) located under "\Data\Tutorial\MIX2.ispd" in the tree 
view to make it active. 

2. Click [Display] on the right-click menu. 

The check mark disappears and the data becomes hidden. 
 
Click [Display] again to redisplay the data. 
Click [Hide All] on the [Window] menu to hide all data. 

 

 
Displaying and Hiding Data 

 

 Closing data 
The tree view can be used to close any currently open data (regardless of whether it is displayed or 
hidden). 

This example uses the "MIX2" data to demonstrate this operation. 

1. Click on [MIX2] (not [Active Data: MIX2]) located under "\Data\Tutorial\MIX2.ispd" in the tree 
view to make it active. 

2. Click [Close] on the right-click menu. 

The "MIX2.ispd" file and any accompanying data is closed. 
 
Data can also be closed by clicking [Close] on the [File] menu. 
Click [Close All] to close all open data. 
 

  
Clicking [Close] and [Close All] does not delete the data from the hard disk. LabSolutions IR 
does not possess any functions that delete data from the hard disk. 
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7.2.4 Joining Multiple Data 

 Joining all 
All data (not hidden) in the main display graph window can be displayed in the same window in an 
overlaid state. 

1. Click [Join All] on the [Window] menu. 

All currently displayed data is shown in an overlaid state. 
This operation overlays all the currently displayed data over the active data. 
 
After clicking on the [MIX1] tab to make it active, click [Join All] on the [Window] menu to combine 
all the tabs into a single [MIX1] data tab. 
Click [Split All] on the [Window] menu to return each data set to its corresponding tab. 

 

 
Joining All Data 

 

 Joining arbitrary data 
Arbitrary data (not hidden) can be displayed overlaid on one other data set. 

The following example demonstrates overlaying the "PURE1" data on the "PURE2" data. 

1. Click the [PURE1] tab to make it active. 

2. While holding down the "Shift" key, drag and drop the [PURE1] tab onto the [PURE2] tab. 

The "PURE1" data is moved onto the "PURE2" data and these two data sets (PURE1 and PURE2) are 
displayed on the [PURE2] tab in an overlaid state. This operation removes the [PURE1] tab. 
Use the "Ctrl" key instead of the "Shift" key to overlay the two data sets (PURE1 and PURE2) on the 
[PURE2] tab without removing the [PURE1] tab. 

 

More than three data sets can be overlaid by repeating the above operation. 
Click [Split All] on the [Window] menu to return each data set to its corresponding tab. 
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 Changing the display of overlaid data 
The display method for overlaid data can be changed via [Style in Tab] and [Split View] on the 
[Window] menu. 

Display Method Function 

[Overlay] Join and overlay multiple data. 

[Tile] Tile the display of multiple data. 

[Tile Vertical] Vertically tile the display of multiple data. 

[Style in Tab] 

[Tile 
Horizontal] 

Horizontally tile the display of multiple data. 

[1  2] 

[2  1] 

[2  2] 

[2  3] 

[3  2] 

[3  3] 

Split the data tab into several areas and display the spectrum in each 
area. 
After selecting a display method via [Split View], drag data from the 
tree view into each divided area. Join operations can be performed 
and the display mode and range can be configured in each area. 

[Split View] 

[Cancel Split] Return to the overlaid display. 
 

 Zooming overlaid data 
The method described in "7.2.1 Zooming Data" can also be used when data is overlaid. 

However, since [Autoscale] and [Full view] both change the vertical range of the active data, other 
data that is overlaid may run off the edges of the window. 

By using [Multi Autoscale], [All Full], and [Every Autoscale], the size of all overlaid data can be 
changed without any data running off the edges of the window. 

Magnification Method Function 

[Fit with Range] Display all data shown in the same data tab so that the intensity of each data 
matches the specified horizontal axis range by multiplying all data with an 
appropriate coefficient and adding a constant. This is useful when comparing data 
with different sized peaks and misaligned baselines. 

[Y-Expand To Fit] Display all data shown in the same data tab so that the intensity of each data 
matches the specified horizontal axis position by multiplying all data with an 
appropriate coefficient. This is useful when comparing data with misaligned 
baselines. 

[Y-Move To Fit] Display all data shown in the same data tab so that the intensity of each data 
matches the specified horizontal axis position by adding an appropriate constant to 
all data. This is useful when comparing data with misaligned baselines. 

[Full view] Display the active data using the full scale. 

[All Full] Display all data using the full scale. 

[Autoscale] Automatically adjust the intensity axis so that the entire peak of the active data can 
be displayed. 

[Multi Autoscale] Automatically adjust the intensity axis so that the entire peaks of all overlaid data 
can be displayed. 

[Every Autoscale] Automatically scale all overlaid data and display the result on a single data tab. 
 
 

  
When data is shown in the "Shift" display and if [Autoscale], [Full view], [Multi Autoscale], [All Full], 
or [Every Autoscale] is executed, all data may not be displayed inside the graph. In this case, either 
adjust the ordinate range or specify an appropriate [Dataset margin] on the [General] tab of the 
[Graph Preferences] window, which is displayed by right-clicking on the graph. 
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7.3 Using the Manipulation Results Window 
This window displays the peak pick results (peak pick table), Point pick results (point pick table), and 
pausing records during Time course measurement. 

The window also allows peak pick, Point picking, and editing of comments related to pausing 
records during Time course measurement. 

Switch between displays by clicking [Manipulation Result] on the [View] menu. 

 

7.3.1 Peak Pick Table 
The peak pick table displays the results of peak pick. Peak pick can also be performed manually. 

 
Peak Pick Table 

 

The peak pick table displays the following information. 

Item Description 

[No.] Indicates the number of the detected peak. 

[Peak] Indicates the position of the detected peak. 

[Intensity] Indicates the top position value of the detected peak on the vertical axis. 

[Corr. Intensity] Indicates the height of the peak top from the baseline, from which the values 
of [Base (H)] and [Base (L)] have been subtracted. 

[Base (H)], [Base (L)] Indicates the baseline positions. 

[Area] Indicates the area from the zero value on the vertical axis. 

[Corr. Area] Indicates the area enclosed between the graph and baseline after subtracting 
the values of [Base (H)] and [Base (L)]. 

[Area color] Change the peak fill color if necessary. 
The default setting is [Auto]. [Auto] is the same setting as that in the [2D 
Graphic Preferences] window. Double-click on a cell to display the [Peak Area 
Color] window. 

[Comment] Display a comment on the corresponding peak. 
Double-click on a cell, enter a comment, and press the "Enter" key. 
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Peak marks are displayed for the detected peaks in the graph window. 

Details for display are set in the [2D Graph Preferences] window. Right-click on the graph window 
and select [Graph Preferences] on the right-click menu. Display the [Style] tab in the [2D Graph 
Preferences] window and select the details to display from No., X axis value, Y axis value, and 
Comment under [Label]. 

In addition, peak pick can be performed manually using the following buttons located at the lower left 
of the peak pick table. 

 

 [Move to Peak Pick screen] 
This button displays the peak pick window. For details on the peak pick window, see "8.2 Peak 
Pick". 

 

 [Add Peak] 
This button displays the [Add Peak] window that allows peaks to be added to the peak pick table. 

Enter an X axis value into the [Add Peak] window to automatically detect any peak tops and bases in 
the surrounding area and add them to the peak pick table. 

 

 [Auto Cursor] 
Move the cursor that indicates the peak position in the main display graph window to detect the 
corresponding peak and add it to the peak pick table. 

1. Click  and select [Auto Cursor] from the list. 

A vertical cursor (red line) is displayed in the magnified display graph window.  

2. Drag and drop the vertical cursor (red line) to the position for detection. 

3. Click when the cursor changes to the shape of a hammer. 

Any peak tops and bases in the vicinity of the specified position are detected automatically and added 
to the peak pick table. 

 

 

 [3 Point Cursor] 
Move the cursor that indicates the displayed peak position and the two baseline positions in the 
magnified display graph window to detect the corresponding peak and add it to the peak pick table. 

1. Click  and select [3 Point Cursor] from the list. 

Three vertical cursors (red lines) are displayed. 

2. Drag and drop a vertical cursor (red line) to the peak position and each of the baseline 
positions. 

3. Click when the cursor changes to the shape of a hammer. 

The software searches for a peak top at the specified position, calculates the height from the specified 
baseline, and adds the located peak to the peak pick table. 
 

 

 [Delete Peak] 
Delete a peak from the peak pick table. 
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 [Peak Ratio] 
Display peak intensities (ratios) when the selected peak is given an intensity of 1. 

1. Select a peak in the peak pick table. 

2. Click  and select [Peak Ratio] from the list.  

Peak intensities (ratios) are displayed in the peak pick table. 
Click [Peak Ratio] again to clear the intensities. 

 

 

7.3.2 Point Pick Table 
The point pick table displays the results of Point pick. Create a table (point pick table) of X axis 
values and their corresponding intensity. 

 
Point Pick Table 

 

The point pick table displays the following information. 

Item Description 

[No.] Indicates the point number. 

[X value] Indicates the point's position on the X axis. 

[Y value] Indicates the point's position on the Y axis. 

[Label] Specify the display direction (up or down) of the point pick mark displayed in 
the graph window. 

[Comment] Display a comment on the corresponding point. 
Double-click on a cell, enter a comment, and press the "Enter" key. 

 

In addition, Point pick can be performed using the following buttons located at the lower left of the 
point pick table. 
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 [Add Point] 
This button displays the [Add Point] window that allows points to be added to the point pick table. 

Enter an X axis value into the [Add Point] window to add the value of the corresponding point into 
the point pick table. 

 

 [Cursor] 
Move the cursor that indicates the point position in the main display graph window to add the 
corresponding data to the point pick table. 

1. Click  and select [Cursor] from the list. 

A vertical cursor (red line) is displayed in the magnified display graph window. 

2. Drag and drop the vertical cursor (red line) to the position for detection. 

3. Click when the cursor changes to the shape of a hammer. 
 

 

 [Delete Point] 
Delete a point from the point pick table. 

 

 [Save Point List] 
Save the X axis value of the configured point to a point pick template. 

 

 [Apply Point List] 
Apply a saved point pick template to the displayed data and perform Point pick automatically. 
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Chapter 8 Manipulation 
 

This chapter explains how to perform manipulation. 

Refer to the help file provided with the LabSolutions IR software for examples not included in this 
manual. 

Refer to the help file provided with LabSolutions IR for detailed explanations, tutorials, and other 
information regarding LabSolutions IR functions. 

 

 Explanations included in this chapter 
This chapter explains the Manipulation function, with examples that include peak pick, baseline 
correction, and spectral subtraction. 

The sample data used in explanations of operations is located in the installation folder of this 
software. 

For example, if the software is installed to "C:\Program Files", the sample files are copied to 
"C:\Program Files\LabSolutions\IR\Data". This path is abbreviated to "\Data" and "\Data\Tutorial" in 
the case of subfolders in this manual. 

  
If using the database version or client server version, use a project with a registered sample file that 
was created according to descriptions in the Installation and Maintenance Manual ("Sample_IR_JP" 
under default settings). 

 

 Operations that can be performed using this function 
Use the following main methods of manipulation with respect to spectra. 

 Arithmetic 

 Normalize 

 Zero Baseline Correction 

 3 Point Baseline Correction 

 Multipoint Baseline Correction 

 Smoothing 

 Derivative 

 Cut 

 Connect 

 Reduce 

 Interpolate 

 Frequency Convert 

 X Adjust 

 Time-Temperature Conversion 

 Peak Pick 

 Film Thickness 

 Data Calculation 

 Purity 

 Deconvolution 

 FFT 

 Kubelka Munk 

 ATR Correction 

 Advanced ATR Correction 

 Kramers Kronig 

 Peak Split 

 Atmosphere Correction 

 

  
Relationship between Lambert-Beer's law and manipulation 

Click [Manipulation Preferences] on the [Tool] menu and select the [Disable Lambert Beer] 
checkbox to perform manipulation on transmittance spectra in transmittance mode. Calculations can 
be performed on transmittance spectra during manipulation without changing the mode. 

Example) 

Half of 50 % transmittance is 25 % (0.5  0.5 = 0.25) when the [Disable Lambert Beer] checkbox is 
selected and is approximately 70 % when the [Disable Lambert Beer] checkbox is deselected 
because transmittance is converted to absorbance and multiplied by 0.5. 
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8.1 Startup 
Click the relevant manipulation button on the main toolbar to perform manipulation. 

Click  on the right of each button to display a list of available manipulation. Select the required 
command from the list to execute the corresponding manipulation. 

The manipulation buttons display the name of the last used manipulation. 

Two manipulation buttons are available for use. 

 

 

 
Manipulation Window (Postrun Window) 

 

Manipulation buttons 
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8.2 Peak Pick 
When multiple spectra are displayed, make the spectrum active for peak pick. Once active, select 
[Peak Pick] from the list of manipulation buttons to display the peak pick window. 

The noise level and threshold can be set for the peaks to be detected in the peak pick window. 

Enter values for the peak pick parameters and then click [Calc] to display the peak pick results. The 
number of peaks for detection can be adjusted by adjusting the threshold and noise level. 

 

 Peak Pick algorithm 
Peaks are detected in the following manner. 

 The peak pick algorithm searches for peak tops and bases on each side by checking the rise and 
fall of values on the vertical axis. 

 Of the peak tops found, peak tops whose transmittance is lower than the threshold value in the 
case of transmittance spectra, and peak tops whose absorbance is higher than the threshold 
value in the case of absorbance spectra qualify as peak candidates. 

 The algorithm calculates the difference between the vertical axis values of the peak tops and 
bases on each side and determines that if the smallest of these is larger than the noise level, the 
candidate is a peak. 

 

 

 
Peak Pick Window 

 

Peak pick parameters 
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 Peak pick table 
The peak pick table displays the results of peak pick. 

 Display or hide the peak pick table by clicking [Manipulation Result] on the [View] menu. 

 Detected peaks can be filled with color on the graph display. 

Open the right-click menu on the data, click [Graph Preferences], and select the [Fill peaks] 
checkbox on the [Style] tab. 
While the default setting is the spectrum line color, the fill color can be specified independently 
using [Area color]. 

 A comment describing the peak can be entered. 

The comment can be displayed on the spectrum. 

 Select a row in the peak pick table and click [Peak Ratio] on the right-click menu to calculate the 
peak ratio for all other peaks with respect to the selected peak, which is considered to have a 
height and area of 1. 

Peak ratios can be printed. 

 

8.2.1 Peak Marks 
The peak pick results can be displayed on the spectrum. 
Displayable results include number, X-axis value (wavenumber/wavelength), Y-axis value 
(transmittance/absorbance), and comments. 

1. Open the right-click menu on the graph and click [Graph Preferences]. 

The [2D Graphic Preferences] window is displayed. 

2. Click the [Style] tab. 

3. Under [Label], select the checkboxes corresponding to the peak information (number, X-axis 
value, Y-axis value, and comment) to be displayed. 

 
Peak Pick Results 
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When data is shown in the "Shift" display and if [Autoscale], [Full view], [Multi Autoscale], [All Full], 
or [Every Autoscale] is executed, all data may not be displayed inside the graph. In this case, either 
adjust the ordinate range or specify an appropriate [Dataset margin] on the [General] tab of the 
[Graph Preferences] window, which is displayed by right-clicking on the graph. 

 

 

8.3 Baseline Correction 
If the baseline of a measured spectrum is considerably low or bent due to light scattering in 
transmittance measurement or carbon black in ATR measurement, the baseline can be corrected 
using baseline correction. 

In this example, use the "TOLUENE.ispd" spectrum file located in the "\Data\Tutorial" folder. 

1. Open the "TOLUENE.ispd" spectrum file and click the [TOLUENE] tab to make it active. 

2. Click [Baseline Correction] in the manipulation button list. 

There are three baseline correction methods: [Zero], [3 point], and [Multipoint]. 
 

  
Relationship between Lambert-Beer's law and manipulation 

Click [Manipulation Preferences] on the [Tool] menu and select the [Disable Lambert Beer] 
checkbox to perform manipulation on transmittance spectra in transmittance mode. 
Calculations can be performed on transmittance spectra during manipulation without 
changing the mode. 

 

 

8.3.1 Zero Baseline Correction 
This method of baseline correction is performed so that the minimum value of the spectrum 
becomes "abs = 0" (the maximum value is 100%T in the case of transmittance.) without changing 
the shape of the spectrum. 

1. Click [Zero] under [Method]. 

2. Click [Manipulation Preferences] on the [Tool] menu. 

The [Manipulation Preferences] window is displayed. 

3. Select the [Disable Lambert Beer] checkbox and click [OK]. 

4. Click [Calc]. 

The correction results are displayed. 
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Zero Baseline Correction 

5. Click [OK]. 

The screen returns to the view window and the corrected spectrum is displayed on a [Zero Baseline 
Correction] tab separate from the original spectrum. [Zero Baseline Correction] is also displayed below 
[TOLUENE] in the tree view. 

 

 

 

8.3.2 3-Point Baseline Correction 
This method of baseline correction is performed by specifying a vertical axis value at three arbitrary 
wavenumber positions. 

Normally the three vertical axis values should be specified as the maximum wavenumber, 
2,000 cm−1, and the minimum wavenumber. 

1. Click [3 point] under [Method]. 

2. Click [Manipulation Preferences] on the [Tool] menu. 

The [Manipulation Preferences] window is displayed. 

3. Select the [Disable Lambert Beer] checkbox and click [OK]. 

4. Enter a vertical axis value for each point ([Reference position1], [Reference position2], and 
[Reference position3]) under [3 Point] and click [Calc]. 

The correction results are displayed. 
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3-Point Baseline Correction 

5. Click [OK]. 

The screen returns to the view window and the corrected spectrum is displayed on a [3 Point Baseline 
Correction] tab separate from the original spectrum. 

 

 

 



Chapter 8 Manipulation 

92  LabSolutions IR Basic Operation Manual 

8.3.3 Multi-Point Baseline Correction 
This method of baseline correction is performed by specifying an arbitrary number of vertical axis 
values at arbitrary wavenumber positions. 

Specify vertical axis values and wavenumber positions using the mouse. 

There are two specification modes, [Cursor selection] and [Surfing], and values are entered at the 
cursor position on the spectrum in both of these modes. 

 [Cursor selection] mode: The correction point is regarded as the cursor position (clicked 
position) as well as the wavenumber position and vertical value. 

 [Surfing] mode: The correction point is regarded as the point on the spectrum that 
corresponds to the clicked wavenumber. 

 

This example uses the [Surfing] mode to demonstrate multi-point baseline correction. 

 
Multi-Point Baseline Correction 

1. Click [Multipoint] under [Method]. 

2. Click [Manipulation Preferences] on the [Tool] menu. 

The [Manipulation Preferences] window is displayed. 

3. Select the [Disable Lambert Beer] checkbox and click [OK]. 

4. Click [Surfing] under [Multipoint] and then click [Add]. 

A cursor appears on the spectrum for correction. 



8.4 Spectral Subtraction 
 

LabSolutions IR Basic Operation Manual  93 

5. Click the wavenumber position to be corrected. 

A line connecting two "" marks appears on the spectrum at the position of the clicked wavenumber. 
This is the baseline for correction. 

6. Once the baseline for correction is set, right-click to complete cursor input. 

7. Click [Calc]. 

The correction results are displayed. 
After checking the correction results, click [Add] again to increase the number of correction points or 
click [Delete] to remove any unwanted points. 
When removing points, select the unwanted correction point from the list of correction points and click 
[Delete]. 

8. Click [OK]. 

The screen returns to the view window and the corrected spectrum is displayed on a [Multipoint 
Baseline Correction] tab separate to the original spectrum. 

 

 

8.4 Spectral Subtraction 
In a mixture of several components, the sum of each component's spectrum is the spectrum of the 
mixture as long as mixing the components does not cause any changes, such as a chemical 
reaction. 

Accordingly, by determining the difference between the spectrum of the mixture and spectra of 
components contained in the mixture, spectra of the remaining components can be obtained. This 
method is called spectral subtraction. 

Spectral subtraction is often used in manipulation for the FTIR. 

The following example uses the "MIX1.ispd" spectra file (mixture) and "PURE3.ispd" spectrum file (a 
component contained in MIX1) located in the "\Data\Tutorial" folder to demonstrate spectral 
subtraction (MIX1 - PURE3). 

1. Open the "MIX1.ispd" and "PURE3.ispd" files and click the [MIX1] tab to make it active. 

2. Click [Data Calculation] in the manipulation button list. 

The data calculation window opens and the "MIX1.ispd" file is displayed. 

3. Select [MIX1] in the tree view and click [Send to Source] on the right-click menu. 
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4. Select [PURE3] in the tree view and click [Send to Reference] on the right-click menu. 

The selected spectra appear overlaid. 
 

 
Data Calculation Window 

 

  
Relationship between Lambert-Beer's law and manipulation 

Click [Manipulation Preferences] on the [Tool] menu and select the [Disable Lambert Beer] 
checkbox to perform manipulation on transmittance spectra in transmittance mode. 
Calculations can be performed on transmittance spectra during manipulation without 
changing the mode. 

 
 

The following four methods of data calculation can be performed using [Data Calculation]. 
 Spectral sum (addition of two sets of data)  Result = source + reference  factor 
 Spectral difference (subtraction of two sets of data)  Result = source - reference  factor 
 Spectral product (multiplication of two sets of data)  Result = source  reference  factor 
 Spectral quotient (division of two sets of data)  Result = source / (reference  factor) 

5. Click [Subtract 2 data] under [Method]. 
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6. Click [Calc]. 

The calculation results are displayed. 
 

 
Spectral Subtraction Calculation Results 

 

 
The formula for spectral subtraction is shown below. 

 

(Difference spectrum) = (Mixture) - (Component)  k 
k: Factor, 0 < k < 1 

 

The factor "k" in the above formula indicates the proportion of the component spectrum that occupies 
the mixture spectrum. This factor must be estimated. 
A factor of "k" smaller than the actual value leads to insufficient subtraction and the absorption of the 
component remains in the difference spectrum obtained as the calculation result. On the contrary, a 
factor of "k" larger than the actual value leads to excessive subtraction and the absorption of the 
component appears in the opposite direction. The figure above shows the result obtained when "k = 1", 
in which the absorption of "PURE3.ispd" is subtracted excessively and appears as a peak in the 
opposite direction. The following methods can be used to change the factor value. 
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 Changing the factor using the slider 
 Drag the slider located under [Factor] to the left or right to change the factor value. The 

calculation result is simultaneously updated with the new value. 

 Click the small point at either end of the slider to gradually change the value specified in [Step]. 

 

Using the method stated above, find a factor value for which absorption of "PURE3.ispd" does not 
remain in the difference spectrum and does not cause it to appear in the opposite direction. 

 
Changing the Factor Using the Slider 

 

 Automatic calculation 
The factor for which "abs = 0" at the wavenumber position specified using the cursor can be 
calculated automatically. 

 

Select the [AutoCalc] checkbox to enable wavenumber input. 

Click [>>] to display the cursor on the spectrum shown in the upper portion of the screen. 

Specify the absorption wavenumber position where "abs = 0" for "PURE3.ispd" using the cursor and 
click [Calc]. 

If the absorption of another component exists at the position specified using the cursor or if the 
baseline of the spectrum to be used in subtraction is bent, a slight error may be generated in 
spectral subtraction when using the factor obtained in automatic calculation. 

 

In the result shown below, the factor is slightly too much and therefore the absorption of 
"PURE3.ispd" appears in the opposite direction in the range from 1,650 to 1,500 cm−1. 

In this case, change the specified wavenumber position and click [Calc] again or finely adjust the 
factor using the slider after deselecting the [AutoCalc] checkbox. 
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Automatic Calculation 

 

Lastly, click [OK] to return to the view window where the difference spectrum is displayed on the 
[MIX1 - PURE3] tab. 
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Chapter 9 Search 
 

This chapter explains how to operate the search function. 

Refer to the help file provided with the LabSolutions IR software for examples not included in this 
manual. 

Refer to the help file provided with LabSolutions IR for detailed explanations, tutorials, and other 
information regarding LabSolutions IR functions. 

 

 Explanations included in this chapter 
This chapter explains the function for searching libraries for measured spectra, and the function for 
creating and editing libraries from measured spectra. 

The sample data used in explanations of operations is located in the installation folder of this 
software. 

For example, if the software is installed to "C:\Program Files", the sample files are copied to 
"C:\Program Files\LabSolutions\IR\Data". This path is abbreviated to "\Data" and "\Data\Tutorial" in 
the case of subfolders in this manual. 

  
If using the database version or client server version, use a project with a registered sample file that 
was created according to descriptions in the Installation and Maintenance Manual ("Sample_IR_JP" 
under default settings). 

 

 Operations that can be performed using this function 
Use the search function to perform the following. 

 

Search functions 

 Perform spectrum search (similarity search), peak search, text search, and combination search 

 Search user libraries and commercial libraries 

 Use the post-search processing function 

 Perform spectral subtraction between search target spectrum and spectrum in search results 

 Recalculate difference spectra 
 

Library editing functions 

 Create libraries from spectra 

 Edit the contents of created libraries 
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9.1 Startup 
Display the spectrum to be searched for in the view window of the relevant measurement program or 
postrun window and click [Search] on the main toolbar. 

Select [Search] to perform a search or [Edit Library] to create or edit a library. 

 
 

Main Toolbar 

 

9.2 Search 
Click [Search] on the main toolbar to display the search window. 

 
Search Window 

 

Spectrum search is made possible by qualitative analysis and identification of spectra obtained 
through measurement or manipulation. The following four methods can be used for searching. 

Function Description 

Spectrum search Search a library based on the spectrum pattern. 

Peak search Search a library based on a specified peak. 

Text search Search a library based on name and keyword. 

Combination search This is a combination of spectrum search and text search. 
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9.2.1 Preparation 

1. Click the [General] tab. 

2. Select the checkbox of the library name to use in the search. 

A list of registered libraries is displayed under [Library]. 
If the desired library is not shown, click [Add] to display the [Select a Database] window and open the 
library file for use in searching from the [Library] folder. 

 

 
Library Selection 

3. Set the maximum number of hits, which determines the top number of spectra to display, and 
the minimum score to display. 

In this example, set "10" for [Maximum hits] and "250" for [Minimum quality] (score). 
 

 
Parameter Settings 

 
Normally the entire measured wavenumber range is used so deselect the [Use wavenumber ranges] 
checkbox. 
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9.2.2 Spectrum Search 
Spectrum search is the most frequently used method for identification and qualitative analysis of 
unknown samples in the analysis of contaminants. 

The following example demonstrates spectrum search using the spectrum of polystyrene film 
measured in "Chapter 4 Spectrum". 

1. Click [Search] on the main toolbar. 

The search window is displayed. 

2. Click [Open] on the main toolbar and open the polystyrene film spectrum. 

If the spectrum is already in the tree view, use the tree view to open the spectrum. 

3. Click the [Spectrum] tab. 

4. Select the calculation method (algorithm) for searching. 

The types of algorithms are listed in the table below. 
Normally use [DiffDeriv] or [CorrDeriv]. 
Select [DiffDeriv] in this example. 

 

 
Algorithm 

 

Algorithm Description 

[DiffDeriv] Calculates the primary differential of each data, performs fitting of the entire 
curve, and compares the differential factor at each point. 

[CorrDeriv] Calculates the primary differential of each data and evaluates similarity using 
the calculated correlation factor. 

[Difference 1. Deriv.] Calculates the primary differential of each data and compares the differential 
factor at each point. 
This algorithm can minimize baseline effects and the effects of unclear peaks 
that span a wide range. 

[Difference] Calculates the absolute difference between the sample spectrum and the 
reference spectrum. 

[SQDifference] Adopts the same concept as the least-squares method. Because the 
difference between spectra is squared, large differences are more important 
than small differences. 
The hit rate declines when a few large differences are present as opposed to 
many small differences. 

[SQDifference 1. 
Deriv.] 

Calculates the primary differential of each data and squares the difference in 
differential factor at each point. 
This algorithm is especially effective when the S/N ratio is very small. 

[Euclidean] This algorithm is sensitive to peak shapes. The hit rate declines if the 
spectrum baseline is tilted or the baseline has an offset value. 

[Person] Establishes a linear relationship between the intensities of the sample 
spectrum and reference spectrum. This algorithm has an emphasis on broad 
peaks. 
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5. Select the number of skip points. 

The number of skip points indicates the interval between the data points used in search calculation. 
Normally, select [1]. 

6. Specify the wavenumber range if necessary. 

1. Select the [Use wavenumber ranges] checkbox under [Parameters] on the [General] tab and 
click [Ranges]. 
The [Ranges] window is displayed. 

2. Click [New Range]. 
A cursor is displayed on the spectrum. 

 

 
Wavenumber Range Specification 

3. Drag the cursor to specify the wavenumber range. 
The corresponding values are entered into the table above the spectrum. 
The created wavenumber range can be changed on the spectrum. 
Values can also be entered manually. 

7. Click [Spectrum Search]. 

The search starts. 
 The search target spectrum (upper area), hit spectrum (middle area), and hit list (lower area) are 

displayed as the search results. 
 The hit list displays spectra in terms of score in descending order. 
 While the spectrum at the top of the hit list is displayed as the hit spectrum immediately after 

searching, other spectra in the hit list can be displayed by clicking on the corresponding row. Click 
rows on the hit list while holding down the "Shift" key or "Ctrl" key to display multiple hit spectra 
at the same time. 

 Click [Join] to display the search target spectrum overlaid with the spectra selected in the hit list. 
Click this button again to return to the original display. 
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Search Results 

 

 

 

9.2.3 Text Search/Combination Search 
The text search function searches spectra based on name (such as a registered chemical 
compound name or product name) or keyword. The combination search function combines spectrum 
search and text search. 

Configure spectrum search settings on the [Spectrum] tab. 

Set the conditions for the text search keyword using the [Include all text], [Include any text], and [Not 
include text] tables in the [Test Search] window. Each table accepts up to 30 conditions. 

1. Click the [General] tab and then click [Text Search]. 

The [Text Search] window is displayed. 
If [Combination Search] is clicked, spectrum search is performed first and then a text search is 
performed on those results. 

2. Set the conditions for the text search. 

Algorithm Description 

[Include all text] Search for spectra that contain all of the keywords registered here. 

[Include any text] Search for spectra that contain any of the keywords registered here. 

[Not include text]  Search for spectra that do not contain any of the keywords registered 
here. 
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[Text Search] Window 

1. Select the type of text accompanying the spectrum. 
Select [ALL] in this example. 

2. Enter the search keyword. 
Enter "ethyl" in this example. 

3. Click [OK]. 

The search starts and spectra that contain the text "ethyl" are displayed. 
Spectra that contain the specified keyword received a score of 1000 (perfect score) and those that do 
not receive a score of 0. 
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Text Search Results 

 

 
Combination Search Results 
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9.2.4 Peak Search 
The peak search function searches for the search target spectrum based on the concordance of 
peak position and number of spectra in the library.  
Searches can even be performed without a spectrum file because peak positions can be entered 
manually. 
The following example demonstrates spectrum search using the spectrum of polystyrene film 
measured in "Chapter 4 Spectrum". 

1. Click [Search] on the main toolbar. 

The search window is displayed. 

2. Open the polystyrene film spectrum. 

If the spectrum is already in the tree view, use the tree view to open the spectrum. 

3. Click the [Peaks] tab. 

4. Select the calculation method (algorithm) for peak search. 

The types of algorithms are listed in the table below. 
Select [Match] in this example. 

 

 
Peak Search Algorithm 

 

Algorithm Description 

[Match] Compares the sample spectrum peaks and reference spectrum peaks and 
calculates the number of matching peaks. A higher score (HQI) corresponds 
to a better match. 

[Forward] Evaluates matches using the ratio of concordance of reference spectrum 
peaks with respect to sample spectrum peaks. 
If the sample spectrum has 20 peaks and the reference spectrum has 19 
matching peaks, the score (HQI) is calculated as: 19 / 20  1000 = 950. 

[Reverse] Evaluates matches using the ratio of concordance of sample spectrum peaks 
with respect to reference spectrum peaks. 
If the sample spectrum has 20 peaks and the reference spectrum has 19 
matching peaks, this means all the peaks are matched and the score (HQI) is 
calculated as: 19 / 19  1000 = 1000. 

[Forward: Reverse 1:1] Evaluates matches by combining the results of forward and reverse searching 
using a 1:1 ratio. 

[Forward: Reverse 1:2] Evaluates matches by combining the results of forward and reverse searching 
using a 1:2 ratio. 

 

5. Set an acceptable range in [Acceptable wavenumber] as peak wavenumbers that are not 
aligned may be judged as matches. 
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6. Enter the threshold for detecting peaks used in peak search. 

Peak tops whose transmittance is lower than the threshold value in the case of transmittance spectra, 
and peak tops whose absorbance is higher than the threshold value in the case of absorbance spectra are 
used for Peak searcn. 

 
Intensity Parameters 

 

  
If the baseline of the spectrum is tilted, small peaks on a baseline with high absorbance are 
handled the same as large peaks on a baseline with low absorbance, and this may change the 
search results. In this case, either adjust the threshold value or limit the wavenumber range. 

7. When performing peak search using a spectrum file, select the [Automatic peak pick] checkbox. 

This detects peaks in the search target spectrum and uses the detected peaks in the search. 
To perform peak search on a specific peak, deselect this checkbox and either manually enter the peak 
wavenumber or click [Cursor] and select the peak on the spectrum. 
Searches can be performed without a spectrum file by entering the peak position here. 

 
Peak Information 

8. Click [Peak Search]. 

The search starts. 
 

 The search target spectrum (upper area), hit spectrum (middle area), and hit list (lower area) are 
displayed as the search results. 

 The hit list displays spectra in terms of score in descending order. While the spectrum at the top of 
the hit list is displayed as the hit spectrum immediately after searching, other spectra in the hit list 
can be displayed by clicking on the corresponding row. Click rows on the hit list while holding 
down the "Shift" key or "Ctrl" key to display multiple hit spectra at the same time. 

 Click [Join] to display the search target spectrum overlaid with the spectra selected in the hit list. 
Click this button again to return to the original display. 
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9.3 Post-Search Processing 
9.3.1 Saving Search Results 

A button for saving the search results is displayed at the bottom of the search window after a search 
is executed. 

 
Button for Saving Search Results 

 

Click [Close] if the search results do not need to be saved. 

To save the search results together with the spectrum, click [Fix search result] to save the search 
results as metadata in the spectrum. Each search result can be saved separately if the [Overwrite to 
last result] checkbox is deselected when pressing this button. 

Up to 10 search results can be saved together with a spectrum. 

 
Spectrum Contents (Search Results) 

 

  
When another spectrum is searched continuously, you have to click [Close] to return to a screen 
before searching. And then a next spectrum is displayed to apply to search. 

Even if you open a spectrum or activate another spectrum by Treeview on Search result screen, it is 
not searched. 
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9.3.2 Spectral Subtraction Calculation 
Click [Difference Factor] to calculate the difference spectrum of the search target spectrum and hit 
spectra, and displays the search target spectrum overlaid with a hit spectrum (upper area), a 
difference spectrum (middle area), and hit list (lower area). 

Adjust the value of [Factor] to change the difference spectrum. 

Click [Done] to save the difference spectrum together with the measured spectrum. 

Up to 10 difference spectra results can be saved together with a measured spectrum. 

 
Spectrum Contents (Difference Spectrum Results) 

 

  
Spectrum Contents (Spectrum Subtraction Calculation Window) 
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9.4 Creating and Editing Libraries 

  
Commercial libraries cannot be edited. 

Spectrum extraction from Sadtler libraries is not available. 

 

9.4.1 Creating User Libraries 
Register measured spectra to a library to allow them to be used in searching. 

In this example, use a spectrum located in the "\Data\Tutorial" folder to create a user library. 

Run Postrun program, and then click [Edit Library] to display the edit library window. 

If the [Edit Library] button is not displayed, click  to the right of [Search] and select [Edit Library]. 

 
Edit Library Window 

1. Select [New] from the [Library]. 

The [Create User Library] window is displayed. 
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2. Enter the filename for saving the created library in the [Filename] field. 

Enter "File1" in this example. 
 

 
[Create User Library] Window 

3. Enter a title for the library to be created in the [Title] field. 

Enter "Test1" in this example. 

4. Click [Options]. 

The [Library Creation Parameters] window is displayed. 

5. Enter the wavenumber range and data interval (equivalent to resolution) of the spectrum to 
register to the library and click [OK]. 

Even if the measurement conditions for each measurement spectrum are different, the spectrum is 
registered to the library after being converted to the wavenumber range and data interval specified here. 
In this example, set the wavenumber range from "400" to "4000" and the data interval to "2". 
The user is returned to the [Create User Library] window. 

6. Click [OK]. 

"Test1" is shown in the title of the edit library window. 

7. Click [Open] on the main toolbar and load the spectrum for library registration into the tree 
view. 

In this example, use the "PE.ispd" and "PVC.ispd" files located in the "\Data\Tutorial" folder. 
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8. Move the mouse cursor over [PE] in the tree view and click [Insert into Library] on the 
right-click menu. 

 
Spectrum Registration 

 
The message "Do you want to insert PE into library Test1?" is displayed. 

9. Click [Yes]. 

The spectrum stored in "PE.ispd" is registered to the "Test1" library. 
 

  
After Library Registration 

 
Repeat steps 8 to 9 to register "PVC.ispd" in the same manner. 
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9.4.2 Editing User Libraries 
Spectra contained in libraries can be deleted and spectrum information can be edited. 

The following example demonstrates how to edit the "Test1" library created in "9.4.1 Creating User 
Libraries". 

  
Commercial libraries cannot be edited. 

Spectrum extraction from Sadtler libraries is not available. 

1. Click [Open] on [Library] and select the "File1.idx" library created in "9.4.1 Creating User 
Libraries". 

The edit library window displays the selected spectrum (upper area) and a list of spectra contained in 
the library (lower area). 

2. Edit the library. 

Viewing the library 

1. Click  (Up/Down) to select the spectrum to display. 

Click [Extract] from [Spectrum] with the spectrum selected to export the spectrum as a file. 
 

 

Changing the spectrum name and comments 

The name and comments of spectra contained in the library can be changed. 

1. Select the spectrum for editing from the spectrum list and click [Edit name and comment] on 
the right-click menu. 
The spectrum for editing can also be selected by double-clicking on it in the spectrum list. 

 

 
Editing Operations 

 

  
Changing the name and comments of spectra also changes the corresponding name 
and comments of spectra contained in existing search results. 

 
Confirmation Dialog Box 
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2. Change the [Name] and [Comment] fields as required and click [OK]. 

 
Changing the Name and Comment 

 

Deleting spectra 

Delete unwanted spectra contained in the library. 

1. Select the spectrum for deletion from the spectrum list and click [Delete] on the right-click 
menu. 
The spectrum can also be deleted by clicking [Delete] from [Spectrum]. 
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9.5 Improving Search Accuracy 
9.5.1 Preparation for Spectrum Search (Correction Processing of 

Measurement Data) 
The optimal search parameters that determine the accuracy of spectrum searches differ depending 
on the sample shape, measurement method, and executed manipulation. Check the following items 
before performing spectrum search. 

State Action 

Significant fluctuation in the baseline Correct the baseline by clicking [Baseline Correction] and selecting 
[Multipoint] for [Method]. 

CO2 overlaps the spectrum If the CO2 peaks do not directly overlap the sample spectrum, use 
[Cut] to remove them. 
If the CO2 peaks directly overlap the sample spectrum, click 
[Atmosphere Correction] on the [Tool] menu to remove them. 

Baseline is shifted from the 0 
absorbance level (100%T line) 

Correct the baseline shift by clicking [Baseline Correction] and 
selecting [Zero] for [Method]. 

Measurement using the diffuse 
reflectance method 

Perform correction using [Kubelka-Munk conversion]. 

Measurement using the ATR method Correct the absorbance intensity using [ATR correction] or [Advanced 
ATR correction] in [ATR correction]. 

Measurement using the normal 
reflectance method 

Calculate the absorbance spectrum using [Kramers-Kronig]. For this 
calculation, select [Double FFT] in the parameters and select the 
[Check Normalize result] checkbox. 

Measurement using the MCT 
detector 

Set the wavenumber range for searching in the sensitivity region of the 
detector. 
See steps 7 to 8 in "9.2.3 Text Search/Combination Search". 
Configure the following settings for a regular MCT detector. 
 Minimum value: 700.00 

 Maximum value: 4000.00 

Measured peaks are cut off The concentration of the measured sample is too high. 
Dilute the sample and perform measurement again. 

 
 

9.5.2 Relationship Between Spectrum Search Algorithms and Spectrum 
Shape 
Select an algorithm according to the shape of the spectrum. 

Algorithm Baseline Fluctuation 
Peak Intensity 

Fluctuation 
Detailed Comparison of 

Peak Shapes 

[DiffDeriv]    

[CorrDeriv]    

[Difference]    

[Difference 1. Deriv.]    

[SQDifference]    

[SQDifference 1. Deriv.]    

[Euclidean]    

[Person]    
 
 

9.5.3 Using Libraries According to Purpose 
It is not advisable to use several different types of libraries at the same time when searching. 

Estimate which substances are contained in unknown samples and only use libraries associated 
with these nominated substances for searching. This will help to achieve search results of much 
higher accuracy. 
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Chapter 10 Chemometric Quantitation 
 

This chapter explains how to operate the chemometric quantitation function. 

Refer to the help file provided with the LabSolutions IR software for examples not included in this 
manual. 

Refer to the help file provided with LabSolutions IR for detailed explanations, tutorials, and other 
information regarding LabSolutions IR functions. 

 

 Explanations included in this chapter 
This chapter explains the quantitative function that employs the chemometric (CLS) method. 

The sample data used in explanations of operations is located in the installation folder of this 
software. 

For example, if the software is installed to "C:\Program Files", the sample files are copied to 
"C:\Program Files\LabSolutions\IR\Data". This path is abbreviated to "\Data" and "\Data\Tutorial" in 
the case of subfolders in this manual. 

  
If using the database version or client server version, use a project with a registered sample file that 
was created according to descriptions in the Installation and Maintenance Manual ("Sample_IR_JP" 
under default settings). 

 

 Operations that can be performed using this function 
Create calibration curves using the CLS method and quantify unknown samples using the CLS 
method. 
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10.1 Startup 
Use the postrun program to perform chemometric quantitation. 

Start the postrun program and click [Chemometrics] on the main toolbar. 

 
Main Toolbar 

 

The chemometrics window is displayed. 

 
Chemometrics Window (Postrun Program) 
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10.2 Creating a Calibration Curve 
Click [New] on the [File] menu to create a new calibration curve when a previously created 
calibration curve file is displayed. 

Click [Open] on the [File] menu and select the desired chemometric calibration curve file to load a 
previously created calibration curve. 

 

 Measuring standard sample spectra 
Standard sample spectra and unknown sample spectra must be measured and saved in advance 
using the Spectrum program. Perform these measurements in absorbance mode. 

The number of standard samples required in chemometric quantitation increases with the amount of 
components to be quantified. 

 

 Creating a chemometric calibration curve (loading a standard sample spectrum and 
entering concentrations) 
The following procedure describes how to create a chemometric calibration curve. 

1. Click the [CLS] tab in the chemometrics window. 

2. Click the [Calibration] tab. 

3. Click [Open] on the [File] menu and open the standard sample. 

The file is displayed on the toolbar and its contents is added to the table. 

4. Select the checkboxes corresponding to the required components and enter the concentration 
for each one. 

Spectrum Component 1 Component 2 Component 3 

REFV2\REFV2 200 373 458 

REFV3\REFV3 299 370 454 

REFV4\REFV4 408 366 449 

REFV5\REFV5 504 362 444 

REFV6\REFV6 601 358 440 

REFV7\REFV7 701 354 435 

REFV8\REFV8 810 350 431 

REFE1\REFE1 394 296 447 

REFE2\REFE2 427 340 463 

REFE3\REFE3 457 369 457 

REFE4\REFE4 489 402 445 

REFE5\REFE5 538 447 437 

REFL1\REFL1 478 408 420 

REFL2\REFL2 457 385 444 

REFL3\REFL3 434 368 460 

REFL4\REFL4 418 355 475 

5. Click [Calibrate]. 

The [Prediagnosis], [CLS Calib. Report], and [CLSAnalyze] tabs are displayed. 
This data is the same as that contained in the "CLSDemo.irqc" file located in the "\Data\Tutorial" 
folder. 
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 Loading a chemometric calibration curve 
The following procedure describes how to load a previously created chemometrics calibration curve. 

1. Click the [CLS] tab in the chemometrics window. 

2. Click the [Calibration] tab. 

3. Click [Open] on the [File] menu and open the chemometrics calibration curve file (.irqc). 

The chemometric calibration curve is displayed on the toolbar and its contents is added to the table. 
In this example, open the "CLSDemo.irqc" file located in the "\Data\Tutorial" folder as the CLS 
calibration curve. 

 

 
[Calibration] Tab 
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The created calibration curve is displayed on the [CLS Calib. Report] tab. 
 

 
[CLS Calib. Report] Tab 
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10.3 Quantifying Unknown Samples 
 Measuring unknown sample spectra 

Unknown sample spectra must be measured and saved in advance using the Spectrum program. 
Perform these measurements in absorbance mode. 

 

 Loading and quantitative calculation of unknown sample spectra 

1. Click the [CLSAnalyze] tab. 

2. Click [Open] on the main toolbar and open the unknown sample spectrum. 

In this example, open the "REFL1.ispd" file located in the "\Data\Tutorial" folder. 
 

 
[CLSAnalyze] Tab 

 
The quantitative results are saved to the unknown sample spectrum and displayed as [CLS Result] in 
the tree view. 

 
 

[CLS Result] in the Tree View 

 



10.4 Principle of Multiple Regression Quantitation 
 

LabSolutions IR Basic Operation Manual  123 

Double-click on [CLS Result] in the tree view to display the quantitative results. The date and time in 
the table indicates when the results were calculated. 

 

 
[CLS Analyze Result] Window 

 

 

10.4 Principle of Multiple Regression Quantitation 
A quantitation method that utilizes the classical least-squares (CLS) method can be performed in 
LabSolutions IR. 

This quantitation method is referred to as the "K matrix method". 

 

The model formula below that follows Lambert-Beer's law is used in CLS. 

ECKA    ------ (1) 
 

A is a matrix that represents the sample spectrum and each row is comprised from the sample 
spectrum. 

C is a matrix that represents the concentration of each component and K is a matrix that represents 
the spectrum of each component. E is a residual error matrix. 

K is determined from A and C to minimize the norm of E, and this can be represented as lK  shown 

in 

ACCCK TT
l

1)(   ------ (2) 
 

CT represents the transposed matrix of C. 

Because spectra are used without modification in the CLS method, the accuracy of quantitation 
improves in the following cases compared to the multi-point calibration curve method, which uses 
the area of specific peaks. 

 When the absorbance spectra of multiple components overlap and distinguishing peaks cannot 
be found 

 When quantifying multiple components at the same time 

 

In LabSolutions IR, because this is a specialized function for the quantitation of multiple components 
relevant to the above stated characteristics, calibration curves cannot be created from only one 
component. 

When creating a calibration curve, an assumption of which components are contained in the 
unknown sample is required and a standard sample that contains these components at known 
concentrations must be prepared. 

Enter the known concentrations for all components per sample into the calibration curve table. 

 

The optional partial least-squares (PLS) method, which is an alternative to the CLS method, is also 
available in LabSolutions IR. 
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Chapter 11 Printing 
 

This chapter explains how to operate the print function and the function for creating report templates. 

Refer to the help file provided with the LabSolutions IR software for examples not included in this 
manual. 

Refer to the help file provided with LabSolutions IR for detailed explanations, tutorials, and other 
information regarding LabSolutions IR functions. 

 

 Explanations included in this chapter 
This chapter explains printing using a report template, printing using the ViewPrint function, and 
report template creation. 

The sample data used in explanations of operations is located in the installation folder of this 
software. 

For example, if the software is installed to "C:\Program Files", the sample files are copied to 
"C:\Program Files\LabSolutions\IR\Data". This path is abbreviated to "\Data" and "\Data\Tutorial" in 
the case of subfolders in this manual. 

  
If using the database version or client server version, use a project with a registered sample file that 
was created according to descriptions in the Installation and Maintenance Manual ("Sample_IR_JP" 
under default settings). 

 

 Operations that can be performed using this function 
Print data, print using ViewPrint, and create and edit report templates. 
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11.1 Printing Using Report Templates 
LabSolutions IR provides printing methods that use report templates and the ViewPrint function. This 
section explains how to print using a report template. 

 

11.1.1 Report Templates 
Report templates are templates for printing that are used to arrange LabSolutions IR data and 
information, such as data, scan parameters, peak pick results, search results, and quantitation 
tables, on a page that depicts a representation of the printed layout. 

LabSolutions IR provides a variety of report templates that simplify the printing of data. Users may 
also create and register custom report templates. 

A number of sample report templates are included with LabSolutions IR. 

The main report templates are listed in the table below. 

Report Template Name Description 

data_l.irtm Prints the active spectrum data and corresponding scan parameters on a 
single page. The page orientation is landscape. 

data_p.irtm Prints the active spectrum data and corresponding scan parameters on a 
single page. The page orientation is portrait. 

TC_data_l.irtm Prints the active Time course data and corresponding scan parameters on a 
single page. The page orientation is landscape. 

TC_data_p.irtm Prints the active Time course data and corresponding scan parameters on a 
single page. The page orientation is portrait. 

Map_data_l.irtm Prints the active mapping data and corresponding scan parameters on a 
single page. The page orientation is landscape. 

Map_data_p.irtm Prints the active mapping data and corresponding scan parameters on a 
single page. The page orientation is portrait. 

Data&PeakTable_l.irtm Prints the active spectrum data, corresponding scan parameters, and peak 
pick results on a single page. The page orientation is landscape. 

Data&PeakTable_p.irtm Prints the active spectrum data, corresponding scan parameters, and peak 
pick results on a single page. The page orientation is portrait. 

Spectral_Search_Result.irtm Prints the spectrum search results. The page orientation is portrait. 

Text_Search_Result.irtm Prints the text search results. The page orientation is portrait. 

StandardTable.irtm Prints the standard spectra and calibration curve created using the 
Quantitation program. 
The page orientation is portrait. 

UnknownSampleTable.irtm Prints the quantitative results of an unknown sample, the standard spectra, 
and the calibration curve created using the Quantitation program. The page 
orientation is portrait. 

QuantitationResult.irtm Prints the unknown sample spectrum and the quantitative results calculated 
using the Quantitation program. The page orientation is portrait. 

Photometric Table.irtm Prints the sample's photometric calculation results created using the 
Photometric program. The page orientation is portrait. 

Photometric Result.irtm Prints the sample spectrum and photometric calculation results calculated 
using the Photometric program. The page orientation is portrait. 

ChemometricsCalibration.irtm Prints the standard spectra and calibration curve created using chemometrics.
The page orientation is portrait. 

Film_Thickness.irtm Prints the spectrum and film thickness calculation results on a single page. 
The page orientation is portrait. 

Purity.irtm Prints the spectrum and purity calculation results on a single page. The page 
orientation is portrait. 
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Report templates are saved to the "\ReportTemplates" folder with the file extension ".irtm". 

Report templates can be registered in advance in the [Print Preference] window, which is displayed 
by clicking [Print Preferences] on the [Tool] menu. 

If no report templates are registered, see the above table in conjunction to "11.1.2 Printing Using 
Report Templates Registered to Windows", and set the required report templates in the [Print 
Preference] window. 

 

 

11.1.2 Printing Using Report Templates Registered to Windows 
The report template for use can be registered to each window, such as the graph, search, and 
chemometrics windows. 

Report template registration is performed in the [Print Preference] window, which is displayed by 
clicking [Print Preferences] on the [Tool] menu. 

The following settings are configured as standard. 

If no report templates are registered, set the required report templates in the [Print Preference] 
window. 

 

Program Printable Windows Report Template Name 

View data_p.irtm 

Search Spectral_Search_Result.irtm 

Chemometrics QuantitationResult.irtm 

Postrun program 

Unspecified data_p.irtm 

View data_p.irtm 

Search Spectral_Search_Result.irtm 

Spectrum program 

Unspecified data_p.irtm 

View TC_data_p.irtm 

Search Spectral_Search_Result.irtm 

Time course program 

Unspecified TC_data_p.irtm 

View Map_data_p.irtm 

Search Spectral_Search_Result.irtm 

Mapping program 

Unspecified Map_data_p.irtm 

Quantitation UnknownSampleTable.irtm Quantitation 

Unspecified UnknownSampleTable.irtm 

Photometrics PhotometricTable.irtm Photometrics 

Unspecified PhotometricTable.irtm 
 

For PDF Creation Report Template Name 

Spectrum PDF_Data1.irtm 

2D data PDF_Data1.irtm 

Line mapping data PDF_Data2.irtm 

Area mapping data PDF_Data2.irtm 

3D Time course data PDF_Data3.irtm 

Calibration curve file PDF_Calibration.irtm 

Quantitative data PDF_UNKTable.irtm 

Photometric data PDF_PhotometricTable.irtm 

Chemometric calibration curve PDF_ChemometricsCalibration.irtm 
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[Print Preference] Window 

 
 

The following example uses "data_l.irtm", which is registered as the standard report template, to 
demonstrate printing the contents of the "default.ispd" file measured in "Chapter 4 Spectrum" from 
the postrun program (or view window of the Spectrum program). 

1. A spectrum is created using spectrum measurement or manipulation. Display the spectrum for 
printing in the view window of the relevant measurement program or the postrun program. 

2. Preparation for printing is necessary when printing a zoomed spectrum or printing multiple 
spectra that are overlaid. Perform the following before printing. 

When multiple spectra are displayed in the data area, click the data tab and make the spectrum for 
printing active. 
If the data tab made active displays multiple spectra, all of these spectra are printed. 
In this example, make "default.ispd", measured in "Chapter 4 Spectrum", active. 

3. Click [Print Preview] on the main toolbar or [Print Preview] on the [File] menu. 

A preview of printer output is displayed. 

4. Click [Print] in the print preview window. 

The [Print] window is displayed. 

5. Check settings such as the configured printer and number of copies, and then print. 

Click [Print Preview] on the main toolbar or [Print] on the [File] menu if a preview of printer output 
does not need to be checked. 
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11.1.3 Printing Using a Specified Report Template 
Report templates can be specified for printing if the required report template is not registered to the 
relevant window. 

The following example uses a different report template to print the contents of the "default.ispd" file 
measured in "Chapter 4 Spectrum" from the postrun program (or view window of the Spectrum 
program). 

1. A spectrum is created using spectrum measurement or manipulation. Display the spectrum for 
printing in the view window of the relevant measurement program or the postrun program. 

2. Preparation for printing is necessary when printing a zoomed spectrum or printing multiple 
spectra that are overlaid. Perform the following before printing. 

When multiple spectra are displayed in the data area, click the data tab and make the spectrum for 
printing active. 
If the data tab made active displays multiple spectra, all of these spectra are printed. 
In this example, make "default.ispd", measured in "Chapter 4 Spectrum", active. 

3. Click [Print with Template] on the [File] menu. 

The [File Open] dialog box is displayed. 

4. Select the report template to use and click [Open]. 

The [Print Setup] window is displayed. 

5. Check settings such as the configured printer and number of copies, and then print. 

 

 

 Printing after checking using print preview 

1. A spectrum is created using spectrum measurement or manipulation. Display the spectrum for 
printing in the view window of the relevant measurement program or the postrun program. 

2. Preparation for printing is necessary when printing a zoomed spectrum or printing multiple 
spectra that are overlaid. Perform the following before printing. 

When multiple spectra are displayed in the data area, click the data tab and make the spectrum for 
printing active. 
If the data tab made active displays multiple spectra, all of these spectra are printed. 
In this example, make "default.ispd", measured in "Chapter 4 Spectrum", active. 

3. Click [Edit Printform] on the main toolbar. 

The [Edit Printform] window is displayed. 

4. Click [Open] on the [File] menu. 

The [Open] dialog box is displayed. 

5. Select the report template to use and click [OK]. 

The selected report template is displayed. 
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6. Click [Print Preview] on the main toolbar or [Print Preview] on the [File] menu. 

A preview of printer output is displayed. 

7. Click [Print] in the print preview window. 

The [Print Setup] window is displayed. 

8. Check settings such as the configured printer and number of copies, and then print. 
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11.2 Printing Using the ViewPrint Function 
LabSolutions IR provides printing methods that use report templates and the ViewPrint function. This 
section explains printing using ViewPrint function. 

 

11.2.1 ViewPrint Function 
The ViewPrint function is used to arrange data in LabSolutions IR and print using a layout that 
closely depicts the on-screen representation. 

This function simplifies printing and eliminates the need for report template creation. 

 

11.2.2 Printable Items Using the ViewPrint Function 
The ViewPrint function can print the following information in addition to data. 

The items for printing can be set in the [Viewprint Setting] window, which is displayed by clicking 
[Viewprint Setup] on the [File] menu. 

If the [Open the Setting dialog box when run ViewPrint or ViewPrint Preview.] checkbox is selected 
in the [Print Preference] window, items can be set every time [Viewprint] or [Viewprint Preview] is 
selected. 

Item Description 

[Title] Set the title of the report to be printed. 

[Data] Print scan parameters. 

 [Acquired Date&Time] Print the date and time of the measured data or the creation date and time 
of the data. 

 [Acquired by] Print the name of the analyst. 

 [Filename] Print the filename. 

 [Spectrum name] Print the spectrum name. 

 [Sample name] Print the sample name. 

 [Sample ID] Print the sample ID. 

 [Comment] Print any comments. 

 [Option] Print sample information set for [Option]. 

 [No. of Scans] Print the number of scans. 

 [Resolution] Print the resolution. 

 [Apodization] Print the apodization function. 

[Others] Print information related to pages and the date and time of printing. 

 [Page No.] Print page numbers. 

 [Total page] Print the total number of pages. 

 [Printed Date&Time] Print the date and time of printing. 
 

Click [Page settings] to change the paper size and orientation. 

Item Description 

[Paper] Set the page size and other relevant settings. 
Select a size from A4, A3, and letter. 
Select landscape orientation when data will not fit into portrait orientation. 

[Orientation] Select portrait or landscape for the page orientation. 

[Margins] Set the size of the margin. 
The pink or blue color on the report is the margin area. 
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11.2.3 Printing Using the ViewPrint Function 

 Printing multiple data 
The following example demonstrates opening "QUANT1.ispd" through "QUANT4.ispd" located in the 
"\Data\Tutorial" folder using the postrun program, tiling the display in a 2  2 configuration, and 
printing the displayed report of single spectra for each spectrum file. 

1. Click [Open] on the [File] menu and open "QUANT1.ispd" through "QUANT4.ispd", which are 
located in the "\Data\Tutorial" folder. 

2. Tile the display of data. 

1. Click [Join All] on the [Window] menu. 
The data is overlaid. 

2. Click [Overview] on the [Window] menu. 
The full display of data is closed. 

3. Click [Style in Tab] - [Tile] on the [Window] menu. 

The data is displayed tiled in a 2  2 configuration. 
 

 
Tile Display 

3. Click [Print Preferences] on the [Tool] menu. 

The [Print Preference] window is displayed. 

4. If the [Open the Setting dialog box when run ViewPrint or ViewPrint Preview.] checkbox is 
selected, click [Viewprint] or [Viewprint Preview] on the main toolbar or on the [File] menu. 

The [Viewprint Setting] window is displayed. 



11.2 Printing Using the ViewPrint Function 
 

LabSolutions IR Basic Operation Manual  133 

5. Select the checkbox of each item to print. 

Select the [Comment] checkbox in this example. 
 

 
[Viewprint Setting] Window 

6. Click [OK]. 

A report that includes comments is printed. 
 

 
Example of Printout 
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 Printing data and peak pick results 
The following example demonstrates how to perform peak pick on the data in "default.ispd", which 
was measured in "Chapter 4 Spectrum", and print the data and peak pick results. 

1. Click [Open] on the [File] menu and open the "default.ispd" file. 

2. Click [Peak Pick] in the manipulation button list. 

If the peak pick results are not displayed, click [Manipulation Result] on the [View] menu. 

3. Select the peak information to display and print. 

1. Open the right-click menu on the graph and click [Graph Preferences]. 
The [2D Graphic Preferences] window is displayed. 

2. Click the [Style] tab. 
 

 
[2D Graphic Preferences] Window 

3. Select the checkboxes under [Label] that correspond to the peak information to print. 
Select the [X axis value] checkbox in this example. 
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4. Adjust the display range if the peak pick results run off the edges of the data area or you wish 
to zoom a specific range for printing. 

 
Before Printing 

5. Click [Print Preferences] on the [Tool] menu. 

The [Print Preference] window is displayed. 

6. If the [Open the Setting dialog box when run ViewPrint or ViewPrint Preview.] checkbox is 
selected, click [Viewprint] or [Viewprint Preview] on the main toolbar or on the [File] menu. 

The [Viewprint Setting] window is displayed. 
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7. Select the checkbox of each item to print. 

Select the [Comment], [No. of Scans], [Resolution], and [Apodization] checkboxes in this example. 
 

 
[Viewprint Setting] Window 

8. Click [OK]. 

A report that includes [Comment], [No. of Scans], [Resolution], and [Apodization] is printed. 
 

 
Example of Printout 
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11.3 Creating Report Templates 
This section explains how to create report templates. 

 

Create the report layout in the [Edit Printform] window when creating a new report template. 

Prepare the data for printing before creating a report template. 

When printing peak pick tables or search results, preparing a peak pick table or search results for 
test purposes in advance can be convenient when creating a layout. 

In addition to spectra, LabSolutions IR allows printing of a variety of information that includes all (or 
some) of the contents of peak pick tables as well as scan parameters, search results, quantitative 
results, text files, and image data. 

Create a report template by arranging each type of information for printing in the report window of 
the [Edit Printform] window. 

The remainder of this section demonstrates how to create several actual layouts for printing. 
Prepare the required spectra in advance. 

 
Example of a Layout for Printing 
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11.3.1 Creating a Layout Containing Active Data and Specified Scan 
Conditions (Date, Time, No. of Scans, Resolution) 
The following example demonstrates how to create a layout for printing by arranging the active data 
displayed in the postrun program (or view window of the Spectrum program) and some scan 
parameters of the corresponding spectrum (comments, date, time, number of scans, and resolution) 
on a page in the portrait orientation. 

In this example, use "default.ispd" that was measured in "Chapter 4 Spectrum". 

1. Display the "default.ispd" file in the postrun program (or view window of the Spectrum 
program) and make it active. 

2. Click [Edit Printform] on the main toolbar. 

The [Edit Printform] window is displayed. 

3. Click [New] on the [File] menu to create a new report template. 

4. Open the right-click menu on the layout window and click [Page Setup]. 

The [Page Setup] window is displayed. 

5. Set the printing orientation and margin and click [OK]. 

In this example, set the printing orientation to [Portrait] and all margins to "10 mm". 

6. Click  (header and footer size). 

The [Header Footer Configuration] window is displayed. 

7. Enter the size of the header and footer and click [OK]. 

Set both the header and footer to "10 mm" in this example. 

8. Click [+] to the left of [View] in the item window. 

A submenu that contains [Graph], [Peak Pick Table], and [Scan Parameter] is displayed. Each item 
indicates the following information. 

 

 
Printable Information 
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Item Description 

[Graph] Arrange the data displayed in the postrun program or the view window of 
the relevant measurement program. 

[Splitter Graph] Arrange the data displayed in split view, which is enabled by selecting 
[Split View] on the [Window] menu. 

[Peak Pick Table] Arrange the peak pick results of the displayed data. 

[Point Pick Table] Arrange the Point pick results of the displayed data. 

[PauseRecord] Arrange recordings that were paused during Time course measurement. 

[Scan Parameter] Arrange all (or some) scan parameters of the displayed spectrum data. 

[Timecourse Parameter] Arrange all measurement parameters of the displayed Time course data. 

[Mapping Parameter] Arrange all measurement parameters of the displayed mapping data. 

[Bitmap] Print the visible image obtained in microscope measurement or mapping 
measurement. 

 

9. Arrange the various information for printing. 

Graph layout 

Arrange graphs on the layout in the following manner. 

1. Drag and drop [Graph] onto the report window. 
A rectangular layout frame is displayed. 

2. Use the mouse to adjust the layout frame to the appropriate size. 
The layout frame corresponds to the area of the graph to be printed. 

 

Changing position and size 

The position and size of items in the report window can be changed. 
 Move the mouse cursor over a  mark around the frame to display an up/down, left/right, or 

diagonal arrow depending on the location of the mark on the frame. Drag while this arrow is 
displayed to change the size of the layout frame. 

 Move the mouse cursor inside the frame to display crossed arrows. 
Drag while this arrow is displayed to change the position of the layout frame. 

 

 
Changing the Position and Size of Layout Frames 

 

 If the pitch is set, the position and size of the layout frame can be adjusted according to the pitch. 
The pitch settings can be configured by opening the right-click menu on the layout window and 
clicking [Pitch Setup]. 

 Use the property window to specify the position or size numerically. 
Select a layout frame to display its corresponding information in the property window.  
Enter values for position (x, y), width, and height.  
Leave the other items at their default settings. 
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Property Window 

 

Scan parameter layout 

Arrange scan parameters, including comments, number of scans, and resolution. 

1. Drag and drop [Scan Parameter] onto the report window and adjust its position and size. 

2. Click [...] to the right of [Scan Parameter] in the property window. 
The [Settings for printed items of scan parameters] window is displayed. 

3. Click [+] to the left of [Main]. 
The sub-items are displayed. 

4. Select the [Comment], [No. of Scans], and [Resolution] checkboxes. 

5. Click [OK]. 

 
[Settings for printed items of scan parameters] Window 
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Date and time layout 

1. Click [+] to the left of [Property] in the item window. 

2. Click [+] to the left of [IR spectrum]. 

3. Drag and drop [Aquired Date & Time] onto the report window and adjust its position and size. 

4. Open the right-click menu on the layout window and click [Edit Mode]. 

5. Move the cursor to the start of the row and enter "Acquired Date & Time;". 

 
Report Template (Example of Layout) 

10. Click [Save] or [Save As] on the [File] menu. 

The report template is saved. 

11. Click [Print Preview] on the main toolbar or the [File] menu. 

A preview of printer output is displayed. This can be used to check the format before printing. 

12. Click [Print] in the print preview window. 

The [Print Setup] window is displayed. 

13. Check settings such as the configured printer and number of copies and then print. 

  
By registering the report template saved above to [View] in the [Print Preference] window, which 
is accessible from the [Tool] menu, the report template can be used for printing by clicking 
[Print] on the main toolbar or [File] menu, or the report template can be checked in the preview 
window by clicking [Print Preview]. 
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11.3.2 Printing Two Sets of Data and Text (Comments) 
The following example demonstrates how to create a layout for printing that contains the two spectra 
displayed in the postrun program as well as comments for each spectrum, all arranged on a page in 
the portrait orientation. 

 
Example of a Layout for Printing 

1. Display the "toluene.ispd" and "xylene.ispd" files in the postrun program (or view window of 
the Spectrum program) and make them active. 

2. Click [Edit Printform] on the main toolbar. 

The [Edit Printform] window is displayed. 

3. Click [New] on the [File] menu to create a new report template. 

4. Open the right-click menu on the layout window and click [Page Setup]. 

The [Page Setup] window is displayed. 

5. Set the printing orientation and margin and click [OK]. 

In this example, set the printing orientation to [Portrait] and all margins to "10 mm". 

6. Click  (header and footer size). 

The [Header Footer Configuration] window is displayed. 
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7. Enter the size of the header and footer and click [OK]. 

Set both the header and footer to "10 mm" in this example. 

8. Click [+] to the left of [View] in the item window. 

A submenu that contains [Graph], [Peak Pick Table], and [Scan Parameter] is displayed. Each item 
indicates the following information. 

 

 
Printable Information 

 
Item Description 

[Graph] Arrange the data displayed in the postrun program or the view window of 
the relevant measurement program. 

[Splitter Graph] Arrange the data displayed in split view, which is enabled by selecting 
[Split View] on the [Window] menu. 

[Peak Pick Table] Arrange the peak pick results of the displayed data. 

[Point Pick Table] Arrange the Point pick results of the displayed data. 

[PauseRecord] Arrange recordings that were paused during Time course measurement. 

[Scan Parameter] Arrange all (or some) scan parameters of the displayed spectrum data. 

[Timecourse Parameter] Arrange all measurement parameters of the displayed Time course data. 

[Mapping Parameter] Arrange all measurement parameters of the displayed mapping data. 

[Bitmap] Print the visible image obtained in microscope measurement or mapping 
measurement. 

 
The remainder of this example demonstrates how to print the active data displayed in the postrun 
program or the view window of the Spectrum program. 
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9. Arrange the various information for printing. 

Graph layout 

Arrange graphs on the layout in the following manner. 

1. Drag and drop [Graph] onto the report window. 
A rectangular layout frame is displayed. 

2. Use the mouse to adjust the layout frame to the appropriate size. 
The layout frame corresponds to the area of the graph to be printed. 

 

Changing position and size 

The position and size of items in the report window can be changed. 
 Move the mouse cursor over a  mark around the frame to display an up/down, left/right, or 

diagonal arrow depending on the location of the mark on the frame. Drag while this arrow is 
displayed to change the size of the layout frame. 

 Move the mouse cursor inside the frame to display crossed arrows. 
Drag while this arrow is displayed to change the position of the layout frame. 

 

 
Changing the Position and Size of Layout Frames 

 
 If the pitch is set, the position and size of the layout frame can be adjusted according to the pitch. 

The pitch settings can be configured by opening the right-click menu on the layout window and 
clicking [Pitch Setup]. 

 Use the property window to specify the position or size numerically. 
Select a layout frame to display its corresponding information in the property window.  
Enter values for position (x, y), width, and height.  
Leave the other items at their default settings. 

 

 
Property Window 
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Scan parameter layout 

Arrange the scan parameter comments. 

1. Drag and drop [Scan Parameter] onto the report window and adjust its position and size. 

2. Click [...] to the right of [Scan Parameter] in the property window. 
The [Settings for printed items of scan parameters] window is displayed. 

3. Click [+] to the left of [Main]. 
The sub-items are displayed. 

4. Select the [Comment] checkbox. 

5. Click [OK]. 

 
[Settings for printed items of scan parameters] Window 

 

Selecting spectra to print 

The spectra for printing must be specified when multiple spectra are displayed in the view window. 
Set the spectra for printing using the property window in the following manner. 

1. Drag and drop [Graph] onto the report window. 

2. Click the frame of the item to make it active. 

3. Select [Tab by Index] for [Data Source] in the property window. 

4. Enter the number of the data tab to print into the field next to [Index]. 
The number for [Index] should be specified according to the order of the data tabs in the view window, 
as shown below. 

 

 
 

 

View Window Data Tabs and Index Numbers 

 
In this example, set the index of the item to print for [TOLUENE] to "2" and the index of the item to 
print for [XYLENE] to "3". 
 

(1) (2) (3) 
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Report Template (Example of Layout) 

10. Click [Save] or [Save As] on the [File] menu. 

The report template is saved. 

11. Click [Print Preview] on the main toolbar or the [File] menu. 

A preview of printer output is displayed. This can be used to check the format before printing. 

12. Click [Print] in the print preview window. 

The [Print Setup] window is displayed. 

13. Check settings such as the configured printer and number of copies and then print. 

  
By registering the report template saved above to [View] in the [Print Preference] window, which 
is accessible from the [Tool] menu, the report template can be used for printing by clicking 
[Print] on the main toolbar or [File] menu, or the report template can be checked in the preview 
window by clicking [Print Preview]. 
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11.3.3 Printing Search Results 
The following example demonstrates how to create a layout for printing the unknown sample 
spectrum displayed in the search window, spectra in the search results, the hit list, and detailed 
information regarding search results on a page in the portrait orientation. 

 
Example of a Layout for Printing 

1. In the search window, search the [IRs Polymer2] library for [Polystyrene1.ispd], which is 
located in the "\Data" folder. 

2. Click [Edit Printform] on the main toolbar. 

The [Edit Printform] window is displayed. 

3. Click [New] on the [File] menu to create a new report template. 

4. Open the right-click menu on the layout window and click [Page Setup]. 

The [Page Setup] window is displayed. 
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5. Set the printing orientation and margin and click [OK]. 

In this example, set the printing orientation to [Portrait] and all margins to "10 mm". 

6. Click  (header and footer size). 

The [Header Footer Configuration] window is displayed. 

7. Enter the size of the header and footer and click [OK]. 

Set both the header and footer to "10 mm" in this example. 

8. Click [+] to the left of [Spectrum/Peak Search Results] in the item window. 

A submenu that contains [Hit Graph], [Hitlist], [Details], and [Parameter] is displayed. 
Each item indicates the following information. 

 

 
Printable Information 

 
Item Description 

[Hit Graph] Print a spectrum found in the spectrum search or peak search. 
The displayed spectrum hit or spectrum at a specified rank (hit number) 
can be printed. 

[Hitlist] Print the hit list from spectrum search or peak search. 

[Details] Print detailed information regarding the spectrum hit in the spectrum 
search or peak search. 
The displayed spectrum hit or information at a specified rank (hit number) 
can be printed. 

[Parameter] Print the search parameters used in spectrum search or peak search. 
 
The remainder of this example demonstrates how to print the unknown sample displayed in the search 
window and the displayed spectrum hit. 
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9. Arrange the various information for printing. 

Spectrum hit layout 

Arrange the spectrum hit on the layout. 

1. Drag and drop [Hit Graph] onto the report window. 
A rectangular layout frame is displayed. 

2. Use the mouse to adjust the layout frame to the appropriate size. 
The layout frame corresponds to the area of the spectrum that will be printed. 

 

Changing position and size 

The position and size of items in the report window can be changed. 
 Move the mouse cursor over a  mark around the frame to display an up/down, left/right, or 

diagonal arrow depending on the location of the mark on the frame. Drag while this arrow is 
displayed to change the size of the layout frame. 

 Move the mouse cursor inside the frame to display crossed arrows. 
Drag while this arrow is displayed to change the position of the layout frame. 

 

 
Changing the Position and Size of Layout Frames 

 
 If the pitch is set, the position and size of the layout frame can be adjusted according to the pitch. 

The pitch settings can be configured by opening the right-click menu on the layout window and 
clicking [Pitch Setup]. 

 Use the property window to specify the position or size numerically.  
Select a layout frame to display its corresponding information in the property window.  
Enter values for position (x, y), width, and height.  
Leave the other items at their default settings. 

 

 
Property Window 
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Print settings for searched spectra 

Set [Show searched spectrum] to [On] in the property window to print the spectrum hit in addition to 
the unknown spectrum targeted in searching. 
Display both spectra in vertical layout by setting [Spectra Layout] to [Vertical] in the property window. 
 

Detailed information on the spectrum hit 

1. Drag and drop [Details] onto the report window and adjust its position and size. 

2. Specify the spectrum hit for printing. 
The spectrum hit for printing can be changed using [Hit to show] in the property window. 
Select [Auto] to print the spectrum hit displayed in the search window. 
Enter the rank to print a spectrum hit at a specific rank in the hit list. 
Select [Auto] in this example. 

3. Specify the information for printing. 
Specify the information for printing under [Hitlist] in the property window. 

 

Item Description 

[Hit No.] Print the rank of the hit. 

[Score] Print the score. 

[Library] Print the library name. 

[Name] Print the name of the spectrum in the library. 

[Comment] Print the comment corresponding to the spectrum in the 
library. 

[Sadtler Information] Print detailed information from the Sadtler library. 

[Aldrich/Hummel Information] Print detailed information from the Aldrich/Hummel libraries.
 

 
Property Window 
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Hit list layout 

Arrange the hit list on the layout in the following manner. 

1. Drag and drop [Hitlist] onto the report window. 
A rectangular layout frame is displayed. 

2. Use the mouse to adjust the layout frame to the appropriate size. 
The layout frame corresponds to the area of the hit list that will be printed. 

 

 
Report Template (Example of Layout) 

10. Click [Save] or [Save As] on the [File] menu. 

The report template is saved. 

11. Click [Print Preview] on the main toolbar or the [File] menu. 

A preview of printer output is displayed. This can be used to check the format before printing. 

12. Click [Print] in the print preview window. 

The [Print Setup] window is displayed. 

13. Check settings such as the configured printer and number of copies and then print. 

  
By registering the report template saved above to [View] in the [Print Preference] window, which 
is accessible from the [Tool] menu, the report template can be used for printing by clicking 
[Print] on the main toolbar or [File] menu, or the report template can be checked in the preview 
window by clicking [Print Preview]. 
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Chapter 12 Easy Macro Program 
 

This chapter explains the macro creation and execution functions of the easy macro program. 

Refer to the help file provided with the LabSolutions IR software for examples not included in this 
manual. 

Refer to the help file provided with LabSolutions IR for detailed explanations, tutorials, and other 
information regarding LabSolutions IR functions. 

 

 Explanations included in this chapter 
This chapter explains the function for creating easy macro programs and the execution method. 

 

 Operations that can be performed using this function 
Create, edit, and execute macros using the easy macro program. 

 

  
The following restrictions apply when using the easy macro program with the database and client 
server editions of LabSolutions IR. 

 It is impossible to save a spectrum file which was loaded by using a macro item. When you use 
a spectrum file as an object of Data Processing, please import it into a database beforehand. 

 Filessaved in the database cannot be loaded. Macro programs can be executed to perform data 
processing after loading the target data from the database in advance. 

 Copy the reference spectrum file used in manipulation and the calibration curve file used in 
chemometric quantitation to a local folder on the PC in advance using the database manager. 

 Only filenames are used in spectrum measurement and the path and folder name are ignored. 
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12.1 Easy Macro Program 
The easy macro program in LabSolutions IR allows users to create macro programs by arranging 
sequences of operations in order, beginning with LabSolutions IR startup. 

Created macro programs can be registered to and executed from the launcher, main toolbar, and 
Windows desktop. 

The procedures that can be converted into macro programs are spectrum measurement and 
manipulation functions. 

 

12.2 Startup 
Click [Easy Macro] in the LabSolutions IR launcher to start the easy macro program. 

 

12.2.1 Easy Macro Program Editing Window Layout 

 
Easy Macro Program Editor Window 

 

The easy macro program editor window is divided into the following four parts. 

No. Name Description 

1 Toolbar Displays the buttons for saving, loading, checking syntax, and 
executing easy macro programs. 

2 Macro item list Displays a list of procedures that can be registered to macro 
programs. 
Select the desired macro item and drag and drop it into the macro 
sequence editing window. 

3 Description Displays an explanation of the selected macro item. 

4 Macro sequence editing 
window 

Displays the created macro program. 
The user can copy, paste, and change the order of procedures. 

1

4

2 

3 
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12.3 Creating Easy Macro Programs 
12.3.1 Example of Creating an Easy Macro Program 

The example provided in this section demonstrates how to create an easy macro program that 
performs the following operations. 

LabSolutions IR spectrum program startup 

 

FTIR initialization 

 

Setting scan parameter 

 

Display message to prompt the user to set the background measurement sample 

 

Background (BKG) scan 

 

Close the file (Background) 

 

Display message to prompt the user to set the sample 

 

Sample scan 

 

Spectrum search 

 

Saving of the spectrum 

 

Printing 

 

Macro complete message 

 

Exit 

1. Select [New] from [File] on the toolbar. 

This clears the macro sequence editing window. 

2. Drag and drop [Program] - [Program Start] from the macro item list into the macro sequence 
editing window and select [Spectrum] from [Program Name]. 

3. Drag and drop [Measurement] - [Initialize] from the macro item list into the macro sequence 
editing window. 
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4. Drag and drop [Measurement] - [Scan parameters (Main)] from the macro item list into the 
macro sequence editing window and set the main measurement conditions. 

In this example, configure the following settings. 
 

Parameter Setting 

[Mode] Transmittance (%T) 

[Resolution] 4 cm-1 

[No. of scans] 10 

[Max/Min] 400-4000 cm-1 

[Apodization] Happ-Genzel 

[Detector] Standard 

[Mirror speed] 2.8 mm/sec 

[Beam] Internal 

5. Drag and drop [Control statement] - [Message] from the macro item list into the macro 
sequence editing window and set the message display conditions. 

1. Enter the text "Set the background sample." into [Message]. 

2. Enter "0" for [Display time (s)]. 
Entering a value of "0" will display the message until the user clicks [OK] before proceeding to the next 
step in the macro. 

6. Drag and drop [Measurement] - [BKG scan] from the macro item list into the macro sequence 
editing window. 

7. Drag and drop [File] - [Close] from the macro item list into the macro sequence editing 
window. 

Here, [Close] item is inserted to avoid searching and printing the Background data. 

  
[Search], [Manipulations], [Chemometrics Quantitation]，and [Print] items are applied to all of the 
spectra on memories. 

8. Drag and drop [Control statement] - [Message] from the macro item list into the macro 
sequence editing window and set the message display conditions. 

1. Enter the text "Set the sample." into [Message]. 

2. Enter "0" for [Dysplay time (s)]. 
Entering a value of "0" will display the message until the user clicks [OK] before proceeding to the next 
step in the macro. 

9. Drag and drop [Measurement] - [Sample scan] from the macro item list into the macro 
sequence editing window. 

10. Drag and drop [Search] - [Spectrum search] from the macro item list into the macro sequence 
editing window and set the spectrum search parameter filename. 

Set "\Program Files\LabSolutions\IR\Parameters\standard.isrp" (when the installation folder is 
"C:\Program Files") for [Search parameter filename]. 
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11. Drag and drop [File] - [Save] from the macro item list into the macro sequence editing window. 

12. Drag and drop [File] - [Print] from the macro item list into the macro sequence editing window 
and set the file of the report template into [Report template filename]. 
Set the "//Search_Result.irtm//" file located in the "C:\Program Files\LabSolutions\IR\Data" 
folder (when the installation folder is "C:\Program Files"). 

13. Drag and drop [Control statement] - [Message] from the macro item list into the macro 
sequence editing window and set the message display conditions. 

1. Enter the text "Processing complete!" into [Message]. 

2. Enter "0" for [Time (sec)]. 
Entering a value of "0" will display the message until the user clicks [OK] before proceeding to the next 
step in the macro. 

14. Drag and drop [Program] - [Program End] from the macro item list into the macro sequence 
editing window. 

 

 

12.3.2 Checking Easy Macro Programs 
Click [Check] on the toolbar. 

Any errors encountered in the created macro sequence during the check are displayed. 

 

 

12.3.3 Saving Easy Macro Programs 
The created macro sequence can be saved to file. 

1. Select [Save As] from [File] on the toolbar. 

The [Save As] dialog box is displayed. 

2. Save the created macro sequence. 

In this example, save the macro sequence with the filename "measure-search-print.iscq". 
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12.4 Editing Easy Macro Programs 
This section describes how to edit macro sequence programs. 

Once editing is complete, click [Check] on the toolbar to confirm that the changes to the macro 
sequence are valid. 

 

12.4.1 Loading the Easy Macro Program 

1. Select [Open] from [File] on the toolbar. 

2. Open the saved easy macro program. 

 

12.4.2 Inserting Macro Items 

1. Select the macro item for insertion from the macro item list. 

2. Drag and drop the macro item onto the macro sequence editing window at the desired 
insertion position. 

The macro item is inserted at the position of the triangular mark. 
 

12.4.3 Copying and Pasting Macro Items 

1. Click the title of the macro item to copy. 

The title is displayed in red. 

2. Select [Copy] from [Edit] on the toolbar. 

3. Click the macro item directly preceding the position for pasting. 

4. Select [Paste] from [Edit] on the toolbar. 

The macro item is pasted to the specified position. 
 

12.4.4 Moving Macro Items 

1. Click the title of the macro item to move. 

The title is displayed in red. 

2. Drag the title to move the macro item and release the left mouse button at the position for 
insertion. 

The macro item is inserted at the position of the triangular mark. 
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12.4.5 Deleting Macro Items 

1. Click the title of the macro item to delete. 

The title is displayed in red. 

2. Select [Delete] from [Edit] on the toolbar. 

 

 

12.5 Executing Easy Macro Programs 
Easy macro programs can be registered to and executed from any of the following locations. 

 

 Easy macro program editing window 
Click [Run] in the easy macro program editing window to execute the macro program. 

 

 Launcher 
Macro programs can be registered to a launcher button on the [Macro] tab. 

 

 Main toolbar 
Macro programs can be registered to an easy macro button on the main toolbar in the program or 
postrun program. 

 

 Window desktop 
Create a copy (or shortcut) of the easy macro program file on the Window desktop and double-click 
it to execute the macro program. 
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12.5.1 Executing an Easy Macro Program 
Execute a registered easy macro program. 

1. Click the registered button on the launcher or main toolbar, or double-click on the icon on the 
Window desktop. 

The [Macro Execute] window is displayed. 
 

 
[Macro Execute] Window 

 
Name Description 

[Close] Closes [Macro Execute] window. 
If the [Macro Execute] window was opened from the easy macro program 
editing window, clicking this button returns to the easy macro program 
editing window. 
If the [Macro Execute] window was opened from the launcher, clicking this 
button just closes the [Macro Execute] window. 

[Stop] Stop the execution of the easy macro program. Macro programs cannot be 
resumed. 

[Run] Execute the easy macro program. 

[Pause] Pause execution of the easy macro program. Macro programs can be 
resumed from the paused state. 

2. Click [run]. 

The easy macro program is executed. 
 
 



12.6 Important Notes Regarding Easy Macro Program Creation 
 

LabSolutions IR Basic Operation Manual  161 

12.6 Important Notes Regarding Easy Macro Program 
Creation 
Be aware of the following points when creating easy macro programs. 

 

12.6.1 Program Startup and Exit 
Always start macro sequences with [Program Start] and end sequences with [Program End] when 
the easy macro program is to be executed directly from the easy macro program editing window, 
launcher, or Windows desktop. 

[Program start] and [Program End] are not required when the easy macro program is to be executed 
from the main toolbar in the Spectrum program or postrun program. Execute the macro program in 
the context of the program to which it is registered. 

 

12.6.2 Filename Specification Method 
Filenames must be specified when registering [Sample scan], [Open], or [Save As] from the macro 
item list into the macro sequence. 

If, however, you wish specify the filename by selecting or entering it at the time of execution instead 
of during macro sequence creation, select the [Open a prompt before execution] checkbox. 

Executing a macro sequence in this state will display a [Prompt] window when the corresponding 
item is reached, which allows the user to select or enter a filename. 

 
[Prompt] Window for [Open] 

 

12.6.3 Scan Parameters 
When a macro program with scan parameters runs, scan parameters are changed for it. When the 
LabSolutions IR is activated as a user without a right of "Edit scan parameters", scan parameters 
are changed for the macro program with scan parameters. Memorizing or saving scan parameters 
before running the macro program is recommended. 

When a user without a right of "Edit scan parameters" uses a Measurement program after executing 
such macro program, he loads a scan parameter file which was saved by Administrator. 
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12.6.4 Requirements and Restrictions 

 Requirements regarding combinations of macro items 

Item Requirement/Restriction 

[Program start] 
[Program End] 

 [Program Start] must always be paired with [Program End]. 

 Even when starting the easy macro program from the Spectrum program or 
postrun program, a new program is started if the [Program start] item is present 
in order to execute the macro sequence. 

[Start of repeat] 
[End of repeat] 

Always enter [Start of repeat] before [End of repeat]. 
Make sure that [Start of repeat] is paired with [End of repeat]. 
When using nested loops, make sure that [Start of repeat] and [End of repeat] do 
not straddle other loops. 
Example: 
Good: Start of repeat 1 - (Start of repeat 2 - End of repeat 2) - End of repeat 1
Bad: Start of repeat 1 - Start of repeat 2 - End of repeat 1 - End of repeat 2 

[Chemometrics 
quantitation] 

When using [Chemometrics quantitation], specify to execute the postrun program 
in [Program Start]. An error will occur if spectrum measurement is specified for 
execution. 

 

 Requirements and restrictions regarding macro item and file combinations 

Item Requirement/Restriction 

Data files An error occurs if the target data is not present prior to the execution of 
manipulation, printing, saving, or chemometric quantitation. 
Example of the displayed error message: 
 xMacroRunThis1*#17: id& = GetContainerId&(GetActiveObject)  (10090) 

(10090) OLE automation error’ parameter is incorrect. 

 xMacroRunThis1*#143: For c = Lbound&(lst&) To UBound&(lst&) (10023) 
(10023) Array index outside valid range. 

Saving  Because the purpose of easy macro programs is to automate execution, saving 
by overwriting is performed when the [Prohibit overwriting of other data files] 
checkbox is selected in the [Security Policy Settings] window in LabSolutions. 

 If the [Overwrite the data file at the same time adding the IR data set] checkbox 
is selected in the [Security Policy Settings] window in LabSolutions, data is not 
saved when manipulation is performed in the easy macro program. 

If saving is required, always insert the [Save] item or [SaveAs] item into the 
sequence and save the macro program. 

Manipulation  Errors do not occur during creation of the macro sequence if parameters that 
cannot be calculated for a manipulation item are entered. 

Errors will occur at the time of macro sequence execution. 
 When executing manipulation using an easy macro program, spectrum names 

may be different to when the same operations were performed manually. 

 

 Requirements and restrictions regarding macro program exit 

Item Requirement/Restriction 

[Program End] When [Program End] is executed, a [Exit] window is displayed if unsaved data is 
present in LabSolutions IR. 
The easy macro program does not exit while the [Exit] window is displayed. Click 
[Yes] or [No] in the [Exit] window to exit LabSolutions IR and close the [Scan 
-Macro Execute] window. 
Always insert a [Save] item or [SaveAs] item into the sequence before the 
[Program End] item to ensure that data is saved. 
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Chapter 13 Shutting Down the System 
 

13.1 Turning the Power OFF 
 

13.1.1 For IRTracer-100 
Use the following procedure to turn OFF power to the IRTracer-100. 

1. Confirm that all necessary data in the LabSolutions IR software has been saved. 

2. Close the [LabSolutions Main] window, launcher, [LabSolutions IR] postrun program, and any 
measurement programs. 

3. Turn OFF power to Shut down the PC. 

4. Confirm that the disk access indicators for the hard disk and floppy disk drives are inactive 
before turning OFF power to the PC. 

5. Turn OFF the activationmain switch at the lower right on the front of the IRTracer-100. 

The green power indicator will turn off. 
Keep the power supply cable connected to the IRTracer-100 to allow the internal dehumidifier to run. 

 

  
Do not turn off the power or press the reset switch on the PC while Windows is running. This 
may subsequently prevent Windows from running properly. 
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13.1.2 For IRPrestige-21 
Use the following procedure to turn OFF power to the IRPrestige-21. 

1. Confirm that all necessary data in the LabSolutions IR software has been saved. 

2. Close the [LabSolutions Main] window, launcher, [LabSolutions IR] postrun program, and any 
measurement programs. 

3. Shut down the PC. 

4. Turn OFF the activation switch at the lower right on the front of the IRPrestige-21. 

The green lamp will turn off. 
Keep the power supply cable connected to the IRPrestige-21 to allow the internal dehumidifier to run. 
(The orange lamp should be lit.) 

 

  
Do not turn off the power or press the reset switch on the PC while Windows is running. This 
may subsequently prevent Windows from running properly. 

 

 

13.1.3 For the IRAffinity-1 Series 
Use the following procedure to turn OFF power to the IRAffinity-1 series. 

1. Confirm that all necessary data in the LabSolutions IR software has been saved. 

2. Close the [LabSolutions Main] window, launcher, [LabSolutions IR] postrun program, and any 
measurement programs. 

3. Shut down the PC. 

4. Turn OFF the activation switch at the lower right on the front of the IRAffinity series 
instrument. 

The green power indicator will turn off. 
Keep the power supply cable connected to the IRAffinity series instrument to allow the internal 
dehumidifier to run. 

 

  
Do not turn off the power or press the reset switch on the PC while Windows is running. This 
may subsequently prevent Windows from running properly. 
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13.1.4 For the FTIR-8000 Series 
Use the following procedure to turn OFF power to the FTIR-8000 series. 

1. Confirm that all necessary data in the LabSolutions IR software has been saved. 

2. Close the [LabSolutions Main] window, launcher, [LabSolutions IR] postrun program, and any 
measurement programs. 

3. Shut down the PC. 

4. Turn OFF the activation switch at the lower right on the front of the FTIR-8000 series 
instrument. 

 

  
Do not turn off the power or press the reset switch on the PC while Windows is running. This 
may subsequently prevent Windows from running properly. 
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Chapter 14 [Easy Scan] Program 
 

This chapter explains how to operate [Easy Scan] program. 

Refer to the help file provided with the LabSolutions IR software for examples not included in this 
manual. 

Refer to the help file provided with LabSolutions IR for detailed explanations, tutorials, and other 
information regarding LabSolutions IR functions. 

 

 Explanations included in this chapter 
This chapter explains the easy measurement program function. 

 

 Operations that can be performed using this function 
Execute background (BKG) scan, spectrum scan, peak pick, and printing automatically. 

 

  
Atmosphere correction function 

Although LabSolutions IR is provided with an atmosphere correction function that eliminates the 
effects of carbon dioxide and water vapor from the measured spectrum, this function may not be 
effective in the following cases. 

 When there is so much water vapor in the atmosphere that the spectrum is saturated 

 Or conversely, when there is almost no water vapor due to purging 

 When amide absorption occurs 

In these cases, turn off atmosphere correction during measurement (on the [Tool] menu) and 
proceed with measurement as usual without using the atmosphere correction function for 
manipulation. 
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14.1 [Easy Scan] Program 
[Easy Scan] program assist in the execution of simple measurements. 

When [Easy Scan] program are run, normal measurement can be executed by performing 
operations according to displayed messages. 

 

14.1.1 Preparation  

 Configuration of LabSolutions IR 
Configure the following on the spectrum measurement toolbar in the spectrum measurement 
program in LabSolutions IR. 

 Deselect the [Continuous] checkbox. 

 

 Scan Parameters 
When the program runs, scan parameters are changed for it. When the LabSolutions IR is activated 
as a user without a right of "Edit scan parameters", scan parameters are changed for the program. 
Memorizing or saving scan parameters before running the program is recommended. 

When a user without a right of "Edit scan parameters" uses a Measurement program after executing 
this program, he loads a scan parameter file which was saved by Administrator. 

 

14.1.2 Note During Operations 
The following operations will cause [Automation Error] to be displayed. 

 [Cancel] is clicked in the [Login] window. 

 Spectrum data is not obtained because scanning of the sample spectrum is aborted. 
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14.2 Startup 

1. Close all LabSolutions IR measurement programs and the postrun program. 

2. Click the [Macro] tab in the LabSolutions IR launcher and then double-click [Easy Scan]. 

 
Launcher 

 
The [Macro Execute] window is displayed.  
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3. Click [Run]. 

 
[Macro Execute] Window 

4. Enter a user ID and password into the [Login] window and click [OK]. 

  
When [Cancel] is clicked, [Automation Error] is displayed. Click [OK]. 

 
[Login] Window 

 
The program starts. 
The LabSolutions IR spectrum measurement program starts and the [Easy Scan] window is displayed. 
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14.3 Executing an [Easy Scan] Program 

1. Turn ON power to the FTIR. 

2. Click the [Macro] tab and click [Easy Scan]. 

3. The [Macro Execute] window is displayed. Click [Run]. 

The [Login] window is displayed. 

4. Enter a user ID and password and click [OK]. 

The Spectrum program starts and the system is initialized automatically. 
Clicking [OK] with respect to the confirmation message regarding consecutive measurement settings 
displays the [Parameter Setting] window. 

5. Enter a filename for saving the scan parameters and spectrum as well as a comment. 

 
[Parameter Setting] Window 

 
In this example, configure the following settings. 

 

Item Setting 

Mode Transmittance or absorbance 

Resolution 0.25, 0.5 (or 0.85), 1.0, 2.0, 4.0, 8.0, or 16.0 

No. of Scan 1 to 4000 

Range Normally 7800 to 350 

Data File Enter a filename. 
It is not necessary to add ".ispd" as the file extension. If the same 
filename already exists, it will be overwritten without warning. 

Comment Enter a comment. 

6. Click [OK]. 

The message [Execute BKG scan?] is displayed. 
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7. When performing background (BKG) scan, set the background sample in the sample 
compartment or confirm that no sample is in the sample compartment and then click [Yes]. 

The background (BKG) measurement starts immediately. 
 

 
Starting Background (BKG) Scan 

 

  
Click [No] to skip background (BKG) scan and proceed to the next step. 

Always perform background (BKG) scan when measurement conditions have been changed.

 
Once background (BKG) scan is complete, the message [Execute BKG scan again?] is displayed. 
Check the sample and click [Yes] to perform background (BKG) measurement again. 

 

 
Background (BKG) Scan Complete 

 

  
Click [No] to proceed to sample scan. 

Once background (BKG) scan is complete, the message [Set a sample into Sample 
Compartment?] is displayed. 

 
Set the Sample 
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8. Set the sample and click [OK]. 

Sample scan starts. 
Once sample scan is complete, peak pick is performed and the detected peaks are displayed on a 
spectrum. 
The message [Are results acceptable?] is displayed after peaks are detected. 

 

 
Peak Pick Results 

9. Click [Increase] or [Decrease] to adjust the peak pick results. 

Click [Increase] or [Decrease] to increase or decrease the number of detected peaks and return to the 
same message window. 

10. Click [OK]. 

The spectrum is printed automatically. 
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14.4 End of Program 

1. Click [OK]. 

The LabSolutions IR spectrum measurement program closes after printing is complete. 

  
If any created files are unsaved, a message prompting whether to save the files is displayed 
before the program closes. Click [Yes] to save the files. 

 
Save File Confirmation 

2. Click [Close] in the [Macro Execute] window. 

 
[Macro Execute] Window 
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Chapter 15 Contaminant Analysis Program 
 

This chapter explains how to operate the contaminant analysis program. 

Refer to the help file provided with the LabSolutions IR software for examples not included in this 
manual. 

Refer to the help file provided with LabSolutions IR for detailed explanations, tutorials, and other 
information regarding LabSolutions IR functions. 

 

 Explanations included in this chapter 
This chapter explains how to use the contaminant analysis program. 

 

 Operations that can be performed using this function 
Perform spectral analysis of contaminants and identify "major components" and "accessory 
components". In addition, display analysis results that contain an approximate purity with respect to 
each type of component and print the analysis results. 
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15.1 Contaminant Analysis Program 
The contaminant analysis program assists in the analysis of spectra that contain contaminants in 
addition to the creation of reports. 

Select the measurement method, "ATR" or "Transmittance/Reflectance", used to obtain the 
spectrum for searching (unknown spectrum) in order to automatically set the libraries that 
correspond to the measurement method. A search of the unknown spectrum is conducted and then 
a peak comparison is performed using the peak tables associated with these libraries with respect to 
the top 10 hits in the search results for the detected substances. The results of this peak comparison 
show the major components ranked with (+++), (++), and (+). 

 (+++): All detected peaks match the peak wavenumbers in the peak pick table. 

 (++): All detected peaks, except one, match the peak wavenumbers in the peak pick table. 

 (+): All detected peaks, except two, match the peak wavenumbers in the peak pick table. 
 

Peak comparison is also performed using the peak tables with respect to the detected substances at 
rank 11 and lower in the hit list. The results of this peak comparison show the accessory 
components ranked with (+++), (++), and (+). 

The criteria used to determine ranks (+++), (++), and (+) is the same as for the major components. 

The spectra of substances with ranks (+++), (++), and (+) for major and accessory components can 
be selected for overlaying on the unknown spectrum (or viewed in stack display) and the result can 
be printed. 

 

 During operations 
The following operations will cause [Automation Error] to be displayed. 

 [Cancel] is clicked in the [Login] window. 

 

 Spectrum selection  
This program loads data with an active pointer from the selected spectrum file for use in calculation. 

In LabSolutions IR, when any type of manipulation is performed on the measured data, such as 
baseline correction or Kubelka-Munk conversion, the results of manipulation are saved below the 
original data in the file's hierarchy in the tree view. Because multiple spectra can coexist in a single 
file, an active pointer is employed to represent the data that is displayed first when the file is opened. 
This program uses the data with this active pointer in manipulation. Normally, the active pointer is 
set to the data that was manipulated last. 

If the active pointer is not set for the target data, open the file in LabSolutions IR, open the right-click 
menu on the data in the tree view and click [Active Pointer], and then close the file. 
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Tree View and Active Pointer 

 

 Scan parameters in reports 
Scan parameters are printed in reports if measured raw data is used by this program. 

However, scan parameters are not printed and the corresponding location in the report is left blank if 
the active pointer is set to data that has been manipulated. The reason is that manipulated data 
does not include scan parameters because it is not raw data. 

 

 Important notes regarding LabSolutions DB IR (database edition) and LabSolutions 
CS IR (client server edition) 
Although the target spectrum needs to be selected when the contaminant analysis program is 
running, spectra in the database cannot be selected. 

To access a spectrum from the database, export the target spectrum from the database to a local 
folder on the PC in advance and then select the exported spectrum when the contaminant analysis 
program is running. 
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15.1.1 Program Sequence 
 

 

Start 

Select the "Transmittance/Reflectance" or "ATR" method. 

Load the spectrum of the unknown sample. 

If the maximum peak intensity is higher than 1 absorbance, the message "The peak is 
saturated and there is a possibility that a correct result is not obtained." is displayed. 

Normalize the spectrum to between 0 to 1 absorbance. 

Peak pick 

Perform spectrum search using contaminant libraries that correspond to the 
"Transmittance/Reflectance" or "ATR" method. 

Peak comparison is performed using the peak pick tables that correspond to the contaminant 
libraries with respect to the top 10 hits in the search results for the detected substances. 

If wavenumbers 1 to 3 in the peak pick table are present in the detected peak wavenumbers, 
the detected peak wavenumbers re compared with wavenumbers 4 to 10 in the peak pick 
table. 
If these wavenumbers are not present, comparison is not performed with peak wavenumbers 
4 to 10. If these wavenumbers are present, the search results are displayed as major 
components. 

Peak comparison is performed using the peak pick tables with respect to the detected 
substances at rank 11 and lower in the hit list. 

If the detected peak wavenumbers are present, comparison is then performed with peak 
wavenumbers 4 to 10. If these wavenumbers are not present, comparison is not performed 
with peak wavenumbers 4 to 10. If these wavenumbers are present, the search results are 
displayed as accessory components. 

The search results are displayed as follows for the major and accessory components: 
(+++): All detected peaks match the peak wavenumbers in the peak pick table. 
(++): All detected peaks, except one, match the peak wavenumbers in the peak pick table. 
(+): All detected peaks, except two, match the peak wavenumbers in the peak pick table. 

The spectra of substances with ranks (+++), (++), and (+) for both major and accessory 
components can be selected (multiple selection possible) for overlaying on the unknown 
spectrum (or viewed in stack display). 

Print the identification results, unknown spectrum, and the spectra of the selected major and 
accessory components. 

End 
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15.1.2 Improving the Quality of Identification 
Be mindful of the following points in order to improve the quality of identification. 

 Interpolating data measured at 8 cm-1 to 4 cm-1 will improve the likelihood of hits when performing 
identification. 

 Changing the wavenumber range will improve the likelihood of hits when spectra were measured 
outside the wavenumber range of the relevant libraries, at for example, 4000 cm-1 to 400 cm-1.  

(ATR library range: 4000 cm-1 to 600 cm-1, transmittance/reflectance library range: 4000 cm-1 to 
700 cm-1) 

 Performing atmosphere correction prior to identification will improve the likelihood of hits. 

 Correcting curved baselines will improve the likelihood of hits. 

 A search may not return hits when identifying data measured in a region narrower than the 
wavenumber range of the relevant libraries. 

 Always make the data to be identified active before performing identification. 
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15.2 Initial Configuration 
Configure the basic settings of the contaminant analysis program. These settings should be 
performed during installation. The procedure for initial configuration is described below. 

1. Double-click [Contaminant Analysis] on the [Macro] tab in the LabSolutions IR launcher to 
start the contaminant analysis program. 

Run the program. The [Selection] window is displayed.  

2. Press the "Ctrl", "Shift", and "F10" keys together on the keyboard. 
 

 
[Selection] Window 

The [Password] dialog box is displayed. 

3. Enter a password. 

The password is [shimadzu]. (Enter the password completely in lowercase.) 
 

 
[Password] Window 

The [Configuration] dialog box is displayed if the entered password is correct. 

4. Select [English] for [Language] and click [OK] button. 

 
[Configuration] Dialog Box 

 

Item Setting Description 

Language Japanese/English Select the language used in the program. Select [English]. 
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15.3 Startup 

1. Close all LabSolutions IR measurement programs and the postrun program. 

2. Click the [Macro] tab in the LabSolutions IR launcher and then double-click [Contaminant 
Analysis]. 

 
Launcher 

 
The [Macro Execute] window is displayed.  
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3. Click [Run]. 

 
[Macro Execute] 

4. Enter a user ID and password into the [Login] window and click [OK]. 

  
When [Cancel] is clicked, [Automation Error] is displayed. Click [OK]. 

 
[Login] Window 

 
The program starts. 
The LabSolutions IR postrun program starts and the [Contaminant Analysis ] window is displayed. 
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15.4 Executing the Contaminant Analysis Program 
Prepare spectrum data for contaminant analysis. 

  
 The contaminant analysis program loads data with an active pointer from the selected spectrum file 

for use in calculation. 

 Interpolating data measured at 8 cm-1 to 4 cm-1 will improve the likelihood of hits when performing 
identification. 

 Changing the wavenumber range will improve the likelihood of hits when spectra were measured 
outside the wavenumber range of the relevant libraries, at for example, 4000 cm-1 to 400 cm-1. 
(ATR library range: to 600 cm-1, transmittance/reflectance library range: to 700 cm-1) 

 Performing atmosphere correction prior to identification will improve the likelihood of hits. 

 Correcting curved baselines will improve the likelihood of hits. 

 A search may not return hits when identifying data measured in a region narrower than the 
wavenumber range of the relevant libraries. 

1. Click [Contaminant Analysis] to start the Contaminant Analysis program. 

The following message appears if the contaminant analysis program is started when data is currently 
displayed on screen. 
Click [Yes] if proceeding does not pose a problem. 
Click [No] to exit the contamination analysis program. 
This message does not appear if data is not currently displayed. 

 

 
Warning Dialog Box 

2. Select the measurement method ([Trans/Ref.] or [ATR]). 

 
Selecting the Measurement Method (Libraries) 

3. Select the spectrum for analysis from the folder that stores the corresponding data and click 
[Open]. 

Identification starts. 
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The spectrum undergoes zero baseline correction first, and then peak pick is performed. 
 
The libraries that correspond to the measurement method are selected and peak comparison is 
performed using the peak tables associated with these libraries with respect to the top 10 hits in the 
search results for the detected substances. 
The results of peak comparison show the major components ranked with (+++), (++), and (+). 
 (+++): All detected peaks match the peak wavenumbers in the peak pick table. 

 (++): All detected peaks, except one, match the peak wavenumbers in the peak pick table. 

 (+): All detected peaks, except two, match the peak wavenumbers in the peak pick table. 
 

Peak comparison is also performed using the peak tables with respect to the detected substances at rank 
11 and lower in the hit list. The results of peak comparison show the accessory components ranked with 
(+++), (++), and (+). 
The criteria used to determine ranks (+++), (++), and (+) is the same as for the major components. 
The spectra of substances with ranks (+++), (++), and (+) for major and accessory components can be 
selected for overlaying on the unknown spectrum. 

 

 

 
Identification Result Window 
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The following message appears if the maximum peak absorbance of the loaded infrared 
spectrum exceeds 1. While it is possible to proceed with identification by clicking [Yes], this may 
result in misidentification. 

 
When Absorbance Exceeds 1 

4. Select the detected components and click [Display]. 

The target spectrum of analysis and the selected detected spectrum are overlaid. 
 

 
Spectrum Display 

 

 
Click [Back] to return to the identification result window. 
Click [Next] to proceed to printing. 
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5. Click [Yes] to print. 

 
Print Dialog Box 

Example of report output 

A report, such as the one shown below, can be output after analysis. 
The first page contains the analysis results. 
The second page contains the unknown sample spectrum and the spectra of the selected major and 
accessory components. The third page onwards contains the spectra of the selected major and accessory 
components that did not fit on the first page. Three spectra can be printed per A4 page. 

 
Report Example (Pages 1 and 2) 

 
A dialog box prompting whether to repeat analysis appears after printing is complete or when [No] is 
clicked in the print dialog box. 
Click [Yes] to return to the contaminant analysis program editing window and continue with 
contaminant analysis. 
Click [No] to exit the contamination analysis program. 

 

 
Repeat Analysis Dialog Box 
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15.5 End of Program 

1. Click [No] in the [Check] dialog box. 

The LabSolutions IR postrun program exits. 

2. Click [Close] in the [Macro Execute] window. 

 

[Macro Execute] Window 

 

 



Chapter 15 Contaminant Analysis Program 

188  LabSolutions IR Basic Operation Manual 

15.6 Libraries and Peak Tables 
 Libraries 

The contaminant analysis program uses the six libraries shown in the table below. 

The ATR method and transmittance/reflectance method each use three of these six libraries during 
search execution. The ATR libraries consist of spectra in the 4000 cm-1 to 600 cm-1 wavenumber 
range and the transmittance/reflectance libraries consist of spectra in the 4000 cm-1 to 700 cm-1 
wavenumber range. All libraries have a spectrum resolution of 4 cm-1. 

Users can register new spectra to these libraries. 

The contents of libraries can be viewed in the [Edit Library] window. 

Filename Description 

Inorganic.* Inorganic, ATR method 

Organic.* Organic, ATR method 

Polymer.* Polymer, ATR method 

T-Inorganic.* Inorganic, transmittance method 

T-Organic.* Organic, transmittance method 

T-Polymer.* Polymer, transmittance method 
 

 

 Peak Tables 
The peak pick table files are in CSV format. 

The peak tables consist of the files "A_FMIAPeaktable.csv", "A_FMOAPeaktable.csv", 
"A_FMPAPeaktable.csv", "T_FMITPeaktable.csv", "T_FMOTPeaktable.csv", and 
"T_FMPTPeaktable.csv", which are each associated with the libraries Inorganic.IDX, Organic.IDX, 
Polymer.IDX, T-Inorganic.IDX, T-Organic.IDX, and T-Polymer.IDX. 

When the user registers a new spectrum into a library, the peak wavenumber and substance name 
can be entered along with the library ID. 

The figure below shows part of the "A_FMPAPeaktable.csv" file. 

  
Part of the "A_FMPAPeaktable.csv" File 

 

The function of each item is listed in the table below. 

No. Item Description 

1 [Threshold] Enter the threshold value used in peak pick. 

2 [Noise Level] Enter the noise level used in peak pick. 

3 [Minimum area] Enter the minimum area used in peak pick. 

4 [Number of 
Wavenumber] 

Indicates the maximum number of peak wavenumbers to use in peak 
comparison (fixed to 10). 

5 [Number of Peak 
Ratio] 

This item is not used by the contaminant analysis program (fixed). 

6 [Tolerance of 
Wavenumber] 

Enter a wavenumber range to serve as the allowable error used in the 
comparison between the peak wavenumbers detected in the infrared spectrum 
of the unknown sample and the peak wavenumbers listed in the peak pick table.

7 [Lib.ID] Indicates the library ID of substances that have corresponding peak 
wavenumbers in the Inorganic.IDX, Organic.IDX, and Polymer.IDX libraries. 

8 [Species] This item is not used by this software. 
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No. Item Description 

9 [Wavenumber 1] to 
[Wavenumber 10] 

Enter the wavenumbers used in peak comparison. A maximum of 10 
wavenumbers can be entered and peak wavenumbers that are not present in 
the registered substance can be specified by prefixing the relevant wavenumber 
with a minus sign (). 
Enter peak wavenumbers that are definitely present or definitely not present in 
substances in [Wavenumber 1] to [Wavenumber 3]. If these peak wavenumbers 
are matched, comparison is performed with the remaining peak wavenumbers 
of [Wavenumber 4] to [Wavenumber 10]. 

10 [Material Name] Indicates the name of the substance displayed in the identification results. 

11 [Spectrum 
Information] 

This name is used in remarks for the corresponding spectrum. 

 

 

 Adding Data to Peak Tables 
Add new sample information to a peak pick table according to the procedure described below. 

1. Enter a consecutive number for the numeric part of the library ID in [Lib.ID]. 

Do not enter any characters or numbers for [Species]. 

2. Enter the specific absorbance peak wavenumbers of the substance to register in 
[Wavenumber 1] to [Wavenumber 10]. 

If there is peak wavenumber that cannot exist in the substance, prefix the wavenumber with a minus 
sign (). 

3. Enter a name for the substance to be registered in [Material Name]. 

4. Enter information on the substance's chemical formula or name as text in [Spectrum 
Information], as necessary. 

5. Register the spectrum data to the library. 

For details on the procedure for registering data to libraries, refer to the online help in the LabSolutions 
IR software. 

 

  
 Always make sure that the [Lib.ID] number matches the spectrum number in the library. 

The search function will not operate correctly if these numbers do not match. 

 The peak wavenumber information in peak tables has a significant effect on the accuracy of 
identification. 

Shimadzu recommends backing up peak pick table files before attempting to add or change 
data. Take the utmost care when adding or updating data in peak tables. 

Shimadzu recommends periodically backing up peak pick table files to an external storage 
device as a measure to protect against hard disk failure or unforeseen accidents. 

 After editing is complete, always save the peak pick table data to the "\Peaktable" folder of 
the LabSolutions IR installation folder using the following filenames and format. 

Select the "CSV" file format. (The program will not operate correctly if saved using the Excel 
file format.) 
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Filename Description 

A_FMIAPeaktable.csv Inorganic, ATR method 

A_FMOAPeaktable.csv Organic, ATR method 

A_FMPAPeaktable.csv Polymer, ATR method 

T_FMITPeaktable.csv Inorganic, transmittance method 

T_FMOTPeaktable.csv Organic, transmittance method 

T_FMPTPeaktable.csv Polymer, transmittance method 
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Chapter 16 Pharma Report and Food 
Additives Identification Programs 

 

This chapter explains how to operate the Pharma Report program and the Food Additives 
Identification program. 

Refer to the help file provided with the LabSolutions IR software for examples not included in this 
manual. 

Refer to the help file provided with LabSolutions IR for detailed explanations, tutorials, and other 
information regarding LabSolutions IR functions. 

 

 Explanations included in this chapter 
This chapter explains the functions of the Pharma Report program and the Food Additives 
Identification program using example operation of the Pharma Report program. 

 

 Operations that can be performed using this function 
There are three functions – Report, Print (Spectrum Comparison), Peak Detection – in this 
programs. 

 

Chapter 16 
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16.1 Outline 
The Pharma Report program and Food Additives Identification program have the following functions. 

 

 Report creating 
Creates an analysis report to compare a sample spectrum with a standard spectrum based on 
identification test in the pharmacopoeias. Peak wavenumbers and peak ratios are calculated and the 
program judges Pass (OK)/Fail (NG) based on the errors of calculated peak wavenumbers and peak 
ratios. 

This program compares the sample spectrum to the standard spectrum with the specified 
wavenumbers, and then calculates differences of peak wavenumber and ones of peak ratios. 

When those differences are satisfied with tolerances, the judgment is Pass (OK). User should 
specify the peak wavenumbers and tolerances for judgment. 

 

 Spectrum comparison 
Creates a report suitable to compare standard and sample spectra based on identification test in the 
pharmacopoeias. 

Identification for Tocopherol Acetate on the Japanese Pharmacopoeia 16th edition describes as; 

Determine the infrared absorption spectrum of Tocopherol Acetate ..., and compare the spectrum with the 
Reference Spectrum or the spectrum of Tocopherol Acetate Reference Standard: both spectra exhibit similar 
intensities of absorption at the same wavenumbers. 

 

This program prints out the sample spectrum and standard spectrum to compare them. 

 

 Peak detection 
Detect peaks being described in identification test in the pharmacopoeias, and creates a report. 

Identification for Chlorpheniramine Maleate Powder on the Japanese Pharmacopoeia 16th edition 
describes as; 

...determine the infrared absorption spectrum ...,: it exhibits absorption at the wavenumbers of about 2940, 
2810, 2770, 1589, 1491, 1470, 1434, 1091 and 1015 cm-1. 

 

This program prints out the sample spectrum and a peak table detected at the specified 
wavenumbers. 

 

 Differences between the Pharma Report program and Food Additives Identification 
program 
The Pharma Report program and Food Additives Identification program are 

operated in the same manner. 

Standard spectra that can be used in the Food Additives Identification program are stored in 
"…\LabSolutions\IR\Data\FOOD_ADDITIVES\ATR\"  
and "…\LabSolutions\IR\Data\FOOD_ADDITIVES\TRANS\". 

Standard spectra for the Pharma Report program are not provided and must be prepared by users. 
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16.2 Notes Regarding These Programs 
Be aware of the following points when using these programs. 

 

 Configuration of LabSolutions IR 
Configure the following on the spectrum measurement toolbar in the spectrum measurement 
program in LabSolutions IR. 

Deselect the [Continuous] checkbox. 

 

 Spectrum selection 
These programs load data with an active pointer from the selected spectrum file for use in 
calculation. 

In LabSolutions IR, when any type of manipulation is performed on the measured data, such as 
baseline correction or Kubelka-Munk conversion, the results of manipulation are saved below the 
original data in the file's hierarchy in the tree view. Because multiple spectra can coexist in a single 
file, an active pointer is employed to represent the data that is displayed first when the file is opened. 
These programs use the data with this active pointer in calculation. Normally, the active pointer is 
set to the data that was processed last. 

If the active pointer is not set for the target data, open the file in LabSolutions IR, open the right-click 
menu on the data in the tree view and click [Active Pointer], and then close the file. 

 

 
Tree View and Active Pointer 

 

 Scan parameters in reports 
Scan parameters are printed in reports if measured raw data is used by these programs. 

However, scan parameters are not printed and the corresponding location in the report is left blank if 
the active pointer is set to data that has been manipulated. The reason is that manipulated data 
does not include scan parameters because it is not raw data. 
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 Scan Parameters 
When the program runs, scan parameters are changed for it. When the LabSolutions IR is activated 
as a user without a right of "Edit scan parameters", scan parameters are changed for the program. 
Memorizing or saving scan parameters before running the program is recommended. 

When a user without a right of "Edit scan parameters" uses a Measurement program after executing 
this program, he loads a scan parameter file which was saved by Administrator. 

 

 During operation 
The following operations will cause [Automation Error] to be displayed. 

 [Cancel] is clicked in the [Login] window. 

 Spectrum data is not obtained because scanning of the sample spectrum is aborted. 

 Spectrum data is not opened because [Cancel] is clicked in the [File open] window. 

 

 Peak intensity 
When the absorbance of peaks is too strong, the following message is displayed because correct 
peak tops and peak ratios may not be calculated due to peak saturation. 

 
When the Absorbance Is Too Strong 

 

 Important notes regarding LabSolutions DB IR (database edition) and LabSolutions 
CS IR (client server edition) 
LabSolutions DB IR (database edition) and LabSolutions CS IR (client server edition) store scanned 
spectra in a database, which results in the following restrictions. 

 Spectra scanned using these programs in LabSolutions DB IR (database edition) and 
LabSolutions CS IR (client server edition) are stored in a database instead of a local PC. 

 Because these programs cannot open spectra in the database, export the required spectrum 
from the database to a local folder on the PC in advance and then select the exported spectrum. 
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16.3 Startup 

1. Close all LabSolutions IR measurement programs and the postrun program. 

2. Click the [Macro] tab in the LabSolutions IR launcher and then double-click [Pharma Report] 
or [Food Additives Identification]. 

 
Launcher 

 
The [Macro Execute] window is displayed.  
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3. Click [Run]. 

 
[Macro Execute] Window 

4. Enter a user ID and password into the [Login] window and click [OK]. 

  
When [Cancel] is clicked, [Automation Error] is displayed. Click [OK]. 

 

 
[Login] Window 
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The selected program starts. 
The LabSolutions IR Spectrum program starts and the [Pharma Report] window or [Food Additives 
Report] window is displayed. 

 

 
[Pharma Report] Window 

 
Parameter Description 

Button Start identification of the component shown on the button. 

Edit Comp. Create a new component or edit existing component information. 

Exit Exit the program. 
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16.4 Registering and Editing Components 

1. Click [Edit Comp.] in the [Pharma Report] window or [Food Additives Report] window. 

The [Edit Components] window is displayed. 
 

 
[Edit Components] Window 

 
Parameter Description 

Button with a component name Edit the corresponding component information. 

Empty button Create a new component. 

Back Return to the [Pharma Report] window or [Food Additives Report] 
window. 

2. Click an empty button to add a new component or a button with a component name to edit the 
corresponding component information. 

 

16.4.1 Report Function Settings 
The Report function creates an analysis report to compare a sample spectrum with a standard 
spectrum based on identification test in the pharmacopoeias. Peak wavenumbers and peak ratios 
are calculated and the program judges Pass (OK)/Fail (NG) based on the errors of calculated peak 
wavenumbers and peak ratios. 

This program compares the sample spectrum to the standard spectrum with the specified 
wavenumbers, and then calculates differences of peak wavenumber and ones of peak ratios. When 
those differences are satisfied with tolerances, the judgment is Pass (OK). User should specify the 
peak wavenumbers and tolerances for judgment. 

 

Prepare following files before execution. 

 Standard spectrum (transmittance) 

 Peak table (can be created in this program) 

 Scan parameter file (.iscp file) 
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 This program uses the data with an active pointer in the selected spectrum file in calculations. 

 Scan parameters are printed in reports if measured raw data is used by these programs. However, 
scan parameters are not printed and the corresponding location in the report is left blank if the 
active pointer is set to data that has been manipulated. 

1. Click a button in the [Edit Components] window. 

The [Component configuration] window is displayed. 
 

 
[Component configuration] Window 

 
Parameter Description 

Comp. Name Enter the name to be displayed on the button in the [Pharma Report] 
window or [Food Additives Report] window. 

Method Select [Report]. 

Meas. Parameters Specify the scan parameter file to use for sample measurement in the 
program. 
Select a file from a list by clicking the [...] button. 

Std. Spectrum Specify a standard spectrum. 
Select a file from a list by clicking the [...] button. 

Use Select the wavenumbers to use in calculation. 

Wavenumber Enter peak wavenumbers. 

Tolerance(cm-1) Enter the tolerance (cm-1) for the corresponding wavenumbers. 

No. of Ratio Peaks Select the number of peaks to be used in peak ratio evaluation. 

A to D Enter the numbers ([No.]) of the peak wavenumbers to use in 
evaluation. 

Tolerance(0-1) Enter the tolerance for the peak ratio. 

Register Save the configuration, register it to the selected button, and close the 
window. 

Delete Delete the selected configuration and close the window. 

Cancel Discard the configuration and close the window. 
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2. Enter information for the component. 

1. Enter a name in the [Comp. Name] field. 

2. Select [Report] for [Method]. 

3. Specify the scan parameter file to use for sample measurement in the program in the [Meas. 
Parameters] field.  
Select a file from a list by clicking the [...] button. 

4. Specify a standard spectrum in the [Std. Spectrum] field.  
Select a file from a list by clicking the [...] button. 

5. Enter the required peak wavenumbers into the fields under [Wavenumber].  
Up to 10 wavenumbers can be entered. 

6. Select the wavenumbers to use in calculation. 

  
A wavenumber must be entered and its corresponding checkbox selected to be used in 
calculation. 

7. Enter the tolerance (cm-1) for the corresponding wavenumbers. 

8. Select number of peaks to be used in peak ratio evaluation using [No. of Ratio Peaks].  
It is possible to specify up to four peaks. 

9. Enter the numbers ([No.]) of the peak wavenumbers to use in evaluation in the fields [A] to [D]. 

10. Enter the tolerance for the peak ratio. 

3. Click [Register]. 

4. Click [Back] in the [Edit Components] window. 

  
 If the Pharmacopoeia describes peak wavenumbers to be used, they are used as peak 

wavenumbers. If there are no descriptions, user should specify them. 

 Since there are no descriptions for peak wavenumber tolerance, wavenumber for peak ratio 
calculation and its tolerance on the Pharmacopoeia, user should specify them. 

 

 

16.4.2 Spectrum Printing Function Settings 
The spectrum comparison function creates a report suitable to compare standard and sample 
spectra based on identification test in the Pharmacopoeias. 

Identification for Tocopherol Acetate on the Japanese Pharmacopoeia 16th edition describes as;  

Determine the infrared absorption spectrum of Tocopherol Acetate ..., and compare the spectrum with the 
Reference Spectrum or the spectrum of Tocopherol Acetate Reference Standard: both spectra exhibit similar 
intensities of absorption at the same wavenumbers. 

 

This program prints out the sample spectrum and standard spectrum to compare them. 

 

Prepare following files before execution. 

 Standard spectrum (transmittance) 

 Scan parameter file (.iscp file) 
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 This program uses the data with an active pointer in the selected spectrum file in calculations. 

 Scan parameters are printed in reports if measured raw data is used by these programs.  
However, scan parameters are not printed and the corresponding location in the report is left blank 
if the active pointer is set to data that has been manipulated. 

1. Click a button in the [Edit Components] window. 

The [Component configuration] window is displayed. 
 

 
[Component configuration] Window 

 
Parameter Description 

Comp. Name Enter the name to be displayed on the button in the [Pharma Report] 
window or [Food Additives Report] window. 

Method Select [Printout]. 

Meas. Parameters Specify the scan parameter file to use for sample measurement in the 
program. 
Select a file from a list by clicking the [...] button. 

Std. Spectrum Specify a standard spectrum. 
Select a file from a list by clicking the [...] button. 

Register Save the configuration, register it to the selected button, and close the 
window. 

Delete Delete the selected configuration and close the window. 

Cancel Discard the configuration and close the window. 
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2. Enter information for the component. 

1. Enter a name in the [Comp. Name] field. 

2. Select [Printout] for [Method]. 

3. Specify the scan parameter file to use for sample measurement in the program in the [Meas. 
Parameters] field. Select a file from a list by clicking the [...] button. 

4. Specify a standard spectrum in the [Std. Spectrum] field. Select a file from a list by clicking the 
[...] button. 

3. Click [Register]. 

4. Click [Back] in the [Edit Components] window. 

 

 

16.4.3 Peak Detection Function Settings 
The peak detection function detect peaks being described in identification test in the 
Pharmacopoeias, and creates a report. 

Identification for Chlorpheniramine Maleate Powder on the Japanese Pharmacopoeia 16th edition 
describes as; 

... determine the infrared absorption spectrum ...,: it exhibits absorption at the wavenumbers of about 2940, 
2810, 2770, 1589, 1491, 1470, 1434, 1091 and 1015 cm-1. 

 

This program prints out the sample spectrum and a peak table detected at the specified 
wavenumbers. 

 

Prepare following files before execution. 

 Peak table (can be created in this program) 

 Scan parameter file (.iscp file) 

  
 This program uses the data with an active pointer in the selected spectrum file in calculations. 

 Scan parameters are printed in reports if measured raw data is used by these programs. However, 
scan parameters are not printed and the corresponding location in the report is left blank if the 
active pointer is set to data that has been manipulated. 
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1. Click a button in the [Edit Components] window. 

The [Component configuration] window is displayed. 
 

 
[Component configuration] Window 

 
Parameter Description 

Comp. Name Enter the name to be displayed on the button in the [Pharma Report] 
window or [Food Additives Report] window. 

Method Select [Peak Detection]. 

Meas. Parameters Specify the scan parameter file to use for sample measurement in the 
program. 
Select a file from a list by clicking the [...] button. 

Use Puts a check on the wavenumber to be used for peak detection. 

Wavenumber Inputs peak wavenumbers. 

Marker W.No. Select the number of wavenumbers for marking. 

M1 to M4 Enter the wavenumbers for marking. 

Register Save the configuration, register it to the selected button, and close the 
window. 

Delete Delete the selected configuration and close the window. 

Cancel Discard the configuration and close the window. 

2. Enter information for the component. 

1. Enter a name in the [Comp. Name] field. 

2. Select [Peak Detection] for [Method]. 

3. Specify the scan parameter file to use for sample measurement in the program in the [Meas. 
Parameters] field.  
Select a file from a list by clicking the [...] button. 
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4. Specify a standard spectrum in the [Std. Spectrum] field.  
Select a file from a list by clicking the [...] button. 

5. Enter the peak wavenumbers under [Wavenumber].  
Up to 10 wavenumbers can be entered. 

6. Select the wavenumbers to use in peak detection. 

  
A wavenumber must be entered and its corresponding checkbox selected to be used in 
peak detection. 

7. Select the number of wavenumbers to use for marking using [Marker W.No.]. 

8. Enter the wavenumbers for marking.  
It is possible to specify up to four wavenumbers. 

3. Click [Register]. 

4. Click [Back] in the [Edit Components] window. 

  
If the Pharmacopoeia describes peak wavenumbers to be used, they are used as peak 
wavenumbers. If there are no descriptions, user should specify them. 
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16.5 Execution of Identification 
Click the desired button in the [Pharma Report] window or [Food Additives Report] window. 

 

16.5.1 Execution of the Report Function 

1. Click the desired button in the [Pharma Report] window or [Food Additives Report] window. 

2. Select the method for specifying the sample. 

Click [Yes] to open a previously saved sample or click [No] to scan the sample. 
 

 
Selection Method for Sample Spectrum 

 

To open a previously saved sample 

1. Click [Yes]. 

2. Select the sample file and then click [Open]. 

 
Selecting a Spectrum 
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To scan the sample  

1. Click [No]. 

 

2. Enter a comment for [Comment] and the file path for [Filename] and click [OK]. 
The FTIR is initialized automatically. 

 

 
Entering a Comment and Save Destination for the Spectrum 

3. Set the background (BKG) sample and click [Yes]. 

 
Measuring the Background (BKG) 

4. Set the sample and click [OK]. 

 
Measuring the Sample 

3. The calculation is executed according to the following procedures. 

1. The peak of standard spectrum is detected referring to the peak table. 

2. The peak of the sample spectrum is detected referring to the detected peak list of standard 
spectrum. 

3. Errors (differences between peak wavenumber of standard spectrum and that of sample 
spectrum) are calculated. 

4. Peak ratios are calculated for the standard spectrum. 

5. Peak ratios are calculated for the sample spectrum. 
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6. Ratio of peak ratios in (5) to peak ratios in (4) for evaluation. 

7. Judge according to the result of (3) and (6). 
Results that exceed the acceptable range for wavenumbers in step 3 and results that deviate from the 
acceptable range for judgment values in step 6 are assessed as [NG]. 
The overall judgment is assessed as [OK] if no results deviate from the acceptable range. 
If a single result is assessed as [NG], the overall judgment result becomes [NG]. 

 
When calculation is complete, the spectrum and a message showing the overall judgment result ([OK] 
or [NG]) are displayed. 

4. Click [OK]. 

 
Judgment 

5. Click [Yes]. 

A report is printed. 
 

 
Print window 

6. The following message is displayed after printing a report or after clicking [No] in the print 
window. 

Return to [Pharma Report] window or [Food Additives Report] window by clicking [Yes]. 
Close the program by clicking [No]. 

 

 
Exiting the Program 
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Example 

 

The report consists of the scan parameter, judgment ([OK] or [NG]), spectra of standard and sample, 
and calculated table. 

Markers to show the selected peaks for detection and evaluation are displayed. 

 The upper part of the calculated results shows the detected peak wavenumbers and their 
transmittance for both the sample and the standard spectra. The right row shows the error, which 
is calculated by subtracting [Peak wavenumber of standard] from [Peak wavenumber of sample]. 

 The lower part shows the peak ratios of evaluation peaks for both the sample and the standard 
spectra. The right row shows the error, which is calculated by dividing [Peak ratio of sample] by 
[Peak ratio of standard]. 
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Transmittance values (%T) shown on the "Peak Wavenumber" section are values rounded off to one 
decimal place. 
"Peak Ratio" values are calculated by converting the rounded transmittance shown on the "Peak 
Wavenumber " section into an absorbance, calculating the ratio from the absorbance, and then 
rounding off the ratio to four decimal places. 

 
 

16.5.2 Execution of the Printout Function 

1. Click the desired button in the [Pharma Report] window or [Food Additives Report] window. 

2. Select the method for specifying the sample. 
Click [Yes] to open a previously saved sample or click [No] to scan the sample. 

 

 
Selection Method for Sample Spectrum 
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To open a previously saved sample 

1. Click [Yes]. 

2. Select the sample file and then click [Open]. 

 
Selecting a Spectrum 

 

To scan the sample  

1. Click [No]. 

2. Enter a comment for [Comment] and the file path for [Filename] and click [OK]. 
The FTIR is initialized automatically. 

 

 
Entering a Comment and Save Destination for the Spectrum 
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3. Set the background (BKG) sample and click [Yes]. 

 
Measuring the Background (BKG) 

4. Set the sample and click [OK]. 

 
Measuring the Sample 

3. A report is printed. 

 
Print Window 

4. The following message is displayed after printing a report or after clicking [No] in the print 
window. 

Return to [Pharma Report] window or [Food Additives Report] window by clicking [Yes]. 
Close the program by clicking [No]. 

 

 
Exiting the Program 
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Example 

 

The report consists of the scan parameter, spectra of standard and sample. 
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16.5.3 Execution of the Peak Detection Function 

1. Click the desired button in the [Pharma Report] window or [Food Additives Report] window. 

2. Select the method for specifying the sample. 

Click [Yes] to open a previously saved sample or click [No] to scan the sample. 
 

 
Selection Method for Sample Spectrum 

 

To open a previously saved sample 

1. Click [Yes]. 

2. Select the sample file and then click [Open]. 

 
Selecting a Spectrum 
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To scan the sample  

1. Click [No]. 

2. Enter a comment for [Comment] and the file path for [Filename] and click [OK]. 
FTIR is automatically initialized. 

 
Entering a Comment and Save Destination for the Spectrum 

3. Set the background (BKG) sample and click [Yes]. 

 
Measuring the Background (BKG) 

4. Set the sample and click [OK]. 

 
Measuring the Sample 

3. Peak detection is executed according to the following procedures. 

1. The peak of the sample spectrum is detected referring to the peak table. 
When the peak is not detected, the error message is displayed. 

2. The peak position is plotted on the screen. 
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4. Click [Yes]. 

A report is printed. 

 
Print window 

5. The following message is displayed after printing a report or after clicking [No] in the print 
window. 

Return to [Pharma Report] window or [Food Additives Report] window by clicking [Yes]. 
Close the program by clicking [No]. 

 
Exiting the Program 

 

 
Example 

 

The report consists of the scan parameter, spectrum of sample, detected peak wavenuymbers and 
their intensities (absorbance or %T), and a list of marked wavenumbers. 
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16.6 End of Program 
 

1. Click [No]. 

The LabSolutions IR Spectrum programs exits. 
 

 
Ending program 

2. Click [Close] in the [Macro Execute] window. 

 
[Macro Execute] Window 

 



 

LabSolutions IR Basic Operation Manual  217 

Chapter 17 Purity Judge Program 
 

This chapter explains how to operate the Purity Judge Program. 

Refer to the help file provided with the LabSolutions IR software for examples not included in this 
manual. 

Refer to the help file provided with LabSolutions IR for detailed explanations, tutorials, and other 
information regarding LabSolutions IR functions. 

 

 Explanations included in this chapter 
This chapter explains how to use the Purity Judge Program. 

 

 Operations that can be performed using this function 
Make pass/fail judgment by calculating the conformity score between the sample spectrum and the 
reference spectrum. Judgment parameters can be registered in advance so the judgment can be 
performed automatically by simply selecting the spectrum. The result of jusgment can be printed. 
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17.1 Purity Judge Program 
By selecting the sample spectrum and reference spectrum, the Purity Judge Program calculates the 
conformity between the two spectra, displays the results as "Pass" when the results exceed the 
threshold value of the set pass/fail judgment or "Fail" when the results are below the threshold value 
together with the threshold values, and enables printing of the results report. The sample spectrum 
can be selected as the currently active spectrum or can be read from a specified file. The reference 
spectrum can be selected from the pre-registered spectra (maximum of 20 spectra). Judgment 
parameters (calculation method, threshold value for pass/fail judgment, and reference spectrum file 
path) can be registered to each reference spectrum. The purity is calculated by the same method as 
the calculation performed when [Manipulation] - [Purity] is selected. 
 

 During operations 
The following operations will cause [Automation Error] to be displayed. 
• [Cancel] is clicked in the [Login] window. 
 

 Spectrum selection 
This program reads the data that contains active pointers within the selected spectrum file and uses 
this data to perform calculations.  
In LabSolutions IR, when any type of manipulation is performed on the measured data, such as 
baseline correction or Kubelka-Munk conversion, the results of manipulation are saved below the 
original data in the file's hierarchy in the tree view. 
Because multiple spectra can coexist in a single file, an active pointer is employed to represent the 
data that is displayed first when the file is opened. 
This program uses the data with this active pointer in manipulation. Normally, the active pointer is 
set to the data that was manipulated last. 
If the active pointer is not set for the target data, open the file in LabSolutions IR, open the right-click 
menu on the data in the tree view and click [Active Pointer], and then close the file. 

 
Tree View and Active Pointer 

 
 Important notes regarding LabSolutions BD IR (database edition) and LabSolutions 

CS IR (client server edition) 
Although the target spectrum needs to be selected when the purity judge program is running, 
spectra in the database cannot be selected. To access a spectrum from the database, export the 
target spectrum from the database to a local folder on the PC in advance and then select the 
exported spectrum when the program is running. 
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Program Sequence 
1. Purity Judgment 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Start 

Click the [Purity Judge] button at the [Easy Macro] on the Main Toolbar. 

Select the "Active data" or "File" to load a spectrum on main menu. 

Select the reference spectrum by clicking the registered button or [Other]. 

Score is calculated and then the Judgment result is displayed. 
Select [Ye] or [No] for printing. 

Print the judgment report when [Yes] is clicked. 

Return to [Main Menu]. Click [Cancel] to end the program. 

Click [Run] on [Macro Execute] window. 

Run any Measurement program or Postrun program of LabSolutions IR. 

Click [Close] on [Macro Execute] window. 

End 
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2. Reference spectrum registration 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Start 

Select the "Config." on main menu. 

Click an empty button to add a new reference spectrum 

Input information of a reference spectrum. 

Click [Registry] to save the reference spectrum. 

Return to [Main Menu]. 

End 

Click [return] on [Configuration] window. 
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17.2 Initial Configuration 
The purity judge program is set to English display in the initial configuration. The language setting 
needs to be changed in order to display in other languages. 

The method for switching the language setting is shown below. For details on how to startup the 
purity judge program, see "17.3 Program Startup".  

1. Click the [Language] button on the [Main Menu] window. 

 
[Main Menu] Window 

The [Language] window is displayed. 

2. Change the language if required and click [OK].  

 
[Language] Window 

 
 

Item Setting Description 

Language English 
Japanese 
Chinese 

Select the language used in the program. 
Select [English] for English, 
select [Japanese] for Japanese, 
or select [Chinese] for Chinese. 

 

17.3 Startup 

1. Start the LabSolutions IR measurement program or the postrun program. 

2. Click [Purity Judge] in [Easy Macro] of the main toolbar. 

 
[Easy Macro] in the Main Toolbar 

 
The [Macro Execute] window is displayed. 
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3. Click [Run]. 

 
[Macro Execute] Window 

4. The [Main Menu] window is displayed. 

 
[Main Menu] Window 

 



17.4 Registering and Editing Reference Spectrum 
 

LabSolutions IR Basic Operation Manual  223 

17.4 Registering and Editing Reference Spectrum 

1. Click [Config.] in the [Main Menu] window. 

The [Configuration] window is displayed. 

 

[Configuration] Window 

Item Description 

Button with a reference 
spectrum name 

Edit the reference spectrum. 

Empty button Register a new reference spectrum. 

return Return to the [Main Menu] window. 
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2. Click an empty button to add a new reference spectrum or a button with a reference spectrum 
name to edit. 

The [Configuration] window is displayed. 

 

[Configuration] Window 
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Parameter Description 

Name Input a name for a reference spectrum. 

Judgment Threshold Input a value between 0 and 1.0. 
When the calculated Score is higher than this value, judgment is 
“Pass”. Default value is “0”. 
Judgment Threshold must be set according to configurations of 
Purity parameters such as [Normalize], [Peak purity] and 
[Smoothing points]. 
It give you better result to apply Baseline Correction before 
calculation. And selecting [Normalize]-[Max. Intensity] 
automatically compensates differences of concentration or 
sample thickness. 

Normalization Select either of [None] or [Max. Intensity]. 
None:  Not normalized. 
Ma. Intensity:  Performs normalization. 

Peak Select either of [Correlation] or [Correlation^2]. 
Correlation:  Calculates according to the correlation. 
Correlation^2:  Calculates according to the square of 

correlation. 
 

This correlation can be calculated using the following formula: 

Here, ii yx ,  are the respective intensities for the same 

horizontal coordinate value, and n is the number of data points. 
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Smoothing Select either of [None] or [Value]. 
Smoothing points based on the Savitzky-Golay method. 

Filename Select a file name of the reference spectrum. 
File can be selected from the file list by clicking [>>] button. 

Registry Save the configuration, register it to the selected button, and 
close the window. 

Delete Delete the selected configuration and close the window. 

Cancel Discard the configuration and close the window. 
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3. Enter the information of the reference spectrum. 

1. Enter the [Name]. 

2. Enter the [Judgement Threshold]. 

Enter a value between 0.0 to 1.0. 

3. Select the [Normalization] method. 

4. Select the [Peak] calculation method. 

5. Select the [Smoothing]. 

6. Specify the [Filename] of the reference spectrum. 

Alternatively, click [>>] and select from the list. 

4. Click [Registry]. 

5. Click [return] in the [Configuration] window. 
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17.5 Executing the Purity Judge Program 
Prepare the sample spectrum data to be used for purity judgment. 

  
 The purity judges program loads data with an active pointer from the selected spectrum file for use 

in calculation. 

 Same spectrum data cannot be used as both a reference and a sample. 

 All files which are opened are closed when [File] button is clicked. 

 Combination of “%T and “%T”, ”Abs and Abs”, “%T and Abs”, and “E and E” as Y axis unit can be 
applied to Purity Judgement program. 

1. Start the [Purity Judge Program]. The [Main Menu] window is displayed. 

 
[Main Menu] Window 

 

2. Select the sample spectrum. 

The sample spectrum can be selected from [Active Data] or [File]. 
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3. Select the reference spectrum. 

The reference spectrum can be selected from the pre-registered spectra, or entered from 
[Other]. 

 
[Selection] Window 

 

4. The conformity is calculated, and the judgment results, score and threshold value are 
displayed. Also, the sample spectrum and reference spectrum graphs are overlaid. 

The Y-axis unit of the graph matches that of the sample spectrum. 
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Results 

 

5. Click [Yes] to print. 

 
[Result] Window 

Example report output 

A report, such as the one shown below, can be output after analysis. 
The report is one page and consists of the following information. 

 Pass/fail judgment 
 Score and Threshold 
 Overlaid graph of the sample spectrum and the reference spectrum (The active data of the 

sample are indicated by the surrounding rectangles.) 
 Files names (file paths) of the sample spectrum and the reference spectrum 
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Report example 

 

The screen returns to the [Main Menu] window after printing has completed or when [No] is clicked in the 
[Result] window. 
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17.6 End of Program 

1. Click [Cancel] in the [Main Menu] window. 

The [Main Menu] Window closes. 

2. Click [Cose] in the [Macro Execute] window. 

 
Macro Execute 
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Chapter 18 Appendix 
 

18.1 Using LabSolutions IR Data with Other Applications 
In Windows, data from one application program can be easily processed in another application 
program. For example, spectra measured in LabSolutions IR can be pasted as image data into word 
processing software and peak pick tables output to the report window can be loaded and processed 
by spreadsheet software. 

This section describes a simple example of creating a report using the WordPad application, which 
is included in Windows. 

The explanation in this section assumes that users possess elementary knowledge regarding the 
operation of Windows and WordPad. For details on unclear terms or operating procedures, refer to 
the Windows instruction manual. 

 

18.1.1 Creating a Report Using WordPad 
The LabSolutions IR software includes a print function that can be used to easily output spectra if a 
printer is connected to the PC. However, this print function is insufficient for creating documents that 
include figures inserted into text, such as articles and reports. 

This section uses an example to describe the operations for pasting spectra displayed in the 
LabSolutions IR software directly into a document in WordPad. 

  
Both the LabSolutions IR and WordPad software must be running at the same time to perform the 
following operations. Multiple applications may not be able to run at the same time if your PC does not 
have sufficient memory. 

The following example assumes that WordPad is installed and functioning correctly. 

 

 

 Transferring spectra 
Use the following procedure to include spectra displayed in LabSolutions IR into a document. 

1. Start WordPad. 

2. Create a new document or load a previously created document in WordPad. 

3. Switch to the LabSolutions IR software. 

Click on any visible part of the LabSolutions IR window or press the "Alt" and "Tab" keys together to 
switch applications. 

4. Make the relevant data tab active and display the area for copying. 

5. Click [Copy] on the [Edit] menu. 

The [Clipboard Image Size] window is displayed. 

6. Enter "800" for [Width in pixel] and "600" for [Height in pixel] and click [OK]. 

The graph is temporarily copied to the Windows clipboard. 
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7. Switch back to WordPad. 

8. Position the cursor at the location to paste the graph and click [Paste] on the [Edit] menu. 

Calibration curves can also be transferred to WordPad using the same procedure. 
 

 

 Transferring text 
Use the following procedure to include text formatted data into a document, such as quantitative 
results and the contents of peak pick tables. 

1. Start WordPad. 

2. Create a new document or load a previously created document in WordPad. 

3. Move the mouse pointer to the start of the text to be copied (peak pick table title or start of the 
table) and drag to select the text range for copying. 

  
The same operation can be performed using the arrow keys while holding down the "Shift" key.

4. Once the text is selected, click [Copy] on the [Edit] menu. 

The text is temporarily copied to the Windows clipboard. 

5. Switch back to WordPad. 

6. Position the cursor at the location to paste the text and click [Paste] on the [Edit] menu. 
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18.1.2 Using Spectrum Data with Other Applications 
Spectrum image data can be converted into ASCII format as a method for using the data in other 
applications. 

Click [Export] on the [File] menu to convert spectrum data into the Jcamp-DX, ASCII, or csv format 
for use in other applications. 

For details on each format, see "1.3.5 File Formats of the LabSolutions IR Software" or refer to the 
online help in the LabSolutions IR software. 

 

Format Description 

Jcamp-DX format This is a common data format used by spectrophotometers. 
Use this format to transfer data between LabSolutions IR and FTIR software or 
spectrum search software developed by other companies. 

ASCII format This type of file is used to output the list of vertical axis values (transmittance 
or absorbance). 
The wavenumber range and data interval are written to the header. 

ASCII Simple Text 
(csv) format 

This type of file is used to output the list of wavenumbers and vertical axis 
values (transmittance or absorbance). 
The file format is convenient for loading data into spreadsheet software. 

 

 

 Notes on using the Jcamp-DX format 
By using the Jcamp-DX format, spectra measured using LabSolutions IR can be loaded into FTIR 
software and spectrum search software developed by other companies. Similarly, spectra measured 
using FTIR software from other companies can be loaded into LabSolutions IR. 

The settings for Jcamp-DX conversion should be modified according to the target software. 

1. Click [File Preferences] - [File Filters] on the [Tool] menu. 

The [File Filters] window is displayed. 

2. Select [JCAMP Data File] and click [Options]. 

3. Configure the following settings. 

Parameter Setting 

Compression format Select [Packed] or [Fixed]. 

Description, history Leave empty. 

Conversion option Select this checkbox. 

Factor (%T calculation) Select whether to set 100 % transmittance as 1 or 100 (%) for 
calculation. 
This setting should be tested as it differs depending on the particular 
software. 
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18.2 Using Libraries Created in IRsolution with 
LabSolutions IR 
Libraries created using the IRsolution software can be used in LabSolutions IR without modification. 

 

 

18.3 Using Libraries Created in HYPER-IR with 
LabSolutions IR 
Libraries created using the HYPER-IR software cannot be used in LabSolutions IR without 
conversion. 

Convert these libraries using the following procedure so they can be used in LabSolutions IR. 

1. Click the [Start] button, navigate to [Accessories] under [Programs], and click [Command 
Prompt]. 

2. Set the current directory to the LabSolutions IR installation folder. 

Example input 

cd program files\LabSolutions\IR  (then press the "Enter" key) 

3. Convert libraries using the "ConvertLibsR.exe" command. 

While the file extension of the library name is not required, make sure to specify the drive name and 
folder name. 
The command syntax is shown below. 

Syntax 

[ConvertLibsR.exe] [old library name] [new library name] 

Example input 

ConvertLibsR.exe c:\spdata\tutorial\tutorial c:\spdata\tutorial\new_tutorial  (then press the "Enter" 
key) 

 
Library conversion occurs at the command prompt and a new library is created. 

4. Repeat step 3 to convert any other libraries. 

5. After conversion is complete, type "exit" and press the "Enter" key. 

The command prompt exits. 
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18.4 Using Commercial Libraries 
LabSolutions IR can perform spectrum searches that utilize infrared spectrum databases such as 
Sadtler (produced by Bio-Rad Laboratories) and Hummel (produced by S.T. Japan) libraries. 

This section describes how to perform the settings required to use these libraries. 

! CAUTION 

Instructions  

Disconnect any devices attached to the PC via USB (Universal Serial Bus) 
before installing the necessary drivers. 

Any such devices may be damaged when drivers are installed with these devices 
connected. 

 

 

18.4.1 Using the Sadtler Libraries with LabSolutions IR 
The Sadtler libraries produced by Bio-Rad Laboratories can be used with LabSolutions IR. 

In order to access these libraries, a security device must be connected to a USB port. The Sadtler 
libraries used with the IRsolution software as well as the control file (IR.CTL) supplied with the 
libraries for IRsolution can be used with LabSolutions IR. 

However, in some cases old versions of the Sadtler libraries cannot be used without conversion. 
Consult Bio-Rad Laboratories for details on conversion. 

 

 Installing the protection key driver 
The driver for the protection key is installed together with LabSolutions IR and is configured 
automatically when the security device is connected. 

 

 Connecting the protection key 
After driver installation is complete, connect the protection key supplied together with the libraries to 
the specified port on the PC. 

 

 Installing the library files 
Install the Sadtler libraries according to the following procedure. 

1. Create a folder to store the Sadtler library files on the hard disk. 

2. Copy the library files to the hard disk from the disk that contains the Sadtler libraries. 

3. Deselect the [Read-only] checkbox in the attributes of the all of the copied files. 

1. Select all the copied files using Windows Explorer. 

2. Open the right-click menu and click [Properties]. 

3. Deselect the [Read-only] checkbox and click [OK]. 

 

 Copying the control file 
The control file for the Sadtler libraries is named "IR.CTL" and is supplied on a disk or floppy disk. 

Copy this file to the same folder that the library files were copied to (do not copy it to the 
LabSolutions IR folder). 

Deselect the [Read-only] checkbox for the control file in the same manner as the Sadtler library files. 
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 Starting LabSolutions IR and registering the Sadtler libraries 
Start LabSolutions IR and register the Sadtler libraries in the search window in the same manner as 
other libraries. 

The spectrum search method using the Sadtler libraries is not different from using any other 
libraries. 

 

 

18.4.2 Using the Hummel Libraries with LabSolutions IR 
The Hummel infrared spectrum database produced by S.T. Japan can be used with LabSolutions IR. 

Because the format of these libraries is different to those for HYPER-IR, be sure to specify the 
LabSolutions IR format at the time of purchase. A protection key must be connected to the printer 
port in order to use the Hummel libraries. 

 

 Installing the protection key driver 
The driver for the protection key is installed together with LabSolutions IR and is configured 
automatically when the security device is connected. 

 

 Connecting the protection key 
After driver installation is complete, connect the protection key supplied together with the libraries to 
the specified port on the PC. 

 

 Installing the library files 
Install the Hummel libraries according to the following procedure. 

1. Create a folder to store the Hummel library files on the hard disk. 

2. Copy the library files to the hard disk from the disk that contains the Hummel libraries. 

3. Deselect the [Read-only] checkbox in the attributes of all of the copied files. 

1. Select all the copied files using Windows Explorer. 

2. Open the right-click menu and click [Properties]. 

3. Deselect the [Read-only] checkbox and click [OK]. 

 

 Copying the control file 
The control file for the Hummel libraries is named "LCWIN.ACL" and is supplied on a floppy disk (the 
file format is the same as that for HYPER-IR and IRsolution). 

Copy this file to the LabSolutions IR installation folder, the default location being "C:\Program 
Files\LabSolutions\IR" (note that this is different to the location for the Sadtler libraries). 

Deselect the [Read-only] checkbox for the control file in the same manner as the Sadtler library files. 

 

 Starting LabSolutions IR and registering the Hummel libraries 
Start LabSolutions IR and register the Hummel libraries in the search window in the same manner 
as other libraries. 

The spectrum search method using the Sadtler libraries is not different from using any other 
libraries. 
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18.5 Precision of Internal Manipulation 
LabSolutions IR performs manipulation using double-precision floating-point numbers. All data 
saved to file retains this same degree of precision. 

The number of digits following the decimal point of printed data or data displayed on screen is 
rounded to either the user-specified or default number of digits. This rounding process only applies 
to printed data and data displayed on screen and does not affect the precision of saved data or any 
subsequent calculations. 

For example, differences may appear between a manually calculated calibration curve that is based 
on printed or on-screen tabular data and a calibration curve that is calculated by LabSolutions IR 
using double-precision floating-point numbers. 

Item Description 

Double-precision floating-point 
numbers 

IEEE compliant 64-bit numbers 
Mantissa: 53-bit, Exponent: 11-bit 
16 digits at 10  308 in decimal notation 

Rounding process Numbers of five or higher are rounded up and numbers lower than five are 
rounded down. 

Comparison of rounded 
numbers 

Numbers of five or higher are rounded up and numbers lower than five are 
rounded down. 
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